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От автОра
Если читаете эти строки, значит настало ваше время, уважаемый читатель, проявить 

интерес к темам, обозначенным в названии книги. в мир 3D приходят по-разному – от про-
стой любознательности и желания попробовать себя в новом жанре или новой программе 
компьютерной графики – просто «для души», как хобби, до профессиональной необходимо-
сти освоения нового рабочего инструмента. Сразу можно сказать – и в том, и в другом слу-
чае вы на правильном пути, выбрав именно SketchUp! 

О чем говорит название книги? Надеюсь, оно точно отражает задуманное содержа-
ние, назначение, организацию и стиль подачи материала. Итак, почему «SketchUp», почему 
«просто» и почему «3D»… 

во-первых – перед вами учебник-справочник по 3D-редактору Google SketchUp теку-
щей на момент написания книги 8-й Pro версии для Windows, а точнее, версии 8.0.11752 (де-
кабрь 2011г.). Если же у вас установлена другая (например, более ранняя), будут некоторые 
небольшие отличия в отдельных частях интерфейса и наборе функций – с изменениями в так 
называемых «релизах» текущей версии можете ознакомиться здесь: http://support.Google.com/
SketchUp/bin/static.py?hl=en&page=release_notes.cs.

Далее мы будем подробно рассматривать все возможности и достоинства SketchUp, 
но сразу отмечу одно качество, особенно ценное для новичка в 3D или в новой для поль-
зователя других редакторов программе – уникальную дружественную простоту в освоении 
и удобство в работе. 

во-вторых – решения по содержанию, структуре и стилю изложения учебных материа-
лов сложились из предложений и пожеланий читателей других моих учебников – в основном, 
начинающих пользователей SketchUp. Зачастую, кроме подробного «сухого» руководства-
справочника в манере Help или пошаговых уроков решения отдельных задач (что предпола-
гает уже наличие базовых знаний программы), требуется нечто третье… то самое «просто», 
последовательно, от простого к сложному, от общий понятий к нюансам, максимально под-
робно и наглядно иллюстрированное. Поэтому в итоге сложилось решение построить кни-
гу, как тренинг с воображаемым «учеником», или как курс занятий с комментариями по ходу 
и ответами на типичные вопросы и затруднения. При этом за основу принят принцип посте-
пенного «наращивания» багажа знаний – от самых необходимых и востребованных тем, до 
профессиональных тонкостей решения узкоспециальных задач, «секретов» и «хитростей» 
моделирования в SketchUp... 

в-третьих – круг интересов и начальный уровень подготовленности пользователей к 
моменту знакомства со SketchUp бывает очень различен, как различна и персональная не-
обходимость в глубине освоения программы. Для SketchUp это особенно актуально, по-
скольку многие начинают его освоение с совершенно «нулевого» уровня не только в 3D, но 
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и вообще в компьютерной графике. Конечно, все-таки требуется минимум базовых знаний 
по работе в программах под Windows (что и предполагается в изложении материала). Оче-
видно также, что даже опытные пользователи и даже в «своей» программе не задействуют 
всех 100% возможностей – только то, что действительно необходимо в рабочей практике 
или больше подходит для типично решаемых задач, а в некоторые «уголки» программы мо-
гут так ни разу и не заглянуть. 

Отсюда – решение разделить материал на два уровня «глубины» освоения, условно 
обозначенные в названиях двух частей (книг) – «Практик» и «Эксперт». Первая книга прове-
дет читателя от начала знакомства с миром трехмерной компьютерной графики, основными 
понятиями и принципами устройства 3D-программ до уровня уверенного владения основны-
ми, самыми востребованными инструментами SketchUp, готовности к решению разнообраз-
ных задач моделирования. вторая книга углубит и завершит изучение всех возможностей, 
практических «тонкостей» и «хитростей» работы в SketchUp, знание которых и делает поль-
зователя профессионалом, экспертом в программе.

таким образом, каждый может выбрать и начать изучение со своего уровня подготов-
ленности и по своим интересам, или обратиться к любой из еще не освоенных тем в нужный 
момент, в произвольном порядке. Хотя практика показывает, что иногда бывает очень по-
лезно «вернуться к истокам» даже достаточно опытному пользователю – не исключено, что 
обнаружатся пробелы в уже, казалось бы, пройденном и освоенном…

Условные сокращения и обозначения в тексте: 
Клик (кликнуть) – нажатие левой кнопки мышки (запуск опции)
СКМ – средняя кнопка (колесико) мышки 
ПКМ – правая кнопка мышки 
Shift + СКМ – сочетания кливиш с кнопками мышки 
Ctrl+V – «горячие клавиши» (keyboard shortcuts) быстрого запуска командам

P.S. Приведенные в книге авторские комментарии, замечания и способы решения от-
дельных задач выражают только личные оценки и опыт автора, и конечно, не претендуют на 
роль единственно правильных – хотя бы по причине того, что один и тот же результат может 
быть достигнут самыми разными шагами и способами, а «универсал» SketchUp в этом плане 
предоставляет все возможности…

Буду благодарен за отзывы и пожелания по книге, готов ответить на возникающие до-
полнительные вопросы (пишите: prosketchup@narod.ru) и, конечно, – желаю творческих успехов! 

Александр Петелин 2011г.
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тема 1. НЕМНОГО ИСтОрИИ И тЕОрИИ

1999-2011
SketchUp имеет весьма солидный по меркам «жизни» компьютерных программ воз-

раст – его разработчик, американская компания @Last Software, с 1999 по 2006 г. выпусти-
ла пять версий программы. в 2006 г. SketchUp был приобретен корпорацией Google, зна-
комой всем пользователям Интернета, как минимум, по одноименному поисковому серви-
су. в 2007 г. редактор вышел уже под новым именем – Google SketchUp 6, в 2008 появил-
ся первый релиз 7-й версии, а в сентябре 2010 вышел первый релиз текущей 8-й версии. 

Программа доступна в двух вариантах – профессиональном Google SketchUp Pro (на 
нем и базируются материалы книги), и бесплатном – Google SketchUp. Бесплатная отлича-
ется от Pro рядом функциональных ограничений: недоступен импорт и экспорт файлов са-
мого распространенного «конструкторского» CAD формата (DXF, DWG), недоступен эк-
спорт в форматы файлов других 3D и векторных форматов (3DS, OBJ, PDF, DWG и др.). та-
ким образом, суть ограничений состоит в том, что «отсечена» возможность обмена век-
торной графикой и 3D-моделями со сторонними программами. Кроме того, в бесплатную 
версию не включены новые (в этой версии) инструменты Solid Tools и две «партнерские» 
программы-приложения: LayOut и Style Builder. Но сразу можно заметить, что эти ограни-
чения для начинающего пользователя совершенно не критичны, и свободно скачав бес-
платную версию с офсайта: http://SketchUp.Google.com, можно не только сразу начинать из-
учение SketchUp, но и полноценно выполнять практическую работу по моделированию и 
презентации своих проектов.

Итак, что же такое SketchUp, и в чем его отличие от других, общеизвестных 3D-ре-
дакторов? Изначально «идеология» программы была сформулирована разработчиками @
Last Software как «...оптимальное сочетание элегантности и свободы дизайна «от руки» со 
скоростью и гибкостью цифровых технологий...», и «3D – для всех!». И эти принципы были 
блестяще воплощены, прежде всего – в уникальном по простоте, удобству и функциональ-
ности интерфейсе, который обеспечивает как быстроту и легкость освоения, так и непрев-
зойденную для 3D-редактора скорость работы. Благодаря этому SketchUp предоставляет 
максимальный простор именно для творческой части работы, дает возможность творить, 
фактически «не отрывая руку от карандаша» при минимальных затратах на технические 
действия. а отсюда – если для большинства пользователей освоение нового специфиче-
ского мира 3D-моделирования неизбежно весьма трудоемко и длительно, то со SketchUp 
этой проблемы просто не существует! Буквально в первый раз открыв программу, пользо-
ватель уже через полчаса начинает с увлечением скорее не работать, а играть в модели-
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рование, даже если это его первая 3D-программа. 
Сейчас уже, пожалуй, можно сказать, что SketchUp стал родоначальником идеоло-

гии целого направления максимально дружественных к пользователю программ, ориенти-
рованных именно на простоту, легкость освоения, скорость и удобство работы. редактор 
делался, в том числе, для потенциального пользователя, у которого 3D-моделирование – 
только один (или не основной) из профессиональных инструментов, или вообще просто 
хобби «для души». Понятно, что в этом случае у него нет необходимости, возможности, да 
и желания тратить долгие часы на освоение громоздких интерфейсов и огромного числа 
функций «тяжелых» универсальных 3D-редакторов «полного цикла». Характерно, что ана-
логичный подход сейчас все чаще прослеживается и в новых 3D-редакторах разного на-
значения. Более того – в некоторых из них можно заметить явные «скетчаповские» черты 
в принципах решения интерфейсов и вообще в системе управления. Надо отметить также, 
что особенно в последние годы явно обозначилась тенденция все более широкого «при-
знания» SketchUp сторонними разработчиками, которые все чаще включают в свои про-
граммы или непосредственную поддержку файлов SketchUp, или обмен данными с ним че-
рез специальные плагины. 

Остается только удивляться, насколько точно в свое время разработчики @Last 
Software «попали» в эту востребованную и перспективную «нишу» жанра...

SketchUp, что отражено и в самом его названии (Sketch – эскиз, набросок, Up – вверх) 
предназначен для эскизного, поискового 3D-моделирования – изначально и прежде все-
го – с архитектурной специализацией. Однако на самом деле, благодаря универсальности 
заложенных в нем механизмов моделирования, возможности и области применения оказа-
лись намного шире – SketchUp с успехом используют для разработки разнообразных про-
ектов во всех жанрах дизайна, рекламы, инженерном проектировании, кино- и игропро-
изводстве... трудно перечислить все. 

Интересно проследить историю роста популярности SketchUp у «3D-общественно-
сти». Долгое время понятие 3D однозначно было связано с «тяжелыми» редакторами, пре-
жде всего – с «патриархом» жанра – Autodesk 3ds Max. Да и сейчас это достаточно харак-
терное заблуждение, особенно у тех, кто «не в теме» – например, у работодателей дизай-
неров и заказчиков. видимо поэтому довольно долго со SketchUp был знаком только узкий 
круг специалистов, в основном – архитекторов, а у нас в стране он оставался практически 
неизвестным. К тому же «дружественность» интерфейса программы, как ни парадоксаль-
но, иногда работает на «негатив» – создает при первом поверхностном знакомстве впе-
чатление несерьезного, даже неполноценного редактора. На самом же деле за обманчи-
вой простотой, даже «игрушечностью» интерфейса (в т.ч. в названиях некоторых инстру-
ментов) скрываются как замечательные возможности для решения практически всех задач 
низкополигонного 3D-моделирования, так и высокая точность построений уровня профес-
сиональных CAD (Систем компьютерного проектирования) редакторов.

И конечно, явный скачок роста популярности SketchUp произошел с момента «при-
вязки» программы к Интернет-проектам нового владельца – Google 3D-модели (http://
SketchUp.Google.com/3dwarehouse/) и Google планета Земля (http://earth.Google.com/intl/ru/). 
Для взаимодействия с этими проектами в SketchUp встроены специальные опции и инстру-
менты. в этой связи можно заметить, что причиной выбора и приобретения SketchUp кор-
порацией Google очевидно стали именно его простота и доступность – альтернативы на 
роль необходимого для таких проектов «народного» 3D-редактора просто и не было... да 
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пожалуй, нет и до сих пор.

2D…
Начнем с обзорного знакомства с базовыми основами компьютерной графики вооб-

ще и 3D-моделирования в частности – понятиями, терминологией и «правилами игры». Это-
му имеет смысл уделить внимание, поскольку незнание элементарной «азбуки» изучаемого 
жанра в дальнейшем, при освоении конкретных инструментов и опций моделирования, по-
рождает множество затруднений. 

Итак, каждый может взять в руки карандаш и изобразить на листе бумаги, напри-
мер, простой кубик. На определенном этапе компьютерного прогресса появились техноло-
гии компьютерной графики – возможность получать аналогичный результат в специальных 
программах – графических редакторах, например – самых распространенных у нас Adobe 
Photoshop или CorelDraw. Конечно, чисто технически с этого момента началась настоящая 
революция в части инструментов, методов и производительности рисования, но суть оста-
лась та же – плоское изображение на некой плоской основе: там – на бумаге, здесь – в ра-
бочем пространстве редактора, на экране. 

теперь представим, что нам надо получить изображение этого же кубика, но в дру-
гом ракурсе (т.е. требуется показать его с другой стороны), изменить размер и положение на 
листе. в случае «ручного» рисования любой новый ракурс означает только одно – все опять 
«с нуля» и заново... в графическом редакторе можем без проблем изменить размер и поло-
жение уже существующего рисунка, удалить, приблизить картинку на экране, но вот другой 
ракурс… и здесь означает рисование еще одной новой картинки. 

Суть в том, что рисуя на листе бумаги, мы имеем дело с т.н. двухмерным рабочим по-
лем, с двумя Dimension (размерами, измерениями), откуда и пришло сокращенное обозна-
чение – 2D. Или, по-другому – при этом используем только два размерных понятия и изме-
рения – «ширина» и «высота».

 
в этих же параметрах работают и механизмы рисования 2D графических редакторов 

– в них положение любой точки в числовых значениях определяется координатами по двум 
осям: горизонтальной и вертикальной (обозначаемых обычно X и Y). При этом заметим, что 
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даже если откроем в редакторе фотографию, на которой зрительно вполне явно «читается» 
глубина пространства (например, перспектива улицы), все равно картинка, как объект ре-
дактирования, остается двухмерной. в то же время у 2D-графики имеется весомое достоин-
ство – относительная простота в понимании сути рабочего пространства и управления ин-
струментами рисования. ведь 2D-редактирование фактически аналогично привычному «руч-
ному» рисованию – например, интуитивно очевидно, что произойдет, если переместить на-
рисованную фигуру по горизонтали, вертикали, и как это сделать… 

…и 3D
в отличие от 2D, трехмерная, или 3D-графика, базируется на принципиально другом 

подходе, прежде всего – к рабочему пространству. Здесь два привычных понятия и измере-
ния – «ширина, высота», дополняются третьим – «глубина», и таким образом положение лю-
бого объекта однозначно определяются тремя пространственными координатами с число-
выми значениями по каждой из осей (традиционно – X, Y, Z). а само трехмерное пространст-
во – это виртуальный мир, который во многих 3D-редакторов так и называется – World (Мир), 
а его оси – World Axes (Мировые оси). также для такого пространства, «мира», используется 
аналогичное понятие – «Сцена». работу в 3D-редакторе правильней уже называть не «рисо-
ванием», а «построением», поскольку изображаем не картинку, не плоскую фигуру, а строим 
именно полноценную (пусть и виртуальную) объемную форму. такая форма (или «модель»), 
как и в реальности, имеет три измерения в физических величинах. И именно это дает воз-
можность свободно манипулировать объектом в трехмерной пространстве проекта-сцены. 

Что же принципиально иного нам дает 3D-моделирование по сравнению с 2D-графи-
кой? в самом широком смысле – мы получаем уникальную и удивительную возможность сво-
бодно, как угодно, и сколько угодно раз манипулировать однажды построенной моделью, 
изменяя и дополняя множество ее параметров в трехмерном, т.е. максимально приближен-
ном к реальному восприятию, пространстве. 
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КаМЕрЫ
Итак, в трехмерной сцене произвольно меняем положение модели в пространстве – 

в нашем примере перемещаем и поворачиваем трехмерный кубик так, чтобы увидеть любую 
из его сторон. Однако рассмотреть тот же кубик, или любой другой объект можно и по-дру-
гому, используя еще один базовый механизм 3D-моделирования – т.н. Camera (Камеру). Что 
под этим понимается? в принципе, это то, что в каждый момент времени видим на экране мо-
нитора, это как бы окно в наш виртуальный мир, созданный в данном проекте. Или, точнее: 
представьте, что смотрите на сцену через объектив фотокамеры. Почему именно объектив, 
а не просто «окно»? Дело в том, что механизм камеры дает дополнительные возможности 
управления показом сцены за счет изменения параметров ее «объектива». т.е. можно фи-
зически достоверно имитировать диафрагму, глубину резкости, фокусное расстояние, ши-
рину поля взгляда и др. настройки реальной оптики фотокамеры. Кроме того, доступны оп-
ции зуммирования, т.е. увеличения, уменьшения (или приближения, удаления) изображения 
нужной части сцены на экране. Пока на этом останавливаться не будем, но тому, кто доста-
точно основательно занимался фотографией, эти термины скажут многое…

НавИГаЦИЯ, проЕКЦИИ
С понятием Камеры в 3D связано еще одно – т.н. «Навигация в сцене». Проще говоря, 

это опции управления камерой, а значит, взглядом в сцену. возвращаясь к нашему примеру 
– мы можем рассмотреть обратную сторону кубика не трогая его, а просто «объехав» каме-
рой вокруг объекта и направив объектив (т.е. взгляд) в нужном направлении. таким обра-
зом, имеем возможность рассматривать сцену, как бы разгуливая по нашему трехмерному 
миру с камерой в руках. Нетрудно заметить, что часть аналогичных опций обзора рабоче-
го пространства есть и в 2D-редакторах, однако в 3D их значимость и возможности несоиз-
меримо выше. во-первых, манипуляции камерой занимают не меньшую часть времени, чем 
собственно редактирование объектов, а во-вторых, без свободного владения опциями на-
вигации можно просто «потеряться» в трехмерном пространстве... 

Однако свободная «ручная» камера иногда может не устраивать при работе с трех-
мерными объектами – при таком варианте отображения зачастую бывает неудобно, да и 
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просто невозможно выполнять точные построения и перемещения. ведь такая камера ими-
тирует «человеческий» взгляд на мир, в котором всегда присутствуют искажения геометрии 
по законам линейной перспективы – т.е. одинаковые, но более удаленные объекты будут 
казаться меньше, чем находящиеся ближе к наблюдателю. Это, собственно, и обеспечива-
ет визуальную достоверность трехмерного мира, но и означает также, что неизбежны зри-
тельные искажения и линейных размеров, и направлений. 

Для решения этой проблемы в 3D-редакторах используются специальные (или стан-
дартные) камеры – Параллельные (ортогональные) проекции (или Виды). в принципе, эти 
термины наверняка знакомы каждому даже из школьных уроков черчения, однако в 3D они 
имеют свою специфику… Представим, что наша сцена (т.е. все ее объекты) находится вну-
три воображаемого куба с прозрачными стенками – т.е. сцена ограничена 6-ю смежными, 
взаимно перпендикулярными плоскими поверхностями. При этом линии пересечения (грани-
цы) этих поверхностей (ребра куба) направлены строго вдоль соответствующих осей сцены 
X,Y,Z, а потому сами поверхности ориентированы строго параллельно воображаемым пло-
скостям, образуемым каждой парой осей (их еще называют «планами осей»). 

теперь установим нашу камеру, например, на верхнюю плоскость так, чтобы ее «объ-
ектив» был направлен внутрь куба. Условимся также, что в этом варианте камера будет всег-
да «прижата» к поверхности куба, т.е. может перемещаться, «скользить» только по ней (или 
по параллельной ей плоскости) – получаем требуемый вид Top (Сверху). Или, что аналогич-
но – в плоскости, плане осей X-Z. Нетрудно заметить, что в этом случае фактически получаем 
аналог двухмерного рабочего пространства (нет «глубины» перемещения камеры), а значит, 
нет и перспективных искажений – что, собственно, и требовалось. По аналогичному принци-
пу работают и остальные параллельные виды – всего их шесть: Top (Сверху), Left (Слева), 
Right (Справа), Front (Спереди), Back (Сзади), Bottom (Снизу). 
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Но здесь все-таки надо уточнить, что это упрощенная модель – на самом деле на по-
явление перспективных искажений влияет и один из «технических» параметров «объектива» 
– т.н. FOV (Ширина поля взгляда)… но пока на этом задерживаться не будем. 

Итак, имеем общепринятую во всех 3D-редакторах основную систему ориентации в 
пространстве за счет камер (видов) – «свободной» (одной или нескольких) и 6-ти стандар-
тных (фиксированных проекций), на которые можно мгновенно переключаться в любой нуж-
ный момент. 

тЕЛа, повЕрхНоСтИ, КрИвЫЕ, поЛИГоНЫ...
алгоритмы 3D-моделирования (и использующие их редакторы) по наиболее распро-

страненным математическим моделям можно условно разделить на две большие группы – 
т.н. solids (твердотельные или сплошные) и surfaces (поверхностные). 

По теме твердотельного моделирования можно сказать, что этот метод типично ис-
пользуется в специализированных редакторах для инженерно-конструкторских задач. т.е. 
там, где важно получить модель (например, деталь машины), несущую ее точные физические 
характеристики – вес, объем, центр тяжести и т.п. Кроме того, благодаря этому можно ком-
бинировать тела, объединяя и вычитая их, и создавать таким образом новые, более сложные 
модели. Принципиальная разница между solids и surfaces становится очевидной, если разре-
зать объект – solids всегда представляют собой абсолютно замкнутые, сплошные, «глухие» 
объемы. Упрощенно, главный признак таких объемов – они никогда не имеют «дыр», через 
которые можно «заглянуть внутрь».

 
Поверхностный же метод построения трехмерных форм направлен только на визуализа-

цию «внешности» модели, его главная задача – показать «как это выглядит», без учета того, что 
находится внутри объекта. Сравнивать, что лучше – алгоритмы solids или surfaces не имеет смы-
сла, поскольку они предназначены для разных целей и задач. Однако очевидным преимущест-
вом поверхностных моделей является то, что они проще и «легче» в части вычислительной на-
грузки на компьютер, а потому такие редакторы работают практически в реальном времени, с 
мгновенной реакцией на действия пользователя. 

SketchUp – типичный поверхностный моделер, поскольку здесь объекты всегда формиру-
ются из Faces (Плоских поверхностей) и Surfaces (Криволинейных поверхностей), т.е. пред-
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ставляют собой полые оболочки. толщина этой оболочки «нулевая» (ее как бы нет), или по-дру-
гому – не принимается во внимание. а вот еще одно свойство поверхностей в SketchUp очень 
важно – каждая и всегда имеет две стороны, как бы лицевую и изнаночную, точнее, в термино-
логии SketchUp, внешнюю – Face и внутреннюю – Backface. Стороны имеют определенные раз-
личия в свойствах, что в ряде опций редактирования принципиально – далее мы подробно бу-
дем рассматривать эту особенность. 

возникает вопрос – а зачем тогда мы вообще упомянули твердотельное моделирова-
ние? Дело в том, что на самом деле не существует абсолютно «жесткого» деления 3D-редакто-
ров только по этому принципу – как правило, в них в отдельных опциях применяются и тот, и дру-
гой алгоритмы. так, в SketchUp всегда присутствовали (пусть в неявном виде) несколько типич-
ных твердотельных опций, а с 8-й версии понятие solids уже используется «открытым текстом» в 
виде набора специализированных инструментов.

Существует еще одно условное деление 3D-редакторов по используемой математической 
модели – на т.н. curves-based (на основе кривых) и polygonal (на основе плоских многоугольников). 

Коротко о первой группе редакторов – принцип их действия обозначают сокращением 
NURBS (или сплайновым) моделированием, которое базируется на Splines (Сплайнах) – плав-
ных, в общем случае, кривых линиях. Для их определения достаточно координат начала, кон-
ца линии и формулы описания характера кривизны, что позволяет легко создавать на их ос-
нове сложные, абсолютно гладкие и плавно искривленные поверхности, сопряжения и т.п. 
с использованием мощных механизмов управление их параметрами «на лету». Однако, как и в 
случае с твердотельным моделированием, за это приходится расплачиваться повышенной рас-
четной нагрузкой, а потому требуется определенное время на «пересчет» формы при каждом 
действии редактирования формообразующих кривых. 

Можно привести очень условную аналогию (понятную для знакомых с 2D-графикой), 
иллюстрирующую принципиальную разницу полигонального и сплайнового механизмов: 
сплайны – это как бы те же управляемые кривые Безье в векторных редакторах, а сетки по-
лигонов можно сравнить с мозаикой пикселей растровых имиджей.

SketchUp по этому признаку относится ко второму типу – это типичный полигональный 
моделер. в таких редакторах основой всей геометрии является отрезок прямой линии – Line, а 
поверхности (грани) всегда состоят только из плоских Polygons (Многоугольников) со сторона-
ми из этих прямых отрезков, которые в этом качестве являются Edges (Ребрами) объектов. т.е. 
«настоящих» кривых линий и образованных из них плавно искривленных поверхностей в поли-
гональном моделировании просто не существует! Очевидно, что выбор такой математической 
модели обусловлен стремлением обеспечить максимальную простоту и скорость редактирова-
ния в реальном времени, а также назначения им «отделочных» материалов. 

а как же быть с плавными криволинейными поверхностями? Поскольку в нашем распо-
ряжении есть только плоские полигоны, предусматривается специальный механизм визуального 
сглаживания. Фактически при этом работает скрытие, зрительное «размывание» границ между 
смежными поверхностями (т.е. этих границ мы просто не видим), хотя при этом никакого реаль-
ного изменения геометрии не происходит. таким образом создается иллюзия плавной криво-
линейности, что дает возможность даже при простой геометрии получать достаточно слож-
ные формы. Или по принятой терминологии – строить т.н. Low-Poly (Низкополигонные) мо-
дели, т.е. с минимальным количеством формообразующих поверхностей. все это обеспечи-
вает высокую скорость редактирования за счет снижения нагрузки на «пересчет» формы, а 
также «легкие» файлы моделей. 
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Запомним эту принципиальную основу полигонального моделирования, характерную и 
для SketchUp – ее непонимание является источником типичных затруднений многих начинающих. 

Однако достоинства принятых в SketchUp механизмов моделирования оборачиваются 
и проблемной стороной – неизбежной повышенной нагрузкой на визуализацию, т.е. «пере-
рисовку» изображения на экране при любом действии пользователя. Понятно, что это выз-
вано, в том числе, необходимостью непрерывно пересчитывать отображение этого самого 
«сглаживания»… Хотя на самом деле и эта проблема решается умелыми методами работы, 
о чем мы будем подробно говорить далее. 

в завершении, для полноты картины, можно еще отметить характерные для SketchUp 
ограниченные возможности в части работы с т.н. «органикой» – т.е. с «нерегулярными» по-
верхностями сложной кривизны и высокой (Hi-Poly) детализации (природные объекты, пер-
сонажи и т.п). Однако это уже совершенно другая «ниша» 3D-редакторов соответствующей 
специализации, обладающих оптимизированными под эти задачи механизмами…

Eng-Rus
Хотя эта тема не относится напрямую к содержанию курса, стоит сразу, «на старте» изуче-

ния SketchUp сказать по этому поводу несколько слов, чтобы внести ясность и обозначить позицию 
автора по отношению к «русификациям» и «локализациям». Итак, типичная ситуация – как толь-
ко появляется какая-либо новая программа или ее новая версия (общепринято – с интерфейсом 
на английском языке), тут же в обсуждениях на форумах в Интернете возникают вопросы: «а ру-
сификатор к ней есть?.. где найти?..». Сразу внесем ясность – термин «русификация» – это «народ-
ный» аналог понятия «локализация». в чем разница? Локализация – это выпускаемая разработчи-
ком официальная версия программы на определенном языке, которая, как правило, включает в 
себя не только переводы всех текстовых элементов интерфейса (меню и др.), но и Help (Справку) 
или Guide (Руководство) – лучшие источники информации для начала изучения программы. а «ру-
сификация» – это самодельные любительские переводы текстовых элементов интерфейса (чаще 
всего – неполные), сделанные энтузиастами в меру своих способностей и возможностей. 

Объективно ситуация с этой темой выглядит следующим образом: 
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1. Бытует мнение (скорее – заблуждение) начинающих пользователей, что русифицирован-
ную программу легче осваивать с «нуля», однако на самом деле это – не более чем иллюзия «зна-
комости». ведь пункты меню, кнопки – это только некие условные слова, ярлыки для запуска опре-
деленных опций, и от того, что вместо «Follow Me» видим «Ведение», знаний о том, что это и как 
работает, никак не прибавится, поскольку за каждым таким условным обозначением может сто-
ять несколько страниц инструкции по применению... а после того, как эти инструкция прочитана 
и инструмент освоен на практике, проблема запоминания значения одного слова – пункта меню, 
просто снимается.

2. Изначальное освоение русифицированной программы и работа в ней означает, что про 
английские термины придется забыть, иначе все равно будете постоянно выяснять – «а как это на-
зывается по-английски?» (и наоборот). При этом ни о каком полноценном («на одном языке» в пря-
мом и переносном смыслах) общении с большинством коллег-пользователей не может быть и речи. 
Это же относится и к обмену опытом на форумах, освоению новой информации (в т.ч. учебной) и, 
естественно, добавляются проблемы перехода на новые версии, патчи, плагины и т.п.

3. возможности и качество собственно перевода. только в редких случаях можно подо-
брать полноценный смысловой аналог этой тематики в одно слово на русском, а потому зачастую 
видим буквальный перевод, который выглядит как бессмысленный набор слов (в тех же названиях 
инструментов), т.е. собственно идея перевода вообще теряет смысл. Пример: даже в официаль-
ной русской локализации SketchUp одним и тем же понятием «масштаб, масштабирование» пере-
ведены две принципиально разные опции – Zoom (Лупа) и Scale (Масштабирование) . 

4. Даже в официальных локализациях не исключена вероятность появления дополнитель-
ных непредсказуемых программных ошибок и сбоев, а в любительских, понятно, тем более.

 вы, конечно, заметили, что в уже прочитанном тексте все специальные термины и назва-
ния приведены в двойном (англо-русском) варианте – так будет и далее, поскольку изучать мы бу-
дем именно «английскую» версию программы. Можете спросить – а зачем же тогда в этой книге 
автором все-таки приведены переводы названий пунктов меню, инструментов, опций? Да, на эта-
пе начального освоения программы это имеет смысл – не более чем как «рабочий» прием для бы-
строго запоминания их функциональной сути с обязательным подробным истолкованием – что 
это, и как работает. 

Можно продолжать и далее, но резюмируя только перечисленные проблемы, можно ска-
зать, что очень трудно найти хотя бы один рациональный аргумент «за» работу и особенно – на-
чальное, «с нуля», освоение в русифицированном варианте. а если пользователь уже имеет опыт 
работы в англоязычных программах той же специфики (а многие термины и понятия в них анало-
гичны и повторяются), переход на русифицированные ничего, кроме появления дополнитель-
ных проблем, не дает.
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В этой теме рассмотрим инсталляцию SketchUp, впервые откроем програм-

му, и обзорно познакомимся с устройством ее интерфейса.

«СоФт» И «жЕЛЕЗо»
Один из первых логичных вопросов, возникающих у будущих пользователей SketchUp: 

– «а будет ли программа работать на моем компьютере»? 
во-первых, software – доступны версии под операционные системы: Windows (XP, 

Vista, 7) и Mac OS X. во-вторых, hardware – с этим ситуация довольно своеобразная и требу-
ет некоторых комментариев. Поскольку программное ядро SketchUp разрабатывалось бо-
лее десяти лет назад (понятно, под «железо» той поры), обладатели даже весьма «пожи-
лых» компьютеров могут быть почти на 100% уверены, что проблем не будет. Другой вопрос 
– сложность, «тяжесть» конкретной модели, проекта, с которыми приходится работать – в 
этом случае весьма ощутимы возможности вашего компьютера, которые будут проявляться 
в комфортности и скорости работы.

Программа предъявляет весьма скромные требования к производительности про-
цессора и оперативной памяти. Несколько сложней ситуация с видеокартой – визуализация 
(рендеринг) в SketchUp происходит в режиме realtime, т.е. одновременно с процессом мо-
делирования в реальном времени, с использованием стандартного графического 3D-движ-
ка OpenGL, который оптимально работает под управлением видеокарты. И хотя программа 
будет работать и на примитивном, интегрированном в «материнку» видеоадаптере (типич-
но для компьютеров офисного класса), на быструю и комфортную работу рассчитывать не 
приходится. Да и вообще, серьезно заниматься графикой (а тем более – 3D) без подходящей 
видеокарты просто нереально... Какие видеокарты можно рекомендовать для работы со 
SketchUp? такой однозначный список привести сложно, но по отзывам пользователей извест-
но, что чаще проблемы возникают с картами ATI и наоборот, реже всего – с картами NVIDIA.

Конечно, на скорость работы влияет и общая производительность системы – понят-
но, что чем мощней, тем лучше! Однако для счастливых обладателей мощных «сегодняш-
них» компьютеров есть огорчительное обстоятельство – SketchUp «не умеет» (во всяком слу-
чае, пока) в полной мере использовать, например, все возможности multi-core процессоров 
и будет работать только на одном «ядре». таким образом, поменяв старенький процессор 
на несоизмеримо более мощный последних поколений, на явно ощутимый эффект «в разы» 
рассчитывать не приходится. Кроме того, хотя SketchUp будет без проблем запускаться на 
64-bit версиях Windows, но работать будет как 32-bit приложение...

С техническими подробностями минимальных и рекомендуемых параметров можно оз-
накомиться на странице офсайта SketchUp Hardware and software requirements: http://SketchUp.
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Google.com/support/bin/answer.py?hl=en&answer=36208.
Инсталляция SketchUp. Здесь потребуется подключение к Интернету и простое сле-

дование указаниям программы-установщика – например, при отсутствии в системе нужной 
версии необходимого программного компонента NET Framework, будет предложено его за-
грузить и установить.

И еще одна мелкая, но существенная деталь – комфортная работа в SketchUp под 
Windows подразумевает наличие трехкнопочной (со средней кнопкой – колесиком) мышки. 
Конечно, сейчас это уже стало вариантом «по умолчанию», но во избежание недоразуме-
ний, все-таки отметим это. 

ИНтЕрФЕЙС
Если следовать поговорке «встречают по одежке...», то первое впечатление от но-

вой программы складывается, когда перед нами при первом запуске открывается ее рабо-
чее окно. И тут, или сразу возникает симпатия и желание продолжить знакомство, или про-
чие варианты: от «надо, значит надо...», до категоричного неприятия. Конечно, это вопрос 
личных предпочтений, и не всегда эмоции точно отражают суть, но тем не менее явная «дру-
жеблюбность» интерфейса программы очень важна, помогая преодолевать неизбежные 
сложности освоения новых понятий, инструментов и методов работы. 

Итак, мы установили SketchUp и в первый раз запустили программу, кликнув на ее яр-
лыке или через стандартную процедуру Windows: Пуск > Все программы. Кстати, здесь же, в 
программной группе Google SketchUp 8, видим еще два названия – LayOut и Style Builder – это 
самостоятельные приложения, дополнения к основной программе (только в Pro), работаю-
щие c ней на общем программном ядре. Задерживаться пока на них не будем, поскольку для 
работы собственно в SketchUp никакой необходимости в этих приложениях нет.

 

  
Сразу после загрузки программы видим рабочее пространство SketchUp и в его цен-

тре – открытое Окно-приглашение (Welcome to SketchUp), в котором необходимо выпол-
нить несколько действий. 

Если загрузили и установили Pro версию, она появляется в пробном, ознакомительном 
режиме – полнофункциональная работа ограничена 8 часами, по истечении которых пред-
лагается приобрести лицензию на Pro версию, и если этого не сделать – программа перехо-
дит в режим free с ограничениями, о которых было сказано ранее. Для регистрации лицен-
зии после приобретения (переход в Pro версию) открываем закладку License > Add License 
и вводим свои данные. 

Через это же окно доступны также Learn – справочные и учебные интернет-ресурсы 
(естественно, на английском языке) и некоторые другие, но сейчас нам нужен только раз-
дел Template (Шаблоны). 

Это набор предустановленных настроек проекта, из которых нужно выбрать наибо-
лее подходящий вариант для выполнения ваших характерных задач. Далее будем подробно 
рассматривать все настройки (их намного больше), которые сохраняются с шаблоном, а пока 
необходимо выбрать один из предлагаемых вариантов единиц измерений (без этого не смо-
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жем войти в программу), в которых и будем работать в проекте. Кликаем кнопку Template – 
открывается закладка Template Selection (Выбор Шаблона), в которой назначается для те-
кущего сеанса работы (и запоминается для последующих) нужный вариант. Доступны едини-
цы как метрические, так и в футах и дюймах. выбираем то, что нужно (удобней, привычней) 
– например, миллиметры. Как видим, этому параметру уделяется особое внимание, и не зря 
– следует сразу подчеркнуть, что в SketchUp мы работаем в реальных физических измере-
ниях и величинах – в этом, в том числе, проявляются его серьезный CADовский «характер».

Больше окно Welcome нам не требуется, тем более, что при необходимости его мож-
но будет открыть в любой момент и позже из пункта главного меню Help. Поэтому снимаем 
«галочку» в переключателе Always show on startup (Всегда показывать при запуске), что-
бы при каждом открытии программы не приходилось повторять одно и то же, и кликом на 
кнопке Start using SketchUp (Начать работу в SketchUp) открываем рабочее окно програм-
мы. Здесь нас встречает Instructor (Инструктор) – окно, в котором можно выбрать и прос-
мотреть анимированные мини-уроки по нескольким основным инструментам и функциям и 
перейти на учебные ресурсы офсайта – закроем его, а если будет желание с ним полностью 
ознакомиться – можно также открыть его в любой момент из меню Window. 

Как видим, интерфейс предельно прост и сразу располагает к себе… хотя бы стилем 
графического оформления кнопок. Скорее всего, вы даже удивлены – что, и это все? Нет 
конечно, на самом деле сейчас видим на экране минимальный «стартовый» вариант компо-
новки интерфейса (Getting Started), который открывается по умолчанию. Пока, для перво-
го знакомства, он нас вполне устроит, и сразу заметим, что в любой момент легко и быстро 
сможем перестроить интерфейс программы под свои задачи и по своим предпочтениям. 

File, Edit, View… и т.д. – типичная система панели Menu bar (Панели главных тексто-
вых меню). Под ней находятся Toolbars (Панели инструментов) с кнопками (buttons) быстро-
го вызова самых востребованных команд, которые в своем большинстве дублируют анало-
гичные пункты меню (и наоборот). 

Посмотрим, как можно перестроить интерфейс на примере дополнения новой пане-
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лью инструментов. Открываем меню View > Toolbars (Вид > Панели инструментов) и вклю-
чаем показ (ставим галочку) на Standard (Стандартные) – панель этой группы инструментов 
сама встает на предназначенное для нее место с левого края. Если же этого не произошло, 
скорее всего размер вашего монитора не позволяет выставить в одну строку уже размещен-
ные панели и новую и образуется вторая «строка» панелей. Кроме того, всегда можно «пе-
ретянуть» панель в любое нужное, удобное для работы место окна программы.

 Кнопки этой панели активируют опции: New (Новый), Open (Открыть), Save (Сохра-
нить), Cut (Вырезать), Copy (Копировать), Paste (Вставить), Undo (Отменить), Redo (Повто-
рить), Print (Печатать), Model info (Инфо по модели). Как видим, это в своем большинстве 
именно «стандартные» опции работы с файлами программ под ОС Windows.

Итак, за исключением «игрушечной» графики кнопок, перед нами в общем-то стан-
дартное построение рабочего окна Windows, поэтому на его «внешних» кнопках управления 
(свернуть, свернуть в окно, закрыть, восстановить и т.д.) останавливаться не будем.

Кнопки в панелях инструментов распределены по функциям в блоках инструментов – 
некоторые из них обозначены на рисунке ниже.

в самом низу экрана видим Status bar (Панель состояния, статусная строка), на кото-
рую в каждый момент времени выводится вся необходимая текущая информация и доступны 
еще несколько функций. Подробно все эти элементы интерфейса будем рассматривать позже.

Ну, а основную площадь рабочего окна программы, естественно, занимает Окно мо-
делирования – сцена, на которой все и происходит. а что это за цветные линии, и что за пер-
сонаж, который стоит в точке их пересечения (начала)? Ее зовут Susan, и она один из чле-
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нов «гугловской» команды SketchUp… Конечно, это шутка разработчиков, но на самом деле 
Susan поставлена в сцену по умолчанию вполне практично. Она имеет «правильный» сред-
нестатистический «рост» ~ 1,7 м, а потому на начальном этапе построения (в пустой сцене) 
может быть использована как приблизительный «измеритель масштаба» объектов нашего 
виртуального мира. впрочем, никакой особой необходимости в присутствии Susan нет, по-
скольку на самом деле SketchUp имеет мощные специальные механизмы точных измерений. 
так что оставить ее «жить в сцене» или сразу удалить – дело личных предпочтений.

теперь вернемся к цветным линиям. Как уже было сказано, все 3D-редакторы исполь-
зуют систему координат, определяющую положение точки в 3D-пространстве сцены, как по-
зицию относительно трех осей моделирования. в SketchUp традиционного буквенного обо-
значения осей нет, здесь они имеют простое цветовое кодирование. Ось X представлена 
сплошной (положительные значения) и точечной (отрицательные значения) (red) красной 
линией. аналогично, оси: Y – зеленой (green), Z – синей (blue) линиями. Плоскость, на ко-
торой пересекаются красная и зеленая ось (X и Y), образует (ground plane) – «землю», а ве-
личины по оси Z определяют «подъем или спуск» относительно уровня «земли». Заметим это 
отличие от большинства 3D-редакторов, где за третье измерение обычно принято понятие 
«глубины», т.е. направление «от наблюдателя» (или «к наблюдателю»). Для SketchUp же, по-
скольку он изначально был ориентирован на архитектурное проектирование, длина и ши-
рина – это «земля», лежащая в плоскости красной и зеленой осей, а третье измерение – вы-
сота (по синей оси). термин оrigin обозначает начало осей (в точке их пересечения на «зем-
ле»), или числовой «ноль» координат. Еще раз подчеркну принципиальную важность пони-
мания механизма осей – без осмысленной работы с ними моделирование и навигация в 3D-
пространстве просто невозможны, а потому мы постоянно будем далее «привязываться» к 
их направлениям и числовым значениям координат.

Попробуем еще один из приемов настройки интерфейса (подробно обо всех воз-
можностях – позже). «Захватив» панель инструментов (за заголовочную часть), можно втя-
нуть ее внутрь Окна моделирования. теперь у панели (за стрелки на углах и сторонах) мож-
но изменить пропорции, «перетащить» в любое место или «причалить» к любой из границ 
окна. впрочем, надо заметить, что и по умолчанию размещение панелей инструментов впол-
не рационально, так что изменение этого стандартного порядка вряд ли имеет смысл без 
особой необходимости… 

теперь посмотрим, что происходит в Окне моделирования, если подвигать курсор 
– видим «карандаш» – курсор уже активного (включенного) по умолчанию инструмента ри-
сования Line (Линия). таким образом разработчики подчеркивают его особую значимость 
(так оно и есть) и как бы предлагают пользователю сразу приступить к рисованию. Однако 
мы вернемся к нему позже, а пока посмотрим общие приемы работы на примере другого, 
не менее значимого инструмента.

Поместим курсор (не трогая кнопки мышки) на самую левую кнопку в панели и задер-
жимся на ней – через очень короткую паузу «всплывает» текстовая подсказка (Tooltips) по 
названию инструмента – Select (Выбор) и в Панели статуса появляется еще одна, предлага-
ющая выбрать объект для работы с ним другими инструментами или командами:
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таким образом показывается, что сейчас будет выбран (включен) этот инструмент (оп-
ция). Кликаем один раз на кнопке:

  
теперь в Панели статуса появилась подсказка по возможным действиям с этим ин-

струментом – первая предлагает выбрать объект в сцене, остальные говорят о двух других 
способах выбора. аналогичную реакцию интерфейса будем постоянно видеть при работе 
со всеми кнопками (инструментами). 

Надо особо подчеркнуть, что для SketchUp характерен уникальный по эффективно-
сти и удобству механизм подсказок разных типов, который сопровождает все наши дейст-
вия, обеспечивая как удобство, скорость, точность работы, так и легкость освоения про-
граммы. Это работает замечательное устройство программы – Inference engine (IE) (Ло-
гический механизм интерфейса), который в любой момент построений обеспечивает 
быструю и точную работу с выбранным инструментом. Поэтому с самого начала имеет 
смысл выработать твердую привычку не торопиться кликать мышкой, а делать паузы перед 
каждым следующим действием (программе необходимо некоторое время, чтобы среагиро-
вать на наши действия) и обязательно «читать» все появляющиеся текстовые и визуальные 
подсказки. Это в разы сократит как время освоения SketchUp, так и избавит от неточностей 
и других ошибок по ходу работы, а значит – и от потерь времени на их исправление. Конеч-
но, со временем, с накоплением опыта работы, необходимость в этом отпадет сама собой, 
как только выработается автоматизм и клик на кнопке станет продолжением мысли... 

Еще один очень удобный механизм интерфейса SketchUp 
– контекстные меню, которые вызываются кликом ПКМ (контек-
стным кликом) на элементах (объектах) построений. 

в основном эти меню дублируют пункты текстовых меню 
и кнопки инструментов (хотя некоторые опции вызываются толь-
ко таким образом), и обеспечивают очень быстрый и удобный 
доступ к нужным опциям. Главный принцип их работы – содер-
жание контекстных меню изменяется в зависимости от конкрет-
ного контекста и показывает все опции, возможные именно с ним 
(выбранным объектом) в данный момент. в связи с этим работа 
с контекстными меню будет рассматриваться далее «по ходу» 
конкретных задач, ситуаций и опций.

таким образом, пользователь по своим предпочтени-
ям может пользоваться несколькими альтернативными, наибо-
лее удобными и привычными для него, способами работы с ин-
терфейсом.

Есть и еще целый ряд элементов (устройств) интерфей-
са, но поскольку они выполняют специфические функции, свя-
занные с конкретными инструментами и действиями, рассмо-
трим их далее в соответствующих темах. 
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Каждый из инструментов (опций) SketchUp по-своему важен, нужен, а иног-

да и уникален при решении определенных задач. Однако все-таки часть из них 
можно назвать основными или базовыми, поскольку с них чаще всего начинается 
моделирование новых объектов, или они чаще всего востребованы. 

По логике разработчиков именно эти инструменты и представлены в «стартовом» 
(Getting Started) варианте интерфейса, на основе которого мы и начали знакомство с про-
граммой – с этим можно согласиться только частично, поэтому далее по ходу изучения бу-
дем строить свой, «рабочий» интерфейс. 

Открываем меню View > Toolbars (Вид > Панели инструментов), отключаем (снимаем 
«галочку») у пункта Getting Started (панель исчезает) и включаем показ (ставим галочки) на 
Principal (Основные) и Drawing (Рисование) – панели этих групп инструментов сами встают 
на предназначенные для них места в вертикальную колонку у левого края экрана. Или, если 
этого не произошло (панели открылись внутри окна моделирования), просто перетаскива-
ем панели в эту колонку, стыкуя одну под другой.

Однако и в этом варианте не все инструменты можно отнести к базовым, первооче-
редным, но об этом по ходу... 

PRinciPal (оСНовНЫЕ) ИНСтрУМЕНтЫ

select (выбор)
Мы уже обращались к этому инструменту в предыдущей теме, теперь рассмотрим его 

более подробно. При всей «знакомости» по другим программам и очевидности смысла опций 
выбора, на него сразу стоит обратить особое внимание – не зря инструмент поставлен «пер-
вым номером». Дело в том, что большинство опций начинаются именно с предварительно-
го выбора объекта, т.е. мы как бы говорим программе, что именно это, выбранное – объект 
последующего воздействия. а так как выбирать приходится постоянно, на эту опцию неиз-
бежно затрачивается значительная доля общего времени моделирования, и поэтому умелое, 
рациональное использование приемов выбора заметно влияет на скорость работы в целом. 
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рассмотрим самый простой случай – кликаем кнопку Select (включаем инструмент), и 
далее в окне моделирования выбираем какой-либо объект одиночным кликом на нем – он 
тут же подсвечивается габаритом из синих линий, показывая, что опция выбора состоялась. 
таким образом производится т.н. «единичный» выбор (рис. ниже слева).

 

возможен также «множественный» выбор, когда требуется «собрать» вместе несколь-
ко объектов (рис. выше справа). Для этого последовательно, по очереди, кликаем на них с 
нажатой клавишей Shift (про это и была подсказка Shift to extend objects). При этом у стрелки 
курсора появляются значки «плюс» и «минус», что и подсказывает возможность поперемен-
ного добавления или вычитания элементов из выбора. Что значит «вычитания»? таким обра-
зом можно не только добавлять объекты в выбор, но и выполнять обратную опцию – исклю-
чать (снимать, отменять) из текущего множественного выбора повторным кликом на них. 

Отвлекаясь от темы, обратим внимание на использование в SketchUp т.н. функцио-
нальных клавиш (Shift, Ctrl, Alt на клавиатуре) – далее увидим, что их применение в разных 
инструментах и опциях и разных сочетаниях не только расширяет вариантность действий, но 
иногда и превращается в совершенно самостоятельные дополнительные функции.

И еще один «подсказанный» ранее вариант – Drag mouse to select multiple. в нем исполь-
зуется механизм, также возможно знакомый по другим графическим редакторам – Selection 
box (Окно или рамка выбора) – «растягивающийся» прямоугольник (от одного угла до про-
тиволежащего по диагонали). Однако в SketchUp он намного «умней» – если строим его, рас-
тягивая слева-направо, выбирается только те объекты (или их отдельные элементы), кото-
рые полностью попадают внутрь. а если (внимание!) растягиваем справа-налево – выби-
рается еще и все то, что пересекают стороны прямоугольника, т.е. выбирается объект (эле-
мент) целиком, даже если рамкой пересекается только его часть. Запомним сразу на эту воз-
можность – на практике постоянно будут встречаться ситуации, когда применение этого ва-
рианта значительно упрощает и ускоряет выбор только нужного.

И общее правило – текущий выбор будет снят (отменен) при выборе другого объек-
та, инструмента, или просто кликом в любом пустом пространстве окна моделирования. За-
метим, что тот же принцип действует и для всех остальных инструментов.

Но и это еще не все – есть несколько других, дополнительных вариантов выбора, ко-
торые могут оказаться более быстрыми и удобными в определенных ситуациях – рассмо-
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трим их позже.

 component (Компонент) 
тут логика разработчиков, поместивших инструмент в «базовые», не очень понятна... 

Дело в том, что это инструмент «продвинутой» стадии моделирования – опции, вряд ли от-
носящейся к самым востребованным на начальном этапе освоения SketchUp... так что вер-
немся к Компонентам для подробного рассмотрения много позже.

 Eraser (Ластик)
Буквальный перевод звучит как «Стиратель», но мы будем использовать более при-

вычное понятие «Ластик». Основное назначение Ластика очевидно – удалять (стирать) не-
нужные элементы построений. в принципе, без него можно и обойтись, поскольку анало-
гичное действие над выбранным элементом стандартно выполняет клавиша Del клавиатуры. 
Однако при удалении линий (ребер) он намного удобней – в этом случае достаточно без их 
предварительного выбора просто провести Ластиком (удерживая кнопку мышки) поперек 
линии (или сразу нескольких линий). Есть у него и еще пара дополнительных функций, но по-
скольку это совсем другая тема – об этом позже.

 Paint Bucket (палитра)
Инструмент назначения материалов (окраски) поверхностей построений. в принци-

пе, этот механизм также не из первоочередных, нужен в основном на финальной стадии мо-
делирования – «отделочных работах», поэтому, как и в ситуации с компонентами, отложим 
его рассмотрение. 

DRawing (ИНСтрУМЕНтЫ рИСоваНИЯ)
Назначение этих инструментов очевидно при первом взгляде – исходное рисование 

линий и стандартных плоских фигур. Начнем с инструментов в правой колонке – с их помо-
щью рисуются различные типы линейных элементов.

line (Линия)
Линии являются в SketchUp базовым исходным элементом, первым и главным из эле-

ментарных «кирпичиков» любой модели, поскольку формируют структурный фундамент гео-
метрии всех остальных построений – кривых (точнее – псевдокривых), плоских фигур и дру-
гих, более сложных, объемных объектов. 

Линии в SketchUp имеют только один размерный геометрический параметр – длину, а 
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их толщина всегда одинакова, она как бы «теоретическая», точнее – не принимается во вни-
мание. И еще – фактически линии существуют в модели как Edges (Ребра), которыми они ста-
новятся как отдельных элемент построения, или формируют ограниченную ими поверхность 
и становятся ее границами.

Итак, помещаем курсор на кнопку (появляется подсказка по названию инструмента), и 
после его выбора (кликом на кнопке), курсор изменяется на «карандаш»; помещаем его в сце-
не в стартовую точку > кликаем > тянем линию > кликаем второй раз, обозначая конечную точ-
ку. Есть и второй вариант (если так покажется удобней): кликаем в стартовой точке и, удержи-
вая кнопку мышки, тянем линию > отпускаем в конечной точке. И, конечно, по ходу обраща-
ем внимание на подсказки, сопровождающие опцию (Рисует ребра от точки до точки; Выбе-
рите стартовую точку; Выберите конечную точку или введите значение):

  
Что означает «...введите значение» – это отдельная важная тема, которая будет рассмо-

трена позже. а пока заметим только, что все инструменты в SketchUp контролируются абсолют-
но однозначно и точно в реальных «физических» числовых значениях. Что, собственно, и обес-
печивает применение SketchUp как серьезного профессионального инструмента...

Итак, вернемся к «карандашу» и заметим, что в нашем начальном ракурсе обзора сцены 
стартовая точка автоматически окажется на «земле» – красно-зеленом плане осей. Однако ри-
совать линии можно не только на одном из планов осей «в чистом поле», но и от любой из уже 
построенных линий и на любой уже существующей поверхности или ее ребрах (что и будет по-
казано далее). Это же простое правило действует и для всех остальных инструментов рисова-
ния, поэтому запомним его и больше упоминать не будем.

а куда поместить конечную (Endpoint)? Не торопимся – вытягивая линию после перво-
го клика, подвигаем курсор по экрану, и в какой-то момент увидим, что исходная черная линия 
окрасилась, например, в зеленый цвет, и тут же «всплыла» текстовая подсказка On Green Axes 
(На зеленой оси). Эта подсказка говорит о том, что наша линия легла строго параллельно зе-
леной оси сцены. аналогичная картина будет наблюдаться при совпадении направления линии 
с направлением красной оси (On Red Axes), а при вытягивании «вверх» – синей (On Blue Axes). 
таким же образом и для всех остальных инструментов работает IE программы, который в лю-
бой момент сопровождает построение подсказками, обеспечивая тем самым быструю и точную 
ориентацию в трехмерном пространстве сцены относительно ее осей. 
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Завершаем построение линии вторым кликом, и если теперь сразу снова потянуть кур-
сор, видим, что из конечной точки вытягивается новая линия, как бы предлагая построить про-
должение. Здесь работает еще один принцип рисования линии – конечная точка каждой линии 
автоматически становится стартовой точкой другой линии. Но пока выйдем из режима рисова-
ния – кликаем клавишу Esc или любой другой инструмент. а еще лучше применить и запомнить 
на будущее клавиатурную команду Space (Пробел), которая сразу переключит на инструмент 
Select (тема Shortcut (Коротких команд) будет рассмотрена подробно позже). 

теперь проведем курсором по линии (без кликов) – видим подсказки, всплывающие при 
попадании на т.н. «контрольные точки». Набор таких точек у разных элементов может различать-
ся, а у линии они такие:

Кроме знакомых уже конечных точек, видим Midpoint (Середина) и On Edge (На ре-
бре), т.е. на любой другой (кроме конечных и серединной) точке на линии. Для чего, соб-
ственно, нужны эти точки? Они позволяют легко и абсолютно точно позиционировать кур-
сор при построениях, поскольку в SketchUp действует еще один принципиальный механизм – 
Snapping (Привязки) – «прилипания, примагничивания» курсора к контрольным точкам, как 
только курсор оказывается на неком минимальном расстоянии от них. 

Отвечу сразу на один из типичных вопросов – да, этот механизм работает всегда, т.е. 
его отключение невозможно. Имеющих опыт работы в 2D графических редакторах, где воз-
можно свободное рисование «кистью» или «карандашом», это поначалу может несколько 
напрягать, поскольку иногда возникает ощущение, что эта «прилипчивость» не только не об-
легчает работу, но и мешает. Однако на самом деле в 3D-пространстве SketchUp это просто 
необходимо, поскольку избавляет от ошибочных неточностей, и в итоге значительно уско-
ряет процесс построения – так что это только вопрос времени наработки навыков работы 
с инструментами. впрочем, на самом деле есть возможность не отключения, а «фиксирова-
ния» Snapping – как это работает, мы рассмотрим далее на практическом примере.

Посмотрим теперь, как работает инструмент Line на конкретной задаче – пусть требу-
ется построить прямоугольник, продолжая рисования от уже построенной линии. включаем 
инструмент Line, «цепляемся» к одной конечных точек и вытягиваем новую линию перпен-
дикулярного к исходной, направления. т.е., если первая линия была направлена по зеленой 
оси, вторую вытягиваем (следим за подсказкой !) по красной. Далее, повторяя те же манипу-
ляции, строим следующую, третью линию – опять по зеленой оси, однако делать завершаю-
щий клик не торопимся, а аккуратно помещаем курсор примерно напротив начальной точ-
ки первой линии. И как только он окажется точно в этом положении, появляется еще один 
тип подсказки – пунктирная красная (по цвету оси) линия и текстовая подсказка From Point, 
говорящая о том, что именно здесь надо сделать клик, чтобы следующей линией попасть в 
стартовую (находящуюся напротив) точку построения прямоугольника. вот, собственно, и на-
глядная иллюстрация того, почему мы постоянно должны ориентироваться по осям сцены. 
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а теперь – внимание! Как только завершаем построение, замыкая прямоугольник фи-

нальным кликом в начальной точке первой линии, срабатывает еще один принципиальный 
механизм SketchUp – автоматическое образование Face (Поверхности). Это еще один изна-
чальный, базовый «кирпичик» любого построения – собственно, именно такие плоские По-
верхности и образуют объемные «оболочки» и всех других (независимо от вида и сложно-
сти) объектов. 

 
разберемся теперь с остальными принципиальными механизмами работы «семейства» 

Edge-Face (Ребро-Поверхность): 
1. Отдельные, несвязанные с другими построениями Edges (Ребра) могут «жить» отдельно 

от поверхности, т.е. быть самостоятельным, независимым элементом. По этому же принципу Edges 
– границы замкнутой фигуры могут существовать и без поверхности внутри них – ее можно при не-
обходимости удалить, а ребра останутся на месте.

2. Поверхность не может существовать без образующих, ограничивающих ее со всех сто-
рон линий-ребер Edges. т.е., например, если в нашем построенном прямоугольнике удалить одно 
из ребер – поверхность тут же исчезнет, как бы «вытечет». Но при этом всегда доступно и обрат-
ное действие т.н. «лечение» поверхности – она снова появится («зальется»), стоит лишь снова за-
мкнуть плоскую фигуру недостающим ребром!

3. Уточним – для создания Face (Поверхности), нужны, как минимум, три замкнутых ребра, и 
обязательно – лежащие в одной (!) плоскости: вспомним, что так и рисовали – в плане красно-зе-
леных осей. типичное затруднение начинающих пользователей – ребра замкнуты, а поверхность 
не образовалась – свидетельствует о двух возможных ошибках, и чаще всего, просто о небреж-
ности, неаккуратности построения. Дело в том, что SketchUp, несмотря на свой вроде бы «эскиз-
ный» характер, работает с абсолютно точными величинами, и такого не прощает – запомним это, 
как таблицу умножения! Итак, скорее всего:

– на самом деле линии все-таки не замкнуты (остался минимальный «зазор» между конеч-
ными точками). И, скорее всего – при завершении не дождались подсказки о достижении контр-
ольной точки элемента, к которому тянем линию. Причем эта величина может быть настолько мала, 
что визуально обнаружить такой «зазор» очень сложно. 

– на самом деле не все конечные точки линий лежат в одной плоскости.
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4. Цельные линии-ребра при взаимном пересечении или примыкании автоматически раз-
деляются на отдельные «куски» – сегменты в точке пересечения. в этом нетрудно убедиться, вос-
пользовавшись инструментом Select. такой механизм автопересечения позволяет решить и про-
блему «зазоров», описанную ранее – достаточно только обеспечить пересечение линий – и повер-
хности гарантированно образуются (после чего ненужные более «хвосты» можно удалить). При 
этом сегменты смежных ребер остаются взаимосвязанными – например, перемещение одного из 
сегментов «потянет» за собой остальные. Но если удалить разделяющую линию, то цельность дру-
гой опять восстановится (и здесь – принцип «лечения»).

5. Цельную поверхность можно разделить на любое число отдельных частей-поверхно-
стей, если рассечь ее линиями от «ребра до ребра» – в сущности, это тот самый случай рисования 
линии по существующей поверхности, о котором уже упоминалось. то же произойдет при рисо-
вании новой замкнутой фигуры по поверхности. Соответственно, удаление таких внутренних ре-
бер (или фигур) восстановит («вылечит») цельность поверхности. 

 arc (Дуга)
Инструмент рисования дуговых (арочных) элементов, имеющий три геометрических 

параметра: стартовую точку, конечную точку (расстояние между ними – хорда дуги) и ди-
станцию (высоту) подъема. Соответственно, используем тот же порядок рисования: выби-
раем инструмент (курсор меняется на «карандаш» с дополнительным символом дуги) > кли-
каем в стартовой точке > растягиваем на длину хорды и кликаем в конечной точке > пере-
мешаем курсор перпендикулярно хорде на нужную высоту подъема и третьим кликом за-
вершаем построение.

  

текущие текстовые подсказки в панелях инструментов и статуса: 
– при помещении курсора на кнопку инструмента выводится его название и назначе-

ние – Arc; Draw arcs from point to point with bulge (Арка; Рисование дуг от точки до точ-
ки с высотой подъема);
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– после выбора инструмента предлагается: Select start point (Выбрать стартовую точ-
ку); после начала вытягивания линии хорды: Select end point or enter value (Выбрать конеч-
ную точку или ввести длину), а затем: Select bulge distance or enter value (Назначить вы-
соту подъема или ввести ее величину). 

При аккуратном, медленном вытягивании высоты подъема в определенный момент 
ощущается «зазубрина» на траектории движения, а рядом с курсором появится текстовая 
подсказка о том, что достигнута величина подъема, равная половине окружности (Half-Circle). 

Если начать рисования второй дуги в той же плоскости от конечной точки уже по-
строенной, то при вытягивании высоты подъема в определенный момент рядом с курсором 
появится текстовая подсказка о том, что достигли кривизны, соответствующей касательной 
к первой дуге (Tangent at Vertex), а также эта касательная дуга подсвечивается в зелено-
голубой цвет. таким образом строится идеально плавный переход от одной дуги к другой. 

Заметим, что дуга – первый типичный представитель «псевдокривых» SketchUp, кото-
рые на самом деле состоят из последовательного набора прямолинейных сегментов. И чем 
их больше, тем визуально более «плавней изгиб» кривой. Далее мы подробней рассмотрим 
методику и логику управления такими кривыми.

 Freehand (от руки)
Инструмент рисования нерегулярных непрерывных линий в форме криволинейных 

элементов из связанных прямолинейных сегментов. Фактически это рисование «свободным 
карандашом», точнее – мышкой с постоянно нажатой кнопкой. Здесь работают все те же ме-
ханизмы рисования Curve (Кривых), что и для линий, и для дуг. Кроме того, есть вариант это-
го же инструмента 3D Polyline (3D Полилиний) – рисуется аналогично, но при нажатой кла-
више Shift. Этот тип фактически вообще не является элементом построений, никак не вос-
принимается IE и годится, пожалуй, только для «декорирования». 

Надо сказать, что применение инструмента ограничено редкими специфическими 
задачами, так что на практике можно ни разу так им и не воспользоваться. впрочем, так-
же проблематично качество «свободного» рисования мышкой и в любом другом графиче-
ском редакторе...

теперь в блоке кнопок Drawing (Рисование) перейдем к инструментам рисования пло-
ских фигур (в левой колонке). Это фактически модификации инструментов линейного рисо-
вания, которые позволяют быстро, «в два-три клика», получить из заготовок готовую геоме-
трическую фигуру вместо последовательного рисования каждого из ее элементов.
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 Rectangle (прямоугольник)
Название говорит само за себя – инструмент используется для рисования плоских 

фигур (фактически – сразу поверхностей) прямоугольной формы. т.е. сразу получаем гото-
вый прямоугольник, а не создаем его последовательным рисованием каждого из четырех 
ребер, что мы делали ранее. Это фактически «заготовка» типичного элемента построений 
(во многих других редакторах называемых «примитивами») – еще несколько аналогичных, 
представленных их специальными инструментами, мы рассмотрим далее. Ну и конечно, по-
скольку инструмент базируется на Line, здесь действуют все те же принципы построения и 
аналогичные механизмы. 

После выбора инструмента стандартный курсор изменяется на «карандаш» с дополни-
тельным символом прямоугольника: кликаем в стартовой точке (это будет первый угол пря-
моугольника) > растягиваем > кликаем второй раз, обозначая конечную точку построения – 
противолежащий диагональный угол. Есть и второй вариант (если так покажется удобней): 
кликаем в стартовой точке > удерживая клавишу мышки, тянем линию > отпускаем клавишу 
в конечной точке. Естественно, тут же автоматически образуется Face (Поверхность), а сто-
роны прямоугольника становятся его Edges (Ребрами).

И сразу запоминаем принципиальную «ограничительную» особенность инструмента 
– стороны прямоугольника могут строиться только параллельно (и перпендикулярно) осям 
сцены (или можно сказать – только вдоль них)! С подобного рода ограничениями мы стол-
кнемся и далее, в других инструментах, однако сразу заметим, что предусмотрены (если по-
требуется) и возможности их «обхода», например, за счет управления ориентацией осей, но 
об этом позже...

  
Посмотрим на текущие текстовые подсказки в панелях инструментов и статуса: 
– при помещении курсора на кнопку инструмента выводится его название и назна-

чение – Rectangle; Draw rectandle faces from corner to corner (Прямоугольник; Рисование 
прямоугольных поверхностей от угла до угла);

– после выбора инструмента предлагается: Select first corner (Выберите первый угол), 
а после начала вытягивания: Select opposite corner or enter value (Выберите точку противо-
лежащего угла или введите числовое значение).

Если перед завершающим кликом подвигать мышку, меняя пропорции сторон пря-
моугольника на близкие к квадрату, в какой-то момент можно «поймать» положение, когда 
у курсора появится подсказка Square (Квадрат) и точечная диагональная линия, говорящие 
о том, что получили требуемый результат. аналогичные подсказки возникают при достиже-
ния пропорций т.н. «Золотого сечения» – Golden Section.

 circle (окружность)
Инструмент рисования правильных окружностей. После выбора инструмента стандар-

тный «карандаш» появляется с символом – маленькой синей «заготовкой» круга. Начинаем 
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с указания первым кликом точки центра > перемещаем курсор на нужный радиус > кликаем 
второй раз, обозначая конечную точку построения. второй способ: кликаем в точке центра 
> удерживая клавишу мыши, перемещаем курсор на нужный радиус > отпускаем клавишу в 
конечной точке. тут же автоматически образуется Face (Поверхность), а сегменты ограничи-
вающего контура-круга становятся ее Edges (Ребрами). 

текущие текстовые подсказки в панелях инструментов и статуса: 
– при помещении курсора на кнопку инструмента выводится его название и назначе-

ние – Circle; Draw circles from center point to radius (Окружность; Рисование окружностей 
от центральной точки до радиуса);

– после выбора инструмента предлагается: Select center point (Выберите точку цен-
тра), после начала вытягивания радиуса: Select point on edge» – назначить точку на ребре, 
т.е. радиус.

 

 Многоугольник (Polygon)
Инструмент создания многоугольных (Polygon) фигур, фактически – вписанных в окруж-

ность, с числом сторон от 3 до 100. 
После выбора инструмента стандартный курсор изменяется на «карандаш» с дополни-

тельным символом треугольника – маленькой синей «заготовкой». Начинаем построение кли-
ком в намеченной точке центра > перемещаем курсор в сторону на нужный радиус > клика-
ем второй раз, обозначая конечную точку построения. второй способ: кликаем в точке цен-
тра > удерживая клавишу мыши, перемещаем курсор на нужный радиус > отпускаем клави-
шу в конечной точке. тут же автоматически образуется Face (Поверхность), а линейные сег-
менты-стороны многоугольника становятся его Edges (Ребрами).

Нетрудно сразу заметить, что фактически здесь имеем аналогичный или частный слу-
чай предыдущего инструмента рисования окружности. тогда в чем разница и зачем он ну-
жен? Забегая вперед – разница будет видна при назначении количества образующих сегмен-
тов-ребер и в работе механизма их автосглаживания при выходе в третье измерение... но это 
отдельная тема, к которой обратимся далее. 

Итак, мы разобрались с основными 
инструментами рисования, и теперь стоит 
попрактиковаться в рисовании простейших 
фигур, чтобы окончательно понять, прочув-
ствовать, закрепить методику работы с ними. 
Рисуем, выбираем, удаляем (стираем), рису-
ем другие...
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Выполняя тренировочное рисование разнообразных фигур и линий в пре-

дыдущей теме, наверняка в какой-то момент столкнулись с неудобством обзора 
рабочего пространства, необходимостью изменить «взгляд» в сцену – приблизить, 
удалить, рассмотреть с другого ракурса... О чрезвычайной важности этих функций 
для комфортной и продуктивной работы в 3D уже было достаточно подробно ска-
зано в «теоретической» первой теме и, скажем сразу, в SketchUp под эту задачу 
получаем не просто все необходимые, но и удивительно удобные и быстрые ин-
струменты.

все инструменты навигации доступны из главного текстового меню Camera, однако 
на практике вряд ли имеет смысл им пользоваться – намного рациональней работать с кноп-
ками на панели инструментов, и еще более удобно – через возможность временного пере-
ключение на функции камеры из любого другого инструмента без выхода из него, используя 
только кнопки мышки (подробно далее).

Для начала рассмотрим самую востребованную группу инструментов – управления 
«ручной» камерой, т.е. такой, которой можно свободно манипулировать, используя мышку.

camERa (КаМЕра) 
Открываем меню View > Toolbars, включаем показ (ставим галочку) на пункте Camera 

(Камера) – блок кнопок добавляется в панель инструментов. 

Сразу разберемся с одним типичным заблуждением начинающих пользователей – пе-
ремещения камеры относительно объектов сцены визуально (на экране) могут ошибочно 
восприниматься как перемещения (вращение) самих объектов, поэтому очень важно пом-
нить, что при работе с камерой объекты на самом деле всегда остаются на своих местах! а 
действительно («физически») объекты в пространстве сцены могут перемещаться только со-
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ответствующими специальными инструментами модификаций, которые будут рассмотрены 
далее, т.е. это две совершенно разные, не связанные одна с другой, функции.

И конечно, обращение к этим инструментам сопровождается подсказками в строке 
статуса по их функциям и вариантам использования. Приводить их не имеет смысла, посколь-
ку фактически это описание их работы, которое следует далее.

Итак, вначале выбираем нужный инструмент – кликаем на его кнопке, удерживаем 
кнопку мышки и перемещаем курсор.

 Orbit (вращение) 
Инструмент вращения камеры вокруг Target – точки нацеливания взгляда (об этом 

чуть дальше). При этом мы как бы «объезжаем с камерой в руках» на фиксированном рас-
стоянии от этой точки, постоянно удерживая взгляд на ней. 

По умолчанию камера удерживается в вертикальном (относительно «земли») поло-
жении, но при необходимости с нажатой клавишей Ctrl ось камеры можно отклонить на лю-
бой угол, т.е. наклонить ее относительно линии горизонта. впрочем, необходимость тако-
го рода манипуляций, во всяком случае, на этапе построений, практически не встречается. 

Если вращать камеру, одновременно нажав и удерживая клавишу Shift, временно пе-
реключаемся в другой инструмент – панорамирования Pan (см. далее). 

 Pan (панорамирование) 
Инструмент перемещения камеры в плоскости экрана на фиксированном расстоянии 

«в глубину» – только влево, вправо, вверх, вниз. Нетрудно заметить, что это полный аналог 
такого же инструмента 2D-редакторов, что понятно, поскольку здесь доступна манипуляция 
камерой только в некой плоскости, т.е. в двух измерениях.

  Zoom (Лупа) 
Инструмент увеличения (при движении курсора вверх по экрану) или уменьшения 

(движение курсора вниз по экрану) изображения объекта – т.е. приближения/удаления. 
Фактически – имитация операторских приемов «наезда» и «отъезда» камеры на/от «акте-
ра» или работы с зуммированием объектива, знакомым всем по работе с фотокамерой. 

важный момент, который следует запомнить сразу и учитывать в применении ин-
струментов камеры – центр приложения их действия (точка нацеливания взгляда) по умол-
чанию определяется позицией курсора в сцене в данный момент. Что это значит? Напри-
мер, для увеличения изображения какого либо объекта инструментом Zoom сначала по-
мещаем курсор именно на него. работает и еще один очень простой и удобный механизм 
«принудительного целеуказания» – сделав двойной клик любым из этих трех инструмен-
том камеры в любой нужной точке окна моделирования, тем самым однозначно нацелива-
ем камеру (взгляд) именно на нее. визуально это выглядит как вывод изображения «цели» 
в центр экрана.

Надо иметь в виду, что иногда (чаще при большом увеличении) проявляется харак-
терная особенность в работе Zoom – если в этот момент курсор находится в пустом поле 
сцены, инструмент реагирует очень «вяло», почти перестает действовать, поскольку как 
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бы теряет «точку отсчета» пространства сцены. решение проблемы простое – перед зум-
мированием перемещаем курсор на ближайший видимый объект.

Еще одна функция инструмента, управляющая параметрами объектива нашей вир-
туальной камеры – Field of View (FOV)(Поле взгляда). Заметим, что при этом сама камера 
уже не перемещается, т.е. находится в фиксированном положении, хотя визуально проис-
ходит как бы приближение/удаление наблюдаемого объекта. Опция включается удержа-
нием клавиши Shift, и позволяет расширять (движением курсором вверх) или сужать (дви-
жением курсором вниз) ширину поля взгляда. FOV фактически имитирует изменение фоку-
сного расстояния реального объектива – мы как бы получаем возможность менять обыч-
ный объектив, например, на «широкоугольный». Описывать, как проявляется изменение 
FOV, не имеет смысла – просто попробуйте инструмент в действии, рассматривая какой-
либо объект, а еще наглядней – в сочетании с Zoom. 

Еще одна возможность, о которой подробнее поговорим позже – как и для геоме-
трии построений, для камеры работает механизм назначения точных числовых параметров 
FOV – например в градусах «45 deg», или в фокусном расстоянии «35 mm», что эквивален-
тно фокусному расстоянию реального 35мм объектива. 

И еще один, очень существенный для удобства и скорости работы момент. Orbit, 
Pan и Zoom находятся в работе постоянно, а потому имеет смысл пользоваться не пункта-
ми главного меню и даже не кнопками на панели инструментов, а их альтернативой, на-
значенной на СКМ. Смысл и преимущество такого варианта – возможность временного пе-
реключение на функции камеры из любого другого инструмента без выхода из него! Ска-
жем, при рисовании Line может потребоваться по ходу изменить обзор объекта под кур-
сором (например, приблизить изображение для обеспечения точности) – переходим на 
работу со средней кнопкой (колесиком). При этом инструмент рисования остается актив-
ным, и как только отпускаем СКМ (выходим из Zoom), можем продолжать (завершать) ри-
сование тем же инструментом Line. 

Итак, используя СКМ:

 нажать и перемещать = Orbit (Вращение);

 Shift + нажать, и удерживая, перемещать = Pan (Панорамирование);

 вращать колесико = Zoom (Лупа): от себя – увеличение, на себя – умень-
шение.

Это настолько удобно и интуитивно естественно, что после какого-то времени ак-
тивной работы в SketchUp аналогичные опции будете автоматически пытаться повторять в 
других редакторах... где, к сожалению, такой функции нет.

Zoom window (окно увеличения) 
Инструмент показа границ окна просмотра (увеличения) «растягивающимся» пря-

моугольником выбора. также как и Pan, фактически полный аналог такого же инструмен-
та 2D графических редакторов.
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 Zoom Extents (показать все) 
Инструмент вывода окна просмотра такой степени увеличения/уменьшения изобра-

жения, в котором показываются (охватываются) все объекты сцены одновременно. Очень 
полезен в ситуациях, когда требуется восстановить потерянную ориентацию в сцене после 
каких-либо случайных или неудачных манипуляций с камерой или после импорта очень боль-
ших объектов. 

Далее следуют два также очень нужных инструмента, позволяющих «вернуться» к пре-
дыдущему/последующему «взгляду». Это возможно, поскольку каждое действие с инструмен-
тами камеры (вход/выход из вида, установки точки взгляда) автоматически фиксируются и за-
поминаются программой, как последовательные шаги.

 Previous (предыдущий вид) 
Инструмент пошаговой отмены последней (текущей) установки точки взгляда и воз-

врата к предыдущей.

 next (Следующий вид) 
Инструмент пошаговой отмены последней (текущей) установки точки взгляда и пере-

мещения к последующей. 

ViEws (вИДЫ)
Еще раз вспомним первую тему – там мы уже говорили о стандартных, предваритель-

но установленных видах (проекциях). За эти опции отвечает следующая группа инструментов 
навигации, панель которых вызываем через главное меню View > Toolbars > Views (Виды). 
Панель по умолчанию помещается в горизонтальную «строку» панелей инструментов, рас-
положенную под текстовыми меню, над окном моделирования.

По порядку следования: Iso (Изометрия); Top (Сверху); Front (Спереди); Right (Спра-
ва); Back (Сзади); Left (Слева). Кроме того, есть еще вид Bottom (Снизу), который не пред-
ставлен кнопкой на панели инструментов (как довольно редко используемый) и доступен 
только из главного меню Camera > Standard Views (Стандартные виды). 

Надо заметить, что во многих 3D-редакторах предусмотрена возможность одновре-
менного вывода в рабочее пространство моделирования нескольких окон проекций – как 
правило, трех ортогональных (параллельных) в разных комбинациях, и одного перспектив-
ного. При этом изменения, происходящие при работе в одном окне, соответственно ото-
бражаются и в остальных. в SketchUp в каждый момент времени доступно только одна про-
екция (окно, вид) – для быстрого переключения между ними и предназначены инструмен-
ты панели Views. Какое из этих двух интерфейсных решений лучше, сказать трудно – во вся-
ком случае, «одноконное» устройство SketchUp никаких затруднений или неудобств не со-
здает, обеспечивает максимально большое рабочее пространство, и к тому же вполне ло-
гично для его специфики. 

а в какой же проекции находимся сейчас? Пока (и по умолчанию после запуска про-
граммы) мы работаем в окне Iso (Изометрия). Здесь может возникнуть логичный вопрос – 
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почему же тогда говорим о перспективном виде, ведь изометрия (специфические типы чер-
тежных проекций) – это нечто совсем другое? Дело в том, что со Стандартными видами свя-
зан еще один дополнительный механизм обзора (только из меню Camera) – выбор режи-
ма взгляда между Parallel Projections (Параллельным), в котором все линии вдоль каждой 
из осей параллельны (т.е. в ортогональных проекциях) или Perspective (Перспективным), с 
перспективными искажениями (он и включен по умолчанию). 

Здесь же, в меню Camera видим еще один специфический, также условный вариант 
проекции – Two-Point Perspective (Двухточечная перспектива), который отличается тем, что 
все вертикали построений параллельны синей оси и между собой, а перспектива работает 
только для горизонтальных направлений. Следствием такого механизма является то, что из 
инструментов «ручной» камеры работают только Pan и Zoom. При попытке вращение каме-
ры инструментом Orbit происходит автоматический выход из этого режима в перспективную 
проекцию. На практике Двухточечная перспектива традиционно применяется в конструктор-
ском и архитектурном проектировании – например, может оказаться наиболее удобной и на-
глядной для показа интерьера помещения.

И еще – отключение, «снятие галочки» у строк меню Parallel Projections и Two-Point 
Perspective равноценно включению, переходу в режим Perspective.

Итак, резюмируем – камера может работать как в «ручном», свободно управляемом 
движениями мышки режиме, так и может устанавливать взгляд в сцену через Стандартные 
виды. Причем любая из этих камер может работать в сочетании с любым из типов проекций 
– например, Iso + Perspective фактически имитирует «человеческий» взгляд в сцену, а Top + 
Parallel Projections – типично «чертежный» вид «Сверху». Благодаря таким широким возмож-
ностям управления камерой, SketchUp одинаково успешно решает задачи как реалистично-
го представления (презентации) сцены в 3D-пространстве, так и точных конструкторских по-
строений, измерений и распечаток в масштабе (например, планов или разрезов помещений). 

разберемся теперь с такой важной для понимания темой, как взаимодействие инстру-
ментов рисования и навигации, точнее – текущего ракурса камеры (направление взгляда в 
сцену). Как уже было сказано, рисовать можно не только по уже существующей поверхно-
сти, но и в пустом пространстве сцены – это типичная ситуация начала создания построений. 
Причем не только «на земле» (т.е. в плане зелено-красных осей), что фактически мы и дела-
ли до этого, но и в других, «вертикальных» планах осей (зелено-синем или красно-синем). 

Очевидней, проще и удобней всего ситуация, когда работаем в одном из стандартных 
видов – при включенном, например, виде Front любые построения могут (и будут) рисовать-
ся только в плоскости плана красно-синих осей этой проекции, т.е. в 2D. Почему, кстати, име-
ет смысл начинать новые построения именно в таких, ортогональных проекциях, поскольку 
в них к тому же обеспечивается максимальный контроль за точностью. а если в итоге тре-
буется ориентировать построение по-другому в пространстве сцены, это легко выполняет-
ся инструментами модификаций (о них – далее).
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работа в ракурсе «свободной» камеры несколько сложней 
– поскольку, например в перспективном ракурсе, видим одновре-
менно все три плана осей. в этой ситуации основной принцип дей-
ствия IE программы в части ориентации построений при рисовании 
заключается в следующем – SketchUp стремится определить, «уга-
дать» в плоскости какого же все-таки плана осей мы намереваемся 
выполнить построение, и выбирает ближайший (преобладающий «в 
кадре») в зависимости от текущего ракурса. И для того, чтобы по-
лучить требуемый результат, нужно «подсказать» это решение программе, показав (вращая 
камеру инструментом Orbit) в наиболее явном виде. 

Заметим, что контролируемое рисование инструментом Line в режиме «свободной» 
камеры затруднительно, поскольку сегменты линии не имеют никаких «плоскостных» данных. 
так же затруднительно выставить в трехмерном виде нужный ракурс при рисовании «ручных» 
кривых инструментом Freehand и контурного прямоугольника Rectangle. 

Что касается построений с явно выраженной плоскостью – Arc и плоскостных фигур 
Circle, Polygon, то здесь SketchUp с самого начала построения дает ясные подсказки, поэто-
му просто не стоит торопиться – внимательно следим за ними.

Arc – плоскость, в которую она «ляжет», зависит от ориентации линии хорды, а затем 
– направления вытягивания подъема. При этом ориентация плоскости будущей дуги сразу 
«подсказывается» соответствующим «осевым» цветом линий хорды и подъема (при их «вы-
тягивании»), а также текстовым комментарием.

 
Circle, Polygon – здесь видим еще более явные подсказки. После выбора инструмента 

стандартный курсор изменяется на символ «карандаш» с дополнительным символом «окруж-
ность» (или «многоугольник»). При перемещении курсора в пространстве сцены этот сим-
вол будет разворачиваться в одной из трех плоскостей, а также менять цвет контура. так, 
показанная на рисунке ниже ситуация говорит о том, что построение будет выполнено в од-
ном случае – в плоскости, перпендикулярной зеленой оси, в другом – красной, в третьем – 
синей. Или по-другому – ось фигуры, проходящая через центр перпендикулярно ее плоско-
сти, будет параллельно таким осям (такого цвета).

Ну и теперь, вооружившись полученными на данный момент знаниями, самое время 
еще раз попрактиковаться с инструментами рисования, используя еще и возможности управ-
ления взглядом в сцену инструментами камеры... 

В завершении темы остается сказать, что рассмотренными инструментами опции 
навигации и управления камерой в SketchUp не ограничиваются – остальные будут рас-
смотрены позже, поскольку относятся уже к другому уровню моделирования и презента-
ционным механизмам программы. Надо заметить, что наиболее эффектно и наглядно все 
замечательные возможности навигации в SketchUp проявляют себя в трехмерных моде-
лях – к инструментам их создания и перейдем в следующей теме.
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Вот мы и подошли к механизмам «выхода в третье измерение», которые 
представлены в этой группе инструментов – Modification Tools. Открываем меню 
View > Toolbars, включаем показ (ставим галочку) на пункте Modification (Моди-
фикации) – блок их кнопок добавляется в панель инструментов. 

Как следует из названия этой группы, инструменты используются для модификаций (из-
менений, искажений, редактирования) объектов. в том числе – преобразования уже созданных 
инструментами рисования плоских 2D-фигур в 3D-модели, а также для изменений положения 
(позиций), размеров, пропорций любых существующих объектов и их отдельных элементов. 

Замечу сразу – в этой теме мы остановимся только на основных, базовых возможно-
стях инструментов и приемах работы с ними. все они обладают мощными дополнительными 
функциями, как правило связанными с решением конкретных задач моделирования – они бу-
дут подробно рассмотрены позже.

 Push / Pull (вДавИтЬ / вЫтЯНУтЬ)
Удивительно, но далее мы увидим, что создание в SketchUp всего многообразия трех-

мерных объектов фактически основано на использовании одного принципа – «выталкива-
ния» или «вытягивания» плоских 2D-поверхностей в третье измерение, что, как отмечали, 
отражено и в названии самой программы: Sketch – эскиз, Up – вверх! 

Итак, инструмент, буквально работающий на этом принципе, действие которого об-
ычно обозначается в 3D-редакторах термином Еxtrude – выдавливание. Инструмент не ра-
ботает с ребрами, а только с Faces(Поверхностями) и – только в направлении, перпендику-
лярном (точнее, нормальном) самой исходной поверхности. И еще – «за раз» можно приме-
нить инструмент только к одной, единичной поверхности, т.е. он «не умеет» одновременно 
работать с несколькими (собранными множественным выбором) поверхностями, даже ле-
жащими в одной плоскости. Это принципиальные ограничения, которые стоит сразу запом-
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нить как причину возможных типичных затруднений при применении. Если к поверхности, 
которую мы выбрали для Push/Pull, невозможно применить этот инструмент, появляется под-
сказка рядом с курсором в виде символа «запрещающего знака». такой типичный случай – 
попытка «выдавить» криволинейную (точнее – сглаженную) поверхность, например – боко-
вую поверхность цилиндра, поскольку в этом случае она воспринимается не как плоская. 

Есть два варианта применения инструмента, точнее, два варианта последовательно-
сти действий: 

Способ 1. Если в ничего в сцене не выбрано, то после помещении курсора инстру-
мента (который изменится на его изображение) на поверхность автоматически происходит 
ее выбор, так что нет необходимости ее предварительного выбора инструментом Select. т.е. 
здесь нет необходимости предварительно кликать на вытягиваемой поверхности – доста-
точно просто перемещать курсор Push/Pull с нажатой кнопкой мышки и поверхность будет 
«следовать» за ним. Для завершения опции отпускаем кнопку мыши в нужный момент (при 
достижении нужной величины). 

 

Недостаток этого метода, при всей его быстроте, заключается в том, что при этом «вы-
тягиваемая/вдавливаемая» поверхность должна быть постоянно видна, находиться в поле 
взгляда до завершения опции. При этом часто бывают ситуации, когда удобней изменить ра-
курс для точного завершения опции, т.е. требуется повернуть камеру – если это сделать, ин-
струмент «теряет» ранее назначенную поверхность. 

Способ 2. Сначала выбираем нужную поверхность, затем кликаем кнопку инструмен-
та. в этом случае у курсора появляется синяя точка, говорящая о том, что теперь курсором 
можно кликать в любом месте (на этом или другом объекте в сцене), указывая сначала на-
чальную точку (точку отсчета), затем конечную, завершая опцию. При этом между этими дву-
мя кликами можно как угодно изменять ракурс камеры – инструмент «помнит» выбранную 
для опции поверхность. 

ввод точных числовых значений (здесь и по остальным инструментам модификаций) 
рассмотрим подробно позже, а пока заметим только, что инструмент работает как в «поло-
жительном», так и в «отрицательном» направлении, что соответствует «понижению» или «по-
вышению» нового уровня относительно стартовой поверхности. Собственно, само двойное 
название инструмента и иллюстрирует этот принцип. 

Еще одну дополнительную функцию инструмента описывает подсказка в статусной 
строке – «Ctrl = toggle create new starting face». т.е. после выбора поверхности и нажатия 
клавиши Ctrl (удерживать не обязательно) опция будет завершаться созданием новой стар-
товой поверхности, которая при дальнейшем движении курсора остается на месте... и так 
далее – как бы «поэтажно». таким образом, фактически происходит воздействие не на саму 
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выбранную поверхность, а на ее копию, при этом «оригинал «остается на месте. Далее в пра-
ктических примерах мы увидим, насколько это полезно во многих ситуациях...

И еще одна очень полезная функция – если сразу после применения на одной повер-
хности дважды быстро кликнуть (двойной клик) инструментом курсора на другой – будет вы-
полнено то же действие на ту же величину и в том же направлении!

 FOllOw mE (СЛЕДУЙ За МНоЙ)
Инструмент фактически является продвинутым вариантом предыдущего: то же вы-

давливание плоскости 2D-фигуры (профиля), но уже по (вдоль) определенной направляю-
щей линии (пути). При этом профилем выдавливания может быть любая поверхность (Face), 
а направляющей (Path) – любая одиночная линия-ребро (прямая или ломаная) или ребро 
другой поверхности. в зависимости от особенностей геометрии конкретного объекта, мож-
но применять несколько разных вариантов (приемов) работы с инструментом – рассмотрим 
их на простых примерах. 

Сначала – случай выдавливания профиля (шестиугольника в примере) по пути – оди-
ночной кривой линии:

  
Здесь применим первый способ, который можно назвать «ручным». выбираем инстру-

мент (кликаем кнопку) – появляется курсор в виде этого инструмента > помещаем курсор 
на профиль, тем самым выбирая его > удерживая кнопку мышки, аккуратно тянем профиль 
по направляющей (при правильном направлении движения она подсвечивается красным 
цветом) > отпускаем кнопку в конечной точке направляющей, завершая создание объекта.

теперь рассмотрим вторую типичную ситуацию – выдавливание профиля вдоль пути, 
который является ребром другой поверхности, причем неважно – отдельная это поверхность 
или принадлежащая трехмерному объекту.

  
Здесь в качестве направляющей используем ребра верхней грани шестигранной при-

змы, т.е. замкнутую кривую (иначе для ребер поверхности и быть не может). Применяя тот 
же ручной метод, можно убедиться в его сложности и ненадежности в некоторых случаях – 
может возникать непредсказуемая геометрия при неаккуратном движении курсора в зоне 
замыкания объема выдавливания – инструмент как бы «теряется» в выборе пути следова-
ния (рис. выше слева). 
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Особенность действия инструмента – после начала опции профиль автоматически 
«пристраивается» к начальной точке направляющей линии, разворачиваясь таким обра-
зом, что ее начальный сегмент становится нормалью к профилю. Однако в справочной до-
кументации к SketchUp указано, что профиль выдавливания нужно таким правильным обра-
зом «вручную» примкнуть к направляющей до начала опции. т.е., несмотря на такой «авто-
матизм», все-таки лучше не допускать совсем уж «вольное» взаимное расположение профи-
ля и направляющей, поскольку возможны непредсказуемые результаты, о чем и сигнализи-
рует иногда «всплывающее» предупреждение (рис. выше слева).

Заметим, что инструментом можно создать более сложный объект, выбрав в качестве 
направляющей не одну, а две смежные поверхности (в т.ч. лежащие в разных плоскостях) или 
даже несколько – такая возможность зависит от конкретной геометрии (рис. выше справа).

теперь опробуем второй, «автоматический» способ, в котором главное – запомнить 
и соблюдать правильную последовательность действий. Не выбирая инструмент (!), первым 
шагом выбираем направляющую (в нашем первом примере – все сегменты кривой), вторым 
– выбираем инструмент и просто кликаем его курсором по поверхности профиля – получа-
ем гарантировано корректный результат! в случае выдавливания по ребрам поверхности 
автоматический способ срабатывает аналогично, если выбирать не все ребра поверхности, 
а саму поверхность (!), что еще быстрей и удобней. т.е. мы тем самым как бы подсказыва-
ем инструменту, что профиль выдавливания должен полностью обрамить указанную повер-
хность по периметру (если, конечно, требуется именно это). Делаем вывод – это самый про-
стой и надежный вариант практически во всех ситуациях!

Есть и еще один способ, подсказанный в статусной строке – Alt = face perimeter. т.е. 
выбираем поверхность-профиль первым кликом курсора > зажимаем клавишу Alt > поме-
щаем курсор на любую поверхность – профиль выдавливается по всему периметру (ребрам) 
этой поверхности. Как видим, предыдущий «автоматический» способ включает и эту возмож-
ность, так что можно сделать вывод – все-таки является самым удобным.

И в завершении – еще одна замечательная возможность применения инструмента – 
создание объемных тел вращения. во многих 3D-редакторах для этого выделяется отдельный 
инструмент, а в SketchUp задача имеет изящное решение применением того же Follow Me за 
счет использования круговой направляющей. Здесь однозначно необязательно примыкание 
профиля и направляющей окружности друг к другу, а характер результирующего объема бу-
дет зависеть от взаимного расположения и размеров профиля и направляющей окружности.
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 OFFsEt (КоНтУр)
Сам инструмент не создает новые трехмерные объекты, однако чрезвычайно поле-

зен и постоянно используется в работе, значительно облегчая задачи добавления деталей в 
модель и создания объектов со сложными объемами. 

Коротко принцип действия – создается копия лежащих в одной плоскости ребер по-
верхностей любых очертаний (а также отдельных кривых) за счет их копирования на одина-
ковом расстоянии от исходного положения элементов – как внутрь, так и наружу. Причем под 
«кривыми» понимается два и более смежных прямых линейных сегмента, лежащие в одной 
плоскости – по 3D-терминологии – coplanar (запомним этот термин!). таким образом, если по-
пытаться применить инструмент к отдельной прямой линии-ребру или кривой, все сегменты 
которой не coplanar, появится «запрещающий знак» с соответствующей текстовой подсказ-
кой. И еще – для отдельных кривых требуется предварительный выбор всех ее сегментов 
инструментом Select (в остальных случаях – курсором включенного инструмента).

в случае с поверхностями, поскольку создаются новые ребра, всегда создается и но-
вая (дополнительная) поверхность, которую они ограничивают. 

После выбора поверхности (ребра) на одном из ребер (On Edge) появляется красная 
точка, показывающая «точку отсчета» воздействия инструмента. После этого тянем курсор с 
нажатой клавишей внутрь (создаем внутренний, меньший контур) или наружу (создаем внеш-
ний, больший контур) от исходного ребра, и для завершения опции отпускаем клавишу мыши 
в нужный момент. Движение сопровождается временной черной точечной линией, подска-
зывающей направление действия инструмента.

На рисунке ниже показана возможность использования инструмента для быстрого 
построения объема типа полого цилиндра (здесь новая внешняя поверхность далее подня-
та инструментом Push/Pull, образуя «стенку»). 

  
Инструмент можно использовать с тем же принципом действия и для работы с Arc 

(Дугами), и с кривыми, нарисованными инструментом Freehand – их копии также создаются в 
той же плоскости, что и исходный элемент. 

 mOVE (пЕрЕМЕЩЕНИЕ)
Этот, один из самых востребованных инструментов SketchUp, используется для пере-

мещения любых объектов и элементов построений, а также обладает еще несколькими до-
полнительными мощными функциями. 

Здесь работают те же два способа (последовательности) выполнения опции выбора 
объекта воздействия, аналогичные инструменту Push/Pull (см. выше) – без предварительно-
го выбора, если ничего не выбрано до этого, и с предварительным указанием объекта его 
выбором. видим, что движение сопровождается временной точечной линией, подсказываю-
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щей направление перемещения – красной, зеленой, синей, если движемся по осям, или чер-
ной во всех других направлениях.

Еще одна очень замечательная функция инструмента – возможность одновременного 
с перемещением дублирования перемещаемого элемента (подсказка: «Ctrl = Toggle Copy»). 
т.е. с нажатой клавишей Ctrl перемещается не сам выбранный элемент, а его копия, а ори-
гинал остается на месте. точнее – выбрав инструмент, перед или во время перемещения 
кликаем клавишу Ctrl (удерживать не обязательно). При этом, кроме подсказки направле-
ния, цветом линии рядом с курсором появляется еще одна подсказка – символ «+». вспом-
ним, что похожая по принципу действия возможность доступна в ранее рассмотренном ин-
струменте Push/Pull.

Но это еще не все – остановимся на механизме, который в SketchUp называется Auto-
fold (Автоискажение). Суть его заключается в том, что все смежные элементы построений 
связаны (как бы склеены через конечные точки ребер поверхностей), и поэтому любые дей-
ствия с геометрией и положением одного из элементов автоматически «передаются» на со-
седние, смежные. таким образом и происходит автоискажение поверхностей, иногда сопро-
вождаемое и автосозданием новых ребер (и поверхностей). 

  
Помещаем курсор на грань кубика, т.е. Face (Поверхность) > удерживая клавишу мыш-

ки, двигаем курсор – вся грань перемещается вслед за ним > кликаем для завершения опции. 
Помещаем курсор на какое-либо Edge (Ребро) – при перемещении теперь будет дви-

гаться только выбранное ребро, искажая также геометрию связанных с ним ребер. а по-
скольку остальные (несвязанные) элементы остаются на месте, происходит изменение гео-
метрии поверхностей, и в целом получаем совершенно другой характер объекта. 

Помещаем курсор на какой-либо угол кубика Endpoint (Конечную точку) – при пере-
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мещении теперь будет двигаться только выбранная точка пересечения ребер, изменяя дли-
ны и направления трех связанных с ней ребер, за счет чего также получаем новую геоме-
трию. Как видим, здесь к тому же появляются и новые ребра. 

Однако в некоторых случаях инструмент «отказывается» выполнять такое искажение 
перемещением элемента в том направлении, которое ему указываем, а как бы «упираясь» 
в некую преграду. И при этом часто происходит неуправляемое перемещение совершенно 
в другом осевом направлении с непредсказуемым результатом. Описать все ситуации, ког-
да это происходит, довольно затруднительно, поскольку это связано с конкретной геоме-
трией объекта и выбором конкретного элемента объекта. Каков же выход? Если посмотрим 
на подсказки в панели статуса после выбора инструмента (не забываем это делать постоян-
но!), видим: «Alt = toggle Auto-fold», т.е. с нажатой клавишей Alt происходит переключение 
в режим искажения в любом направлении (снятия всех ограничений). 

Естественно, тот же самый механизм работает и на плоских фигурах. 
Обратим внимание еще на одну подсказку а панели статуса после выбора инструмен-

та: «Hold Shift = lock inference». О чем идет речь? ранее уже упоминали этот механизм IE – 
автоматического прилипания, привязки – snapping. Фактически все инструменты стремятся 
«найти точку опоры, отсчета» на ближайших элементах построений. в нашем примере это 
означает, что начав перемещение объекта (элемента) вдоль одной из осей, в какой-то мо-
мент можно оказаться в зоне нежелательного «притяжения» другого элемента, которое из-
менит траекторию движения. Эту проблему можно решить, просто «переместив взгляд» (по-
вернув камеру) в другой, более удобный, «безопасный» ракурс, в котором по пути переме-
щения не встречаются «посторонние» элементы. 

Однако для таких случаев предусмотрен и специальный механизм фиксации (уточним 
– только вдоль осей!), который и работает согласно подсказке – начав (!) перемещение, за-
жимаем и удерживаем клавишу Shift, т.е. как бы мы не перемещали курсор по сцене, движе-
ние будет «разрешено, зафиксировано» только по той оси, по которой перемещение было 
начато. При этом линия траектории соответствующего цвета осей становится более жирной.

Кроме того, доступен еще один механизм фиксации аналогичного назначения, ко-
торый управляется клавишами клавиатуры со стрелками (нажимаем до начала движения): 

 
«стрелка влево» – движение будет разрешено только по зеленой оси;
«стрелка вправо» – движение будет разрешено только по красной оси;
«стрелка вверх (или вниз)» – движение будет разрешено только по синей оси. 
Фиксация будет действовать до завершения текущего перемещения или нажатия на 

Esc. Обратим внимание, что при этом появляется и графическая подсказка – видим рядом с 
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символом курсора дополнительный маленький символ двух параллельных плоскостей (рис. 
выше справа).

Уточним еще раз – механизм автоматических привязок к контрольным точкам постро-
ений невозможно отключить, здесь речь идет только о возможности фиксации направления 
движения курсора вдоль осей. И еще – этот же механизм и аналогичным образом работает 
и при рисовании линий инструментом Line.

 ROtatE (враЩЕНИЕ)
Инструмент вращения объектов «целиком» или их искажения за счет вращения от-

дельных элементов построений. 
После выбора инструмента (клика на кнопке) стандартный курсор изменяется на 

изображение инструмента Protractor (Транспортир) с круговыми стрелками. Заметим, что 
работа Protractor, как и других инструментов модификаций, контролируется точными чи-
словыми измерениями, точнее – угловыми величинами (рассмотрим подробно позже).

Первый принципиальный момент – плоскость и ось вращения объекта определя-
ются положением и ориентацией в пространстве курсора Rotate перед началом враще-
ния. И здесь видим аналогичную инструментам рисования графическую подсказку – изо-
бражение курсора меняет цвет на красный, зеленый или синий при «попадании» в пло-
скость соответствующих осей. Здесь также работает принцип – инструмент «понимает, что 
от него хотят», когда нужный план осей преобладает «в кадре» текущего ракурса каме-
ры, т.е. совершенно аналогично ситуации с настройкой ориентации инструментов рисо-
вания. Например, для того, чтобы выставить Protractor вертикально, просто направляем 
камеру выше линии горизонта, и в определенный момент плоскость курсора развернет-
ся как надо. Есть и еще несколько возможностей и приемов управления курсором вра-
щения – их рассмотрим далее на практическом примере.

вообще возможны два варианта работы инструмента: первый – рассмотренный 
выше случай когда курсор (а также плоскость и центр вращения) находятся вне объек-
та, в пустом пространстве сцены. второй вариант – центр вращения должен находиться 
на самом объекте. При этом курсор автоматически стремится «лечь» на одну из повер-
хностей объекта под ним – если ее ориентация совпадает с одним из планов осей, кур-
сор «окрасится» в этот цвет. во всех остальных случаях – останется черного цвета, по-
казывая тем самым, что плоскость вращения не совпадает ни с одним из планов осей. 

  
Если центр и плоскость вращения должны находиться на самом объекте, достаточ-

но просто поместить курсор Rotate на нужную поверхность (грань) объекта – при этом од-
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новременно происходит выбор элемента под курсором (поверхности или ребра), так что 
нет необходимости в предварительном выборе (если в сцене в этот момент не выбран ни 
один из объектов). Следующий шаг после установки курсора в нужное положение: пер-
вым кликом указываем (фиксируем) центр вращения > перемещением курсора (без на-
жатия кнопки мышки) «вытягиваем» пунктирную линию, указывая положение исходного 
(первого) луча угла поворота и вторым кликом фиксируем его > перемещением курсора 
(без нажатия кнопки мышки) поворачиваем объект на нужный угол, т.е. назначаем поло-
жение второго луча угла поворота > третьим кликом завершаем опцию. 

Если центр вращения должен находиться вне объекта, потребуется предвари-
тельно выбирать объект (элемент объекта) инструментом Select (указывая, что именно 
его будем вращать), а уже затем включать и настраивать инструмент Rotate. Естествен-
но, предварительный выбор будет нужен и при назначении поворота нескольким объ-
ектам одновременно. 

а что же с использованием вращения для искажений? Как и при работе инстру-
мента Move, это обеспечивается механизмом автоискажения – вращение одного (или не-
скольких) элементов объекта за счет «скручивания» связанных поверхностей будет со-
здавать новые поверхности и ребра в разных плоскостях. 

 
Посмотрим теперь на подсказки в статусной строке – не откроют ли они нам еще 

неизвестные возможности инструмента? 
Ctrl = toggle Copy – если выбрать инструмент, и перед, или во время вращения 

кликнуть клавишу Ctrl (удерживать не обязательно), то вращаться будет не сам объект, а 
его копия (оригинал остается на месте). Как видим, это аналог опции дублирования с пе-
ремещением инструмента Move, только дублирование происходит по круговой траектории. 

...Hold Shift = align to face – опция выравнивания плоскости вращения (т.е. кур-
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сора Protractor) по поверхности. выше мы уже говорили об ориентировании курсора по 
какой-либо из поверхностей поворачиваемого объекта или по какому-либо плану осей. 
Однако нередко возникает ситуация, подобная показанной ниже: требуется повернуть 
цилиндр в плоскости красной поверхности соседней призмы. во-первых, в случае криво-
линейной поверхности (Surface) очень затруднительно выставить на ней курсор Protractor 
нужным образом, тем более, если требуемая ориентация не совпадает с плоскостью пла-
на осей сцены (как в нашем примере). выход один – «перенести» (как бы скопировать) 
подходящую ориентацию с плана осей или другой поверхности (другого объекта). в этом 
примере «перенесем» ориентацию плоскости вращения с красной поверхности призмы. 

 
Для этого первым шагом выставляем Protractor на призме, затем зажимаем Shift 

и перемещаем курсор на нужное место цилиндра – видим, что при переносе плоскость 
курсора остается зафиксированной в том же положении. Ну и завершаем опцию обыч-
ными шагами вращения.

 

 scalE (МаСштаБИроваНИЕ)
Инструмент используется для изменения размеров и пропорций объектов целиком и 

их отдельных элементов для искажения. Для указания объекта будущего масштабирования 
возможны два варианта выбора (как и для других ранее рассмотренных инструментов мо-
дификаций): можно или предварительно выбрать его инструментом Select, а затем выбрать 
(включить) инструмент кликом на кнопке (стандартный курсор изменяется на изображение 
инструмента), или сначала включить инструмент, а затем кликнуть его курсором на объек-
те (элементе). 

Прежде всего запомним принципиальное ограничение механизма масштабирования 
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SketchUp – он работает только и всегда по направлениям осей сцены (красной, зеленой си-
ней)! Что это значит? Посмотрим, что происходит при работе инструмента на примере куби-
ка, «правильно» ориентированного по осям, т.е. такого, в котором каждая из граней (повер-
хностей) параллельна одному из планов осей, а ребра, соответственно, параллельны осям. 
Сначала выберем для масштабирования одну из граней, например – верхнюю, т.е. фактиче-
ски рассмотрим работу инструмента на плоской форме. Появляется габарит грани из жел-
тых линий с зелеными кубиками – grip (зажимами) в углах и в серединах ребер – всего 8 шт. 
на поверхность. Каждая пара зажимов «отвечает» за возможное направление масштабиро-
вания в одну и другую сторону. в этом «плоском» примере, понятно, будут задействованы 
только две оси – зеленая и красная. 

  
разобраться с тем, что происходит при перемещении зажимов в середине ребер, до-

статочно просто – грань будет масштабироваться вдоль оси в направлении перетягивания за-
жима. аналогично инструмент работает с зажимами, расположенными в углах грани, только 
теперь уже происходит пропорциональное (uniform) масштабирование, т.е. одновременно 
по двум осям (в примере на третьем рисунке выше – красной и зеленой), поскольку направ-
ление масштабирования находится под углом к планам осей сцены.

теперь обратим внимание на подсказки в строке статуса: 
«Ctrl = About Center» – с нажатой клавишей Ctrl происходит двунаправленное масшта-

бирование (в обе стороны) по линии, соединяющей зажимы от центра выбранного элемента;
«Shift = Toggle Uniform» – переключатель попеременного нажатия клавишей Shift 

пропорционального /не пропорционального масштабирование по задействованным осям. 
Кроме того, если одновременно будем удерживать Ctrl + Shift, получим масштаби-

рование от центра – за угловые «зажимы» – непропорциональное, за все остальные – про-
порциональное.

Не очень очевидно, не правда ли? Инструмент, безусловно, непрост для освоения, и 
требует хорошо развитого пространственного мышления. вряд ли прочитанное выше сра-
зу даст полную ясность, поскольку в зависимости от места размещения выбранных «зажи-
мов» (на ребре, на поверхности, в углах) в различных сочетаниях с клавишами Ctrl, Shift, Ctrl 
+ Shif возможны различные варианты масштабирования с разными результатами. выход один 
– практика и еще раз практика – пробуем, смотрим и осмысливаем полученный результат...

Еще сложней ситуация с трехмерным объектом, поскольку любая опция масштабиро-
вания, в т.ч. с клавишами Ctrl и Shift будет влиять на геометрию уже по всем трем осям сцены 
одновременно. Посмотрим, что при этом происходит – выберем весь кубик целиком и вклю-
чим инструмент. Здесь, прежде всего, видим появление еще одного «зажима» по центру ка-
ждой грани – это и понятно, поскольку появляется возможность масштабирования еще по 
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одной оси, нормальной к плоскости грани. 

  

 

FacEs / suRFacEs 
(пЛоСКИЕ / КрИвоЛИНЕЙНЫЕ повЕрхНоСтИ)

На практике не раз придется столкнуться с задачей построения поверхностей слож-
ной кривизны, например – рельефом местности. в таких объектах «режет глаз» их угловатость 
(сказывается «низкополигонный» характер SketchUp). Конечно, можно добиться «гладкости» 
простым добавлением деталей (усложнением геометрии), однако за это приходится распла-
чиваться повышением нагрузки на компьютер со всеми вытекающими отсюда последствиями. 

Однако есть и другое решение, более рациональное решение – в первой «теоретиче-
ской» теме мы коротко рассмотрели типичный для полигонального моделирования механизм ви-
зуального «сглаживания». Он позволяет, имея в своем распоряжении только линейные сегменты 
плоских фигур и образованные на их основе плоские поверхности (Faces), за счет зрительного 
«размывания» ребер-границ между ними, имитировать геометрию сложной кривизны (Surfaces).
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Наглядную демонстрацию этого механизма мы видим при «выдавливании» объемов 
на основе окружностей и дуг инструментами модификаций, например, в цилиндре – при этом 
по умолчанию происходит автоматическое сглаживания его боковой криволинейной повер-
хности. Но, кроме автоматического сглаживания в таких объектах, доступны и опции «при-
нудительного» назначения его параметров.

Как увидим дальше, этот механизм имеет принципиальное значение для решения цело-
го ряда задач – как для собственно построений, так и для назначения материалов поверхностям 
объектов. Опции сглаживания не представлены отдельным инструментом, но тем не менее, 
их вполне можно отнести к инструментам (или опциям) модификаций. 

sOFtEn / smOOth EDgEs (СМЯГЧЕНИЕ / СГЛажИваНИЕ рЕБЕр)
Итак, оптимальным является подход, при котором используется минимально необ-

ходимая детализация моделей в сочетании с эффектом смягчения/сглаживания этой специ-
альной опцией, которая открывается из меню Window > Soften Edges или, что аналогично 
– из контекстного меню на выбранном (клик ПКМ). Наглядней всего действие опций видно 
на примере того же цилиндра – выберете его весь и посмотрите, что происходит при изме-
нении параметров в диалоговом окне опции. 

Angle Between Normals (Угол между нормалями) – величина угла между смежны-
ми поверхностями, при превышении которой «ребро-граница» между ними будет визуально 
смягчена или сглажена. Настройку производим движком слайдера, при этом результат ин-
терактивно отображается на модели. видим, что с увеличением значения угла (перемеще-
нии движка вправо) будет происходить большее искажение модели – подбираем оптималь-
ную величину. Очевидно, что крайнее левое положение движка фактически означает пол-
ное отключение сглаживания. такая возможность иногда требуется для временного нагляд-
ного показа геометрии поверхностей сложной кривизны, поскольку некоторые инструмен-
ты включают сглаживание автоматически. 

результат также зависит от сочетания параметров, назначаемых переключателями 
ниже слайдера: 

Smooth Normals (Сглаживание нормалей) – включение этой опции «сглаживает» ре-
бра между смежными поверхностями, так, что они вместе начинают восприниматься програм-
мой как единая, цельная криволинейная поверхность.

Soften Coplanar (Смягчение Coplanar поверхностей) – включение этой опции «смяг-
чает» ребра между смежными, лежащими в одной плоскости поверхностями, до их полного 
скрытия (аналогично опции Hide).

Еще раз отметим, что смягчение/сглаживание ребер – чисто зрительный эффект пред-
ставления модели, который не влияет на ее геометрию – чтобы убедиться в этом, сделайте 
тройной клик на сглаженном объекте (выбор всех элементов), что даст возможность уви-
деть в т.ч. его скрытые опцией ребра. 
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В предыдущих темах мы изучили принципы работы SketchUp, основные воз-

можности его базовых инструментов и опций. Эта тема будет посвящена закре-
плению полученных знаний и рассмотрению нескольких дополнительных меха-
низмов – как уже знакомых (отложенных ранее «на потом»), так и новых, самых 
необходимых в практическом моделировании с первых шагов. 

Для наглядности построим эту тему на практическом примере – выполним первую 
конкретную работу – пусть нашим учебным проектом будет простой домик. Причем начнем 
с абсолютного «нуля», не задаваясь точными размерами и прочими ограничениями – пола-
гаемся только на свой глазомер, чувство пространства, пропорций, объемов и... фантазию. 
По ходу работы постепенно будем уточнять и дополнять модель – именно в такого рода за-
дачах эскизного, поискового, концептуального 3D-моделирования и проявляются «во всей 
красе» уникальные возможности и достоинства SketchUp! 

Прежде всего надо заметить, что опытный моделер еще до первого клика мыш-
кой прогнозирует в общих чертах ход будущей работы, продумывает оптимальные шаги 
и способы решения задачи. Попробуем сделать это и мы – определимся с последова-
тельностью действий, решив, из каких отдельных частей-объектов будет «складывать-
ся» модель. в нашем случае: сначала построим на «земле» основу – цокольную часть, 
на ней – стены («коробку» дома), затем на нее поставим конструкцию крыши. Ну и да-
лее будем уточнять и дополнять модель деталями и достраивать дополнительные объ-
екты. та же последовательность работ, как и в реальном строительстве, не так ли? 
Этот рациональный подход к моделированию стоит запомнить, и использовать всег-
да и в дальнейшем! т.е. представлять, что не просто рисуем линии и строим некие аб-
страктные трехмерные объемы, а вполне физически реальные детали, из которых со-
бирается, складывается в достоверной последовательности конкретная конструкция, 
объект. Не призма, а например – «ножка стола», не шар, а «глобус» и т.п. такой под-
ход, в т.ч. с возможностью дать значимые «имена» отдельным деталям модели, особен-
но рационален в сложных проектах и удобен в работе с рядом опций SketchUp, что да-
лее и будет показано. 

Итак, запускаем SketchUp – помним, что он откроется в настройках шаблона по 
умолчания (см. Тему 2). Здесь сразу запомним принципиальную особенность моделиро-
вания в SketchUp – программа поддерживает любые размеры сцены (и объектов в ней) 
практически без ограничений! Отсюда следует, что нет никакого смысла пользовать-
ся масштабированием объектов (с уменьшением в определенных пропорциях) – всегда 
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работаем в реальных величинах, что к тому же будет особенно удобно при «конструк-
торском» моделировании в конкретных физических размерах. 

Ну а поскольку нас пока устроят даже приблизительно достоверные размеры, в 
сцене для начала не помешает присутствие человеческой фигуры (как измерителя мас-
штабности) – той самой Susan, которую упоминали при знакомстве с интерфейсом. По умол-
чанию она стоит в «нулевой» точке осей (центре сцены) – отодвинем ее инструментом Move 
в сторону, чтобы она не мешала дальнейшей работе. 

Заметим, что имеет смысл все новые построения начинать, «привязываясь» именно 
к центру сцены – прежде всего, так будет в дальнейшем удобней возвращаться в исходный 
вид из любого другого ракурса камеры одним кликом на кнопках панели инструментов Views 
(Виды). Есть и еще ряд соображений, связанных с передачей модели в другие программы, 
поскольку в файле хранится и информация о ее положении в сцене в осевых координатах – 
но об этом позже...

1  Итак, первым шагом рисуем инструментом Rectangle прямоугольник цоколя 
от центра сцены, «зацепившись» за него первым углом и растягивая по «земле» до вто-
рого противолежащего угла на подходящую величину.

 
Имеет смысл сразу сохранить наш файл, назначив место на жестком диске (луч-

ше – в отдельную папку) и имя – например, «domik_0». И с этого момента начнет рабо-
тать опция автосохранения (о ней позже), что поможет не потерять проделанную ра-
боту в случае непредвиденных проблем.

Здесь надо заметить, что SketchUp поддерживает кириллицу, и мы можем рабо-
тать не только с русскими именами файлов, но и с вводом любых текстовых данных и 
в других, «внутренних» опциях. Однако такого рода проблемы могут возникнуть впо-
следствии при передаче модели в другие 3D-редакторы, рендеры и т.п., которые в сво-
ем большинстве «не понимают» кириллицу. таким образом, если предполагается даль-
нейшая работа с моделью не только в SketchUp, лучше сразу выработать привычку ис-
пользовать только латиницу в именах файлов (и некоторых других опциях – об этом по-
зже). Кроме того, и полный путь к файлу в файловой системе, (т.е. и имена папок), не долж-
ны содержать русских букв, иначе возможны аналогичные проблемы. Например, назначаем 
место сохранения файлов таким образом – D:\DOMIK\ domik_0. 

Мы можем привычно сохранить файл текущего проекта через пункт главного меню 
(File > Save), и также выполнять другие действия с файлами через основные текстовые меню. 
Однако удобней и быстрей все-таки пользоваться кнопками инструментов, поэтому сейчас 
имеет смысл «вызвать» (если ее еще нет) постоянно используемую панель управления фай-
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лами и рядом других опций в наш интерфейс – View > Toolbars > Standard (Стандартные).
 

Мы ее уже рассматривали в теме 2, но все же напомню – кнопки этой панели запуска-
ют типичные для программ под Windows опции меню работы с файлами и редактирования:

– File: New (Новый), Open (Открыть), Save (Сохранить), Cut (Вырезать), Print 
(Печатать);

– Edit: Copy (Копировать), Paste (Вставить), Erase (Удалить), Undo (Отменить), 
Redo (Повторить).

Обратим внимание на опции Undo/Redo, которые помогают быстро (пошагово на-
зад / вперед) отменить предыдущие ошибочные действия или отменить предыдущие от-
мены. Причем количество доступных шагов отмен не регламентировано! 

Назначение кнопки Print (Печать) пока все очевидно, а что касается кнопки оп-
ции Model info (Инфо по модели) – это отдельная важная тема назначения настроек те-
кущего проекта (файла), которая будет рассмотрена позже. 

2  Вторым шагом «поднимаем» инструментом Push/Pull (Толкать/Тянуть) 
поверхность прямоугольника основания на нужную высоту – получаем объем цоко-
ля дома. 

 

Что дальше? вроде бы очевидно – продолжаем «строительство» построением 
стен на верхней плоскости цоколя. Однако здесь задержимся на одной неизбежной 
(при последующих шагах) проблеме. вспомним, что все смежные элементы – ребра и 
поверхности любого построения взаимосвязаны, как бы склеены. таким образом по-
следующие возможные манипуляции со стенами (например, их перемещение или мас-
штабирование), «потянут за собой» и смежные элементы уже готового цоколя. К тому 
же, вообще говоря, на данный момент для программы не существует цельного объек-
та, который мы для себя называем цоколем – пока это просто набор отдельных смеж-
ных ребер и поверхностей. 

gROuP (ГрУппа)
Задачу создания «физически полноценного» объекта решает важнейшая опция 
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SketchUp – Make Group (Создать группу). Группа представляет собой связанную в единое 
целое комбинацию любых (в т.ч. по расположению в сцене) элементов построений, которые 
с момента группировки воспринимаются программой как один объект. т.е. для его выбора 
достаточен один клик инструментом Select на любом из ее элементов, частей.

Замечу сразу – все, что будет сказано про группы здесь и далее на протяжении курса, 
относится и к другому, «родственному» механизму – Components (Компонентам), которые 
фактически являются продвинутой модификацией Групп, т.е. обладают всеми теми же свой-
ствами и возможностями, плюс – своими специфическими. Ну а поскольку Компоненты будут 
подробно рассмотрены отдельно и позже, пока на них задерживаться не будем. 

Итак, группа создается выбором нужных элементов (объектов) и применением коман-
ды меню Edit > Make Group или аналогичной – из контекстного меню выбранного. Обрат-
ная опция (разрыв группы) доступна из меню Edit > Group > Explode или из аналогичного 
пункта контекстного меню ранее созданной группы. Подробнее о работе с контекстным 
меню – чуть позже. 

в чем же суть группы? Главное ее отличие от простого набора отдельных элемен-
тов и главное преимущество заключается в том, что с момента группировки не только «ро-
ждается» единый объект, но он еще и «физически» отделяется (!) от остальных элементов 
модели. Очевидно, что намного проще (особенно в сложной сцене), работать с группа-
ми-объектами, чем с разрозненными ребрами и поверхностями – начиная с опций выбо-
ра и заканчивая любыми другими действиями с ними. Одним словом, соблюдение прин-
ципа «группируем все!» – признак «грамотного» моделирования... в этом не раз убедитесь 
на практике, если придется работать с чужими моделями, в которых этот принцип изна-
чально не был соблюден – их редактирование гарантированно превращается в мучение...

Понятно, что все опции модификаций будут воздействовать на группу, как единое 
целое, т.е. на все содержащие ее объекты одновременно и с одинаковыми параметрами. 
Наглядная иллюстрация – группы обладают очень удобной функцией «разворота на месте», 
точнее – вокруг геометрического центра группы. Это делается с помощью инструмента Move 
(еще одно очень практичное применение инструмента, которое ранее в его теме не рассма-
тривалось). активируем инструмент и помещаем его курсор на одну из поверхностей габари-
та объекта (синие линии) – появляется изображение Protractor (Транспортира), а фактически 
– инструмента вращения Move и четыре красных крестика-маркера, за которые можно по-
вернуть группу в этой плоскости. Заметим, что плоскости габаритного бокса всегда (!) парал-
лельны планам осей сцены, независимо от объектов его содержимого и ориентации в сцене. 
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Группы имеют еще несколько уникальных возможностей в части модификаций и на-
значения материалов – изучим их позже. Ну и конечно, подход к моделированию, как к со-
зданию физически реальных объектов (о котором говорили ранее) возможен только с ис-
пользованием групп, которые к тому же могут иметь индивидуальные, значимые «имена»... 

Итак, прежде всего для создания группы надо выбрать все то, что в нее должно 
войти. Конечно, мы не будем «общелкивать» каждую поверхность и ребро (используя + 
Shift – множественный выбор) – слишком долго и неудобно, а воспользуемся «прямоуголь-
ником» выбора. Однако нередки случаи, когда и такой способ неудобен, не подходит. На-
пример, если за нужным объектом находятся другие, и мы их видим (или их отдельные эле-
менты) в текущем ракурсе камеры – они тоже попадут в зону выбора. Конечно, повернув 
камеру, можно «поймать» подходящий ракурс, но и этот способ может потребовать нера-
циональных манипуляций. 

вот теперь можно познакомиться с дополнительными механизмами выбора, предо-
ставляемыми SketchUp – во многих ситуациях более удобными и быстрыми. 

выбор в быстрой последовательности
Этот механизм позволяет очень быстро, используя только разное число кликов мыш-

кой на любом из элементов построения отдельного объекта, получать разные результа-
ты выбора:

– одиночный клик (знакомая функция) – выбирается только одиночный элемент 
под курсором;

– двойной клик (неважно, на поверхности или на любом из ее ребер) – одновре-
менный выбор и этой поверхности, и всех ее ребер;

– тройной клик (на любом элементе построения) – одновременный выбор всех 
смежных элементов, принадлежащих одному отдельному построению (объекту). 

Как видим, последний вариант как раз и подходит для выбора всего нашего «цоко-
ля», т.е. опция создания группы максимально быстро и точно выполняется сначала трой-
ным кликом для выбора, и затем – командой Make Group.

выбор и создание группы через контекстное меню
Еще одна альтернативная возможность выбора элементов и создания из них группы 

доступны и из контекстного меню выбранного. Контекстные меню (о них уже несколько 
раз упоминалось) – чрезвычайно удобный механизм, который в большинстве случаев пре-
доставляет самый быстрый способ применения доступных в данной ситуации опций. а от-
сюда следует, что имеет смысл выработать привычку проверять через вызов контекстно-
го меню на активном объекте – а что же у нас под курсором, и что можно сделать с этим 
элементом (объектом)? И не исключено, что после этого откроете для себя новые, более 
удобные и быстрые методы и приемы моделирования.

Итак, откроем контекстное меню, сделав клик ПКМ на любом ребре или поверхно-
сти еще не сгруппированного «цоколя» – и далее, через пункт Select > All Connected (Все 
связанное) получаем тот же требуемый результат выбора всех его элементов (рис. ниже сле-
ва). Остальные пункты вариантов выбора удобно использовать в других ситуациях и опци-
ях – вернемся к ним позже. 

После завершения опции контекстное окно закрывается – тут же вызываем его сно-
ва и выбираем пункт Make Group (рис. ниже справа). 
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Как видим, использование контекстного меню дает возможность буквально в пару 

кликов мышкой получить тот же результат без «многошаговых» переходов по пунктам ос-
новных меню или кнопкам панелей инструментов.

lock (Фиксация) группы
После создания группы в контекстном меню появляется этот, присущий только груп-

пам (и компонентам), пункт. Смысл его очевиден – до применения обратной команды Unlock 
(Снятие фиксации), объект «закрыт, защищен» от всех видов выбора и редактирования, что 
обозначается изменением цвета линий его габарита на красный. Думаю, назначение такой 
функции и удобство применения в некоторых ситуациях для защиты объектов от случайных 
«повреждений» не требует комментариев.

Entity inFO (ИНФо по эЛЕМЕНтУ) 
Итак, мы создали группу объекта цоколя. Но где, собственно, зафиксировано это со-

бытие, в т.ч. имя группы (о такой возможности уже упоминали), и какие она имеет параметры? 
в любой момент и на любом построении можно получить всю доступную информацию 

по нему через контекстное меню, выбрав первый пункт Entity Info (Инфо по элементу). От-
крывается специальное диалоговое окно, содержание которого будет зависеть от конкрет-
ного рассматриваемого элемента (объекта), т.е. выбранного контекста. Что нам оно дает? во-
первых, это просто подсказка – что у нас выбрано, и какие имеет характерные параметры. а 
во-вторых, здесь можно назначить и изменить параметры и атрибуты, доступные для редакти-
рования в данной конкретной ситуации. таким образом, это фактически дополнительный ин-
формационно-управляющий инструмент, чрезвычайно полезный в практике моделирования.

вызвав Entity Info на нашей группе, прежде всего видим заголовок, указывающий на 
тип построения и количество его копий в модели (сцене) – в нашем случае Solid Group (Груп-
па). Добавка параметра Solid к имени говорит о том, что у нас получился сплошной замкну-
тый объем – вспомним, что о такого рода объектах было сказано в первой теме. 

Пока на этом задерживаться не будем, поскольку Solid объектам и инструментам ра-
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боты с ними будет посвящена отдельная большая тема. Ниже находится ряд окошек и пе-
реключателей – белый фон в них означает, что здесь доступно изменение данных, серый – 
недоступность для изменений (т.е. они имеют чисто информационный характер). Например, 
окошко Volume (Объем) автоматически рассчитывает и показывает объем объекта в назна-
ченных в проекте единицах измерений – кстати, понятно, что этот параметр доступен толь-
ко для такого типа – Solid-объектов.

Не будем касаться и остальных параметров, которые пока нам незнакомы – обратим вни-
мание на поле Name (Имя). На момент открытия окна оно пустое, так что как раз здесь можно 
вписать (назначить) значимое имя группе (помним о проблеме «кириллица/латиница»). На самом 
деле назначение имен не так уж и обязательно, и никак не влияет на собственно построения. Но 
если для простых проектов можно обойтись и без «личных имен» объектов, то с усложнением, 
увеличением их количества в сцене, «имена» могут значительно облегчить и ускорить работу в 
целом за счет наглядной организации иерархии объектов (об этом позже).

Заметим, что все диалоговые окна SketchUp, представителем которых и является Entity 
Info, после своего первого вызова остаются в рабочем пространстве программы, независимы 
от действий в окне моделирования и будут повторно активироваться при вызове соответству-
ющей опции. Ну и конечно, их можно свернуть, переместить, «причалить» в любое место, за-
крыть и т.п. – таким образом формируем по своим предпочтениям наиболее удобное содержа-
ние интерфейса на каждом этапе работы.

3  Продолжим проект третьим шагом – построением стен. 
во-первых, надо сказать, что одна и та же задача построения определенного объекта 

может быть в SketchUp решена практически всегда несколькими способами, методами, шагами 
– с накоплением опыта работы (и личных предпочтений) вырабатываются самые рациональные. 
Здесь рассмотрим два варианта:

Способ 1.
рисуем по верхней плоскости цоколя прямоугольник того же размера, фактически повто-

ряя ее очертания – ребра прямоугольника будут внешней границей стен. Помним, что благода-
ря сгруппированному объекту – цоколю под ним, сейчас начинаем создание нового, независи-
мого объекта. Далее инструментом Offset движением внутрь обозначаем внутреннюю границу 
стен и удаляем внутреннюю поверхность – остается поверхность, образующая толщину стены. 

а теперь плоскую основу стен инструментом Push/Pull вытягиваем, поднимаем на 
нужную высоту.
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Способ 2
После рисования поверхности прямоугольника – внешнего габарита стен, сразу 

вытягиваем из него объем инструментом Push/Pull на нужную высоту. Затем, как и в 1-м 
способе, инструментом Offset движением внутрь обозначаем внутреннюю границу стен. 

 
И теперь остается тем же Push/Pull «продавить» внутреннюю поверхность вниз, 

до уровня верха цоколя (пола помещения). Причем вовсе необязательно видеть, «вы-
лавливать» при движении этот момент – здесь можно использовать для контроля точ-
ности замечательный механизм snapping – привязок, «примагничивания» действий ин-
струмента к контрольным точкам и ребрам построений. в нашем случае просто «дотя-
гиваемся» в движении курсора Push/Pul до видимого ребра верхней грани цоколя (ви-
дим подсказку «On Edge») и отпускаем кнопку мышки в этом месте, завершая опцию 
абсолютно точно! 

И кстати, запомним – контрольным ребром (или точкой) в аналогичной ситуации 
может быть не только элемент этого же построения, но и любой другой подходящий – 
даже находящийся «в стороне». Поясню на простом примере: имеем в сцене готовый 
объект, например – кубик. требуется построить цилиндр точно той же высоты – рисуем 
окружность основания и начинаем вытягивать ее инструментом Push/Pul вверх. а для 
получения той же высоты, что и у кубика, завершаем опцию, просто аналогично «дотя-
гиваясь» курсором до верхней поверхности или любого ее ребра на кубике, показывая 
тем самым программе, что на такой величине надо завершить опцию.

4  Прорезаем проемы под дверь и окна.
точнее – не прорезаем, а продавливаем: рисуем по наружной поверхности сте-

ны инструментом Rectangle прямоугольник дверного проема, и затем инструментом 
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Push/Pull продавливаем его до внутренней поверхности стены, подсказывая помещени-
ем курсора на ее ребро величину (глубину). Заметим, что как только завершим опцию 
отпустив кнопку мышки, поверхность продавливания исчезает и образуется сквозной 
проем. Это типичный случай (и прием) получения сквозных отверстий (проемов), с ко-
торым в работе будем встречаться постоянно.

 
аналогичным образом создаем первый оконный проем. Предположим, на этой 

стене их должно быть три, совершенно одинаковых – так что же, строить каждый за-
ново? Конечно нет – аккуратно выбираем рамкой слева направо все элементы проема 
(следим, чтобы ничего лишнего не попало в выбор) и используя возможности опции ду-
блирования с перемещением (Move + Ctrl), получаем две его дополнительные копии. И 
внимательно следим за направлением перемещения – строго по оси (плоскости) стены.

 
Но, как видим, возникает одна проблема – ребра продублированы, но собственно 

проемы не образовались – их поверхности, совпадающие с поверхностями стены, от нее не 
отделены. в этом случае придется «подсказать» программе, что это надо сделать – обводим, 
повторяем габариты проемов тем же инструментом Rectangle. И теперь уже можно «прода-
вить» проемы насквозь до внутренней плоскости стены. Это только один из способов ре-
шения задачи, в других случаях далеко не самый рациональный (например, при множестве 
окон многоэтажного дома) – освоив далее другие опции SketchUp, мы сможем получать тот 
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же результат намного быстрее. 
Будем считать, что на данном этапе стены готовы, и аналогично объекту цоколя, трой-

ным кликом (или другим удобным в данной ситуации способом) выбираем все элементы по-
строения стен > Make Group – создаем группу стен (даем имя группе, например, «steni»).

5  Строим крышу.
Кратко – основные шаги:
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Конечно, это также только один из возможных вариантов решения задачи... За-
вершив построение, делаем что? Да, конечно – создаем группу и называем ее «krisha».

Будем считать, что основные объемы построены, и теперь можно приступать к 
«деталировке» – уточнению уже существующих построений, и добавлению новых. Но 
здесь возникает один вопрос – фактически имеем в сцене всего три объекта (цоколь, 
стены, крышу), т.е. любой выбор для применения любого инструмента будет «находить» 
только их – а как же редактировать те элементы, что находятся «внутри» групп? Пре-
жде всего напрашивается самое очевидно решение «в лоб» – временно разгруппиро-
вать только нужный объект, отредактировать, и в итоге снова «собрать» в группу. Од-
нако опытный моделер вряд ли так будет делать, поскольку придется выполнять ряд 
лишних действий, без которых вполне можно обойтись.

редактирование внутри группы
SketchUp предоставляет удобный механизм «внутреннего» редактирования групп, 

который фактически является «обратным ходом» множественного выбора быстрыми 
кликами инструментом Select:

– первым одиночным кликом выбираем группу;
– двойным кликом «входим внутрь группы». При этом видим, что появляется ее 

трехмерный габарит, обозначенный точечными линиями, а все, что находится вне груп-
пы – «затеняется». т.е. тем самым обозначается доступная для редактирования зона 
действий и соответственно все, что находится вне ее – как бы заблокировано. И это 
очень удобно – можно применять любые инструменты и опции без опасения «повре-
дить» остальное, находящееся вне группы. вот и еще одно принципиальное преиму-
щество групп! 

– третьим одиночным кликом выбираем нужный элемент и работаем с ним.
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Можно и сразу, в один прием «добраться» до нужного элемента группы, сделав 
на нем быстрый тройной клик и получить доступ к его редактированию. 

И конечно, не забываем о контекстных меню – и здесь видим еще один вариант 
быстрого входа в редактирование группы – контекстная команда Edit Group. Как ви-
дим, при этом попадаем в состояние, аналогичное двойному клику на группе, а далее 
выбираем и редактируем нужный элемент группы. 

Для выхода из режима «внутреннего редактирования» кликаем в любом месте 
сцены снаружи – получаем «старую» группу с новым содержанием!

6  Дорабатываем модель.
Ниже показан пример такой доработки – использованы только уже известные 

инструменты и опции, поэтому попробуйте понять, «как это сделано» и повторить, что 
будет полезно для закрепления пройденного...
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И в завершении темы группы обратим внимание на еще одну возможность это-
го типа объектов – неограниченное число уровней «вложенности». О чем идет речь? 
в состав группы могут входить любые элементы и объекты построений – в т.ч. другие 
группы, в составе которых могут быть другие элементы, объекты, группы... и так далее. 

Эту возможность можно использовать для «переформирования» состава уже го-
товых групп. в нашем примере – кроме редактирования, детализации уже существующих 
объектов-групп, добавились два новых – крыльцо и труба. а если, например, решили по 
каким-либо соображениям, что лучше группу «truba» перенести внутрь группы «krisha»? 

Это можно сделать двумя способами – построить (и сгруппировать) дополнитель-
ный объект во время внутреннего редактирования «крыши», или сначала создать «тру-
бу», а потом перенести внутрь группы «крыша». Как это сделать? Самый простой спо-
соб (есть и другой, через управление иерархией объектов-групп, о нем позже) – через 
опцию копирования (или вырезания) и вставки (войдя внутрь группы) из буфера обме-
на – Copy (Cut) / Paste. 

Однако здесь есть важные нюансы, которые стоит рассмотреть отдельно. Кроме 
использования пунктов меню, можно (и удобней) применять стандартные для Windows: 
копирование в буфер – Ctrl+С, вырезание – Ctrl+X; вставка из буфера – Ctrl+V. Но здесь 
есть одно ограничение – требуется указание места вставки в сцену содержимого буфе-
ра завершающим кликом. т.е. говорить об абсолютной точности тут не приходится, а 
потому зачастую потребуется еще и уточнять положение вставленного объекта, пере-
мещая его в нужное место.

в ситуации нашего примера, когда нужно вырезать группу «truba» из текущего 
положения и вставить точно на то же (!) место в группу krisha, рациональней всего ис-
пользовать замечательную опцию меню Edit > Paste in Place (Вставить в то же место). 
Пояснений тут, пожалуй, и не требуется – достаточно попробовать ее работу... вооб-
ще же эта опция может очень интересно и эффектно использована в ряде других ситу-
аций, которые мы рассмотрим позже.

Можем считать, что на этом завершаем начальную часть нашего курса, которая 
дает достаточное представление о самых «главных» инструментах, опциях, принципах ра-
боты в SketchUp. Конечно, это только «верхушка айсберга», минимально необходимый 
уровень владения программой... Здесь стоит заметить, что практика общения с начина-
ющими пользователями показывает распространенное заблуждение, что можно «пере-
прыгнуть» начальный этап основательного изучения «азбуки» SketchUp. Вполне вероят-
но, что этому способствует обманчивая простота и функциональная «прозрачность» ин-
терфейса... Однако нетерпение и желание сразу начать конкретный проект, не затрудняя 
себя изучением хотя бы элементарных основ программы, все равно (после многих часов 
работы!) неизбежно приводит к тупиковым ситуациям и вопросам – «а как это сделать?..», 
«почему у меня не получается?..» 

Впереди, в последующих темах книги – изучение дополнительных, еще не рассмо-
тренных возможностей уже знакомых инструментов, и конечно – освоение новых, кото-
рые, собственно, и превращают SketchUp в полноценный инструмент практического 3D-
моделирования уровня уверенного пользователя... 
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Один из самых значимых механизмов и элементов интерфейса SketchUp – па-

нель Measurements (Измерения), по умолчанию расположенная в правой части ста-
тусной строки. Можно сказать, что именно это устройство и превращает SketchUp 
в профессиональный проектный инструмент, поскольку имеет уникальные фун-
кциональные возможности. И кроме того, в любых задачах умелое применение 
Measurements многократно повышает эффективность (качество и скорость) работы. 

Measurements по праву можно назвать «Центральным 
пультом управления», так как здесь реализованы одновременно две функции – и контроля, и 
управления. Как это выглядит: во-первых, динамически, в реальном времени в панели «ком-
ментируются» действия текущего инструмента в числовых значениях так, что в любой момент 
по достижении нужной величины мы можем их завершить. а во-вторых, как бы в обратном 
порядке – можем непосредственно управлять самими инструментами, назначая точные не-
обходимые числовые значения действия опций. Например, начав рисование линии, видим 
ее текущую длину, и тут же можем ввести другое, нужное, точное значение (об этом чуть 
дальше) после чего инструмент завершит построение созданием линии именно этой длины:

Для справки – есть возможность сделать панель инструмента «плавающей» (вывести 
из статусной строки) и разместить ее в любом месте окна моделирования, как и любое дру-
гое диалоговое окно – для этого включаем пункт Measurements в меню View > Tools. впро-
чем, и место панели по умолчанию вполне рационально...

Для каждого инструмента отображение (формат) числовых величин и специфика ра-
боты с Measurements своя, и они будут подробно рассмотрены далее в темах соответствую-
щих инструментов. Но есть и общие принципы использования панели: 

1. Сначала активируем инструмент и начинаем соответствующие действия, как бы по-
казывая программе, что и чем собираемся сделать – при этом Measurements выводит наиме-
нование и текущие числовые значения работающей опции. 

2. Если необходимо назначить свои числовые значения, набираем их на клавиатуре во 
время (до завершения) или сразу после завершения опции (до начала другой опции), и нажи-
маем Enter для подтверждения. распространенная ошибка начинающих – не нужно помещать 
курсор в панель, не нужно пытаться кликать в панели перед набором значения на клавиату-
ре (да это и невозможно) – ввод с клавиатуры считывается в панель автоматически и сраба-
тывает после подтверждения нажатием Enter. Если по ходу набора (до нажатия Enter) реши-
ли заменить значение на другое – пошагово «стираем» цифры клавишей Backspace. Если ре-
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шили изменить значение после нажатия Enter –  просто тут же набираем его заново, т.е. ни-
чего «стирать» в панели не требуется – предыдущее действие будет отменено, и опция бу-
дет повторена с новыми параметрами.

3. Формат ввода и показа числовых значений зависит, прежде всего, от настроек 
единиц измерений, установленных для проекта. вспомним, что частично это мы это сделали 
при первом запуске SketchUp и выборе Template (Шаблона) по умолчанию. Полный же на-
бор настроек проекта (файла) назначается в диалоговом окне Window > Model Info > Units 
(о нем подробно – далее). 

Иногда у пользователя возникает проблема – Measurements просто не срабатывает при 
вводе чисел в форматах, показанных в этой книге. Скорее всего, источник проблемы – в настрой-
ках Windows – здесь приведены стандартные форматы «русского» MS Windows, которые назна-
чаются в Панели управления > Язык и региональные стандарты > Региональные параметры > 
Настройка > Числа. Здесь в окошке «разделитель целой и дробной части» должна стоять запятая  
( , ), а в окошке «разделитель элементов списка» – точка с запятой ( ; ). 

4. Если в панели одновременно выводятся дистанции (размеры, координаты) по не-
скольким осям сцены, всегда предполагается стандартная последовательность (порядок) 
следования осей: по красной (X) – по зеленой (Y) – по синей (Z).

5. все буквенные символы, используемые в панели, должны быть на латинице (пере-
ключаемся на «английскую» раскладку клавиатуры).

6. ввод отрицательных величин (со знаком «минус») указывает программе, что их надо 
отсчитывать в направлении, противоположном начальному направлению движения курсора.

7. Любой инструмент при его повторном использовании всегда стремится использо-
вать (повторить) предыдущую введенную в Measurements величину (величину действия) – не 
торопимся, внимательно следим за поведением курсора и числовыми значениями, появля-
ющимися в панели.

model info / units
Прежде чем приступить к рассмотрению работы инструментов с Measurements, под-

робно рассмотрим числовые настройки проекта (файла): открываем диалоговое окно в глав-
ном меню Window > Model Info (Инфо по модели). Пока ограничимся только пунктом Units 
(Единицы), непосредственно связанным с текущей темой – к остальным будем обращаться 
далее по ходу изучения других, 
связанных с ними, тем.

Панель используется для 
назначения по умолчанию ли-
нейных и угловых единиц изме-
рения и настройки точности ра-
боты использующих их инстру-
ментов в текущем (!) проекте. 
Однако заметим, что при необ-
ходимости можно единовремен-
но заменять (блокировать) на-
значенные в этой панели едини-
цы через панель Measurements, 
если явно указывать в ней дру-
гие единицы (миллиметры – mm, 
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сантиметры – cm, метры – m):

Length Units (Единицы длины):
– Format (Формат) – в раскрывающемся списке выбираем нужный – для нас, естест-

венно, подходит Decimal (Десятичный), поскольку остальные используют только футы и дюй-
мы. в списке рядом выбираем конкретно: миллиметры, сантиметры или метры. 

– Precision (Точность) – точность выбранной единицы измерений (количества нулей 
после запятой). Например, для строительных конструкций вряд ли реальна точность изме-
рений менее миллиметра, но лучше все-таки назначить как минимум – с точностью «до де-
сятых», т.е. «0,0». 

– Enable length snapping (Использовать линейное приращение) – минимально возмож-
ный шаг приращения величин при рисовании или модифицировании. Проще говоря: назначив 
эту величину = «1,0» уже не сможем нарисовать мышкой линию длиной менее 1 мм. Это же 
ограничение будет действовать, например, и при перемещении объекта инструментом Move. 

Можно, конечно, установить другие единицы измерения и повысить точность их ото-
бражения – это вопрос личных предпочтений. Надо только иметь в виду, что в дальнейшем 
именно эти параметры будут использованы во всех измерительных опциях, и самое главное 
– в механизме контроля числовых значений панели Measurements.

– Display units format (Показывать формат единиц) – вкл./выкл. показа обозначений 
единиц измерения рядом с числовыми значениями в панели Measurements и при простанов-
ке размеров на объектах (об этом далее). 

– Force Display of 0” (Установка нуля) – опция используется для показа 0” дюймов в 
«западной» архитектурной системе единиц (в десятичной системе недоступна). 

Angle Units (Угловые единицы): 
– Precision (Точность) – установка точности отображения градусов в десятичных еди-

ницах (количество нулей после запятой). 
– Enable angle snapping (Использовать угловое приращение) – назначение шага при-

ращений углов при использовании инструментов Protractor (Транспортир) и Rotate (Вра-
щение). в окошко рядом вводим нужное значение (по умолчанию 15,0 град). Этот параметр 
при медленном, аккуратном вращении будет проявляться как ощутимые «засечки» на кру-
говой шкале.

И, подводя итог – еще раз (об этом уже говорили в первых темах) – принимаем 
за правило не торопиться кликать мышкой, делаем мини-паузы перед каждым следу-
ющим действием, давая возможность сработать логическому механизму. Смотрим не 
только на происходящее в окне моделирования, но и на подсказки IE. Т.е. учимся мак-
симально использовать все его замечательные возможности, в т.ч. в части контроля 
за числовыми значениями в панели Measurements, и тем самым многократно ускоряем 
работу, избегаем неточностей в построениях и лишних, «пустых» действий.
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Здесь, прежде всего, речь пойдет об управлении инструментами через па-

нель Measurements как на этапе «первичного» построения геометрии, так и на 
любом другом последующем этапе редактирования. Кроме того, рассмотрим еще 
ряд новых опций, которые обеспечивают точную и быструю работу в SketсhUp.

Начнем с повторного рассмотрения уже изученных инструментов рисования, модифи-
каций и навигации, завершая их изучение остальными, дополнительными функциями, а зна-
чит – дополнительными, еще неизвестными возможностями. 

УправЛЕНИЕ ИНСтрУМЕНтаМИ рИСоваНИЯ

 Line (Линия)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра построения Length (Длина). После указания стартовой точки и на-
чала рисования (вытягивания) линии видим динамически меняющееся значение: 

Имеем направление (ориентацию) линии и приблизительную длину – вводим на кла-
виатуре точное необходимое значение, Enter! Это самый распространенный вариант назна-
чения длины линии от стартовой до конечной точки. возможен также более трудоемкий, но 
иногда необходимый в каких-то ситуациях ввод параметров линии в координатах осевой си-
стемы сцены:

– относительных (за 0 принимается стартовая точка рисования линии) – вводятся ко-
ординаты конечной точки в формате: Length: <500;300;200> 

– абсолютных (от 0 основных осей сцены) в формате: Length: [500;300;200].
Понятно, что здесь порядок чисел соответствует стандартному порядку следования 

осей: по красной – по зеленой – по синей.

теперь вызовем контекстное меню и посмотрим другие возможности управления ли-
нией. Прежде всего, открыв диалоговое окно Entity Info (Инфо по элементу, видим, что 
можем изменить длину линии в окошке Length. 

Уточним – эта опция доступна только для «свободной» линии, т.е. такой, у которой 
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несвязаны обе или хотя бы одна конечная точка. Отсюда следует, что если линия является 
ребром поверхности или одним из «внутренних» сегментов кривой, т.е. «зажата» смежными 
элементами построения – возможность изменения длины становится недоступна. 

  
Из остальных пунктов контекстного меню Линии остановимся пока на двух последних. 
Divide (Деление) – цельная линия может быть разделена на любое количество рав-

ных сегментов. 

После выбора опции на линии появляются красные точки, соответствующие кон-
цам отрезков (сегментов) разбиения – перемещением мышки вдоль линии влево-вправо 
уменьшаем или увеличиваем их количество. При этом появляется окошко с текстовой под-
сказкой по текущему количеству сегментов и их длине. Кликаем в нужный момент или на-
жимаем Enter для завершения. Кроме того, количество сегментов Segments при переме-
щении мышки динамически отображается в панели Measurements, так что в нужный мо-
мент можем просто ввести число сегментов и после нажатия Enter опция будет заверше-
на с этим результатом.

После опции деления линия будет выглядеть так же, но не может больше редакти-
роваться как цельный элемент (в чем легко убедиться пр выборе инструментом Select), т.е. 
каждый из ее связанных сегментов будет редактироваться отдельно. 

Еще один удобный пункт контекстного меню – Zoom Extents доступен для всех эле-
ментов построений, поэтому посмотрим здесь на его действие один раз и больше упоми-
нать не будем. Задача его очевидна и является дополнительной опцией навигации – мгно-
венное увеличение изображения выбранного элемента на весь экран, что часто бывает не-
обходимо для точной, «нюансной» работы курсором. вспомним кстати, что опция (кноп-
ка) с тем же названием входит в состав панели с основными инструментами навигации, но 
там она работает для всех объектов сцены, независимо от того, выбран в ней какой-ли-
бо объект или нет.
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 Arc (Дуга)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием первого исходного параметра построения – количества прямолинейных сег-
ментов, формирующих дугу – Sides. 

Задержимся на этом весьма важном числе – дело в том, что дуга, как правило, яв-
ляется основой для будущих сглаженных криволинейных поверхностей (surface), и от ис-
ходного числа сегментов будет зависеть ее внешний вид. Понятно, что чем больше сег-
ментов в дуге, тем более плавной и гладкой будет выглядеть и сама дуга, и построенная 
на ее основе surface. Однако здесь есть и «обратная сторона медали» – за это придется 
расплачиваться «утяжелением» геометрии построения (далее подробно рассмотрим эти 
значимые вопросы в отдельной теме). 

Итак, видим в панели предусмотренное по умолчанию число сегментов = 12. в боль-
шинстве случаев этот, минимально достаточный, вариант вполне устраивает, если нет – 
просто вводим другое число. При этом заметим, что это число «запоминается» програм-
мой, и при следующем вызове инструмента Arc уже оно будет использовано по умолча-
нию... до следующего переназначения на другое.

После установки стартовой точки первым кликом и начала вытягивания хорды ви-
дим ее текущую величину Lenght в виде, аналогичном отображению длины при рисова-
нии линий, и при необходимости вводим свою:

После начала вытягивания высоты подъема Bulge видим ее текущую величину, и 
при необходимости вводим свою:

Иногда удобней или требуется вместо высоты подъема назначить величину ради-
уса дуги – вводим число с буквой «r», а также можно и на этом этапе поменять число сег-
ментов в дуге – вводим число с буквой «s»:

теперь откроем контекстное меню построенной Дуги и войдя в диалоговое окно 
Entity Info, видим, что можем и через него изменить два основных параметра: Radius (Ра-
диус) и Segments (Количество сегментов).

Причем оба этих параметра доступны для изменения в любых «плоских» 2D-постро-
ениях, в т.ч. когда дуга становится и ребром поверхности. Однако в составе геометрии 3D-
объекта для дуги остается доступным только изменение радиуса, а количество сегментов 
уже изменить нельзя.
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 Lenght (Длина) – как видим, эту величину напрямую изменить нельзя, так как она за-

висит от радиуса и количества сегментов, и будет меняться с их изменением. 
Из остальных пунктов контекстного меню:
Divide (Деление) – разделение дуги на любое количество равных сегментов в «пло-

ских» 2D-построениях, в т.ч. когда дуга становится и ребром поверхности. в составе геоме-
трии 3D-объекта опция недоступна. работает совершенно аналогично ранее рассмотрен-
ной этой же опции в Line. 

Explode Curve (Разорвать Кривую) – разрывает дугу на простые связанные сегмен-
ты с возможностью редактирования каждого сегмента. Дуга после этого будет выглядеть так 
же, но не может больше редактироваться, как элемент Дуга. 

Convert to Polygon (Конвертировать в Многоугольник) – создает из сглаженной дуги 
несглаженную кривую. 

Есть также возможность «ручного» редактирования характера дуги и построенных на 
ее основе объектов инструментом Move – меняя длину хорды и высоту подъема (радиус) дуги 
перемещением ее контрольных точек. Для этого (без предварительного выбора Select!) пе-
ремещением курсора Move вдоль дуги находим одну из контрольных точек дуги (стартовую, 
конечную или высоты подъема), кликаем, удерживаем, перемещаем на нужную величину. 
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Как и любой другой объект, дугу можно масштабировать, однако следует иметь в 
виду, что если она деформируется непропорциональным масштабированием, то становит-
ся простой Curve (Кривой), т.е. теряет свои специфические свойства и не может больше ре-
дактироваться, как элемент Дуга.

Еще одна любопытная, а иногда и практически полезная возможность – нахождение 
геометрического центра построения дуги. Для этого, перемещая курсор Move вдоль дуги, на-
ходим endpoint высоты подъема, а затем от нее аккуратно «опускаем» курсор по предпола-
гаемому направлению к геометрическому центру дуги. И как только курсор окажется в нуж-
ном положении, появляется соответствующая подсказка:

 Rectangle (Прямоугольник)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра построения Dimensions (Размеры). После начала рисования (вытя-
гивания) сторон прямоугольника: 

Мы уже знаем, что стороны прямоугольника при построении могут быть ориентиро-
ваны только вдоль осей сцены, а также то, что в панели размеры всегда выводятся в стан-
дартном порядке следования осей – по красной; по зеленой; по синей. теперь можем, учи-
тывая эти условия, ввести свои размеры – сразу получаем нужный прямоугольник. вот и на-
глядный пример ускорения работы при использовании Measurements просто в разы!

Здесь доступна еще одна, очень практичная и удобная функция – можно вводить 
значения длины и ширины в Measurements раздельно (частично) в случае, когда одно из из-
мерений нас устаивает, а второе надо откорректировать. Если ввести только одно число в 
виде: 2000; – это значение будет использовано для первого измерения (по красной оси), а 
второе останется без изменений от ранее использованного! Соответственно, если ввести 
число в виде: ;1000 – первое измерение останется от ранее использованного, а второе (по 
зеленой оси) изменится на эту величину. 

Кроме того, надо учитывать, что при этом отсчет идет от начальной точки построе-
ния, т.е. она остается на месте (IE «запоминает» ее), что очень удобно.

теперь посмотрим, что нам дает контекстное меню прямоугольника – по рассматри-
ваемой теме – ничего... Это и понятно, поскольку эта фигура воспринимается программой 
как просто набор простейших отдельных элементов – поверхности и четырех ограничива-
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ющих ее линий-ребер.
Однако есть один пункт, на котором задержимся особо, поскольку он имеет прин-

ципиальное значение для грамотного моделирования не только при построении этой фи-
гуры, но и для всех объектов SketchUp.

Reverse Faces (Поменять стороны поверхности).
в самом начале нашего курса коротко уже упоминалось базовое свойство поверхно-

стей в SketchUp – каждая и всегда имеет две стороны – лицевую и обратную «изнаночную», точ-
нее, в терминологии SketchUp, внешнюю – Face и внутреннюю – Backface, что в ряде опций ре-
дактирования принципиально. 

Кроме того, программа автоматически стремится назначать внешним (обращенным к 
камере) поверхностям свойства лицевой стороны, а внутренним – оборотной. При этом ра-
ботает механизм их «цветового кодирования», т.е. они обозначаются двумя разными услов-
ными цветами по умолчанию и таким образом, легко распознаются – об этом позже в теме 
механизмов визуализации. в то же время бывают неоднозначные ситуации в геометрии по-
строения, когда механизм автоопределения сторон поверхности не срабатывает, и может 
потребоваться принудительно поменять их местами, для чего и предназначена опция кон-
текстного меню на выбранном – Reverce Faces. Есть и еще одна контекстная опция анало-
гичного назначения: выбираем любую правильно ориентированную поверхность, вызыва-
ем кликом правой клавиши на ней контекстное меню и включаем пункт Orient Faces (Ори-
ентировать по поверхности) – все смежные поверхности («по цепочке», начиная с указан-
ной), должны также принять ее ориентацию. 

в принципе, при работе в SketchUp ситуация с ошибочной ориентацией «лица/из-
нанки» редко создает проблемы, и после назначения материалов, отличных от «по умол-
чанию», уже и не определить, где «изнанка» у нас оказалась снаружи объекта. Но все-таки 
лучше приучить себя в процессе построения сразу исправлять ситуацию во избежание про-
блемных неожиданностей в дальнейшем. Например, многие сторонние программы, в кото-
рые возможно придется экспортировать нашу модель, просто «не понимают (не видят)» обо-
ротную сторону скетчаповских моделей... Особенно это актуально для программ фотореа-
листичного рендеринга.

 Circle (Окружность)
После выбора (включения) инструмента видим пустое окошко панели Measurements с 

названием первого исходного параметра построения – количества прямолинейных сегмен-
тов, формирующих окружность – Sides. Cразу становится очевидна аналогия с уже рассмо-
тренной Arc – это и понятно, поскольку они имеют одинаковую геометрическую сущность. 
Это видно даже из того, что предлагаемое по умолчанию количество сегментов (24) равно 
их суммарному количеству в двух дугах.

так же, как и в Arc, это можно считать минимально достаточным вариантом, и так же на 
этом этапе он может быть изменен вводом другого числа сегментов. Ну, и здесь актуальны те 
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же самые соображения по оправданной «тяжести» геометрии, и работает тот же самый меха-
низм запоминания нового количества сегментов по умолчанию при следующем вызове Circle. 

После назначения центра первым кликом и начала растягивания окружности, панель 
Measurements переключается на показ текущего радиуса и появляется возможность ввода 
нужного значения. Можно и на этом этапе поменять и число сегментов в окружности – вво-
дим число с буквой «s»:

 
Как и для дуги, есть возможность нахождение геометрического центра окружности 

аналогичным приемом. Для этого, перемещая курсор в зоне примерного нахождения центра, 
достаточно просто «выловить» нужную точку, после чего появляется подсказка:

Откроем контекстное меню построенной Окружности. в окне Entity Info, видим, что 
и здесь можем изменить два основных параметра: Radius (Радиус) и Segments (Количест-
во сегментов).

 
Оба этих параметра доступны для изменения в «плоском» 2D-круге, т.е. когда окруж-

ность формирует ребра поверхности внутри. Однако в составе геометрии 3D-объекта (на-
пример, «крышка» цилиндра) для окружности-ребра остается доступным только изменение 
радиуса, а количество сегментов уже изменить нельзя. Lenght (Длину окружности) напря-
мую также изменить нельзя, так как она зависит от радиуса и количества сегментов, и будет 
меняться с их изменением. 

Остальные пункты контекстного меню:
Divide (Деление) – разделение окружности на любое количество равных сегментов 

в 2D-круге. в составе геометрии 3D-объекта опция недоступна. работает аналогично этой 
же опции в Line и Arc. 

Explode Curve (Разорвать Кривую) – разрывает окружность на простые связанные 
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сегменты с возможностью редактирования каждого сегмента. После этого будет выглядеть 
так же, но не может больше редактироваться, как элемент Circle. 

Convert to Polygon (Конвертировать в Многоугольник) – создает из сглаженной 
окружности несглаженную кривую. 

  Polygon (Многоугольник)
Про этот инструмент можно сказать совсем коротко – фактически частный случай 

предыдущего, поскольку создает плоскую многоугольную фигуру, вписанную в образую-
щую окружность. 

а отсюда следует, что все механизмы IE программы для контроля и управления рисо-
ванием Многоугольников совершенно аналогичны используемым для Окружностей (см. выше), 
за исключением наименования в Entity Info.

УправЛЕНИЕ FOV (ФоКУСНЫМ раССтоЯНИЕМ оБъЕКтИва)
Единственный инструмент навигации, управляемый из Measurements – Zoom (Лупа). 

Его мы уже достаточно подробно рассматривали, в т.ч. главную функцию – имитацию реаль-
ного объектива в нашей виртуальной камере. Здесь дополнительно можно сказать только, 
что это единственный из инструментов навигации, имеющий управляемый числовой пара-
метр – Field of View – FOV (Поле взгляда). 

После выбора (включения) инструмента видим окошко панели Measurements со зна-
чением FOV по умолчанию, которое можем поменять на другое в двух вариантах – или в гра-
дусах (например, «45 deg»), или в мм фокусного расстояния (например, «35 mm», что эквива-
лентно фокусному расстоянию реального 35мм объектива). Заметим, что как и в ряде дру-
гих инструментов, измененное числовое значение FOV после этого становится значением 
по умолчанию и будет исходно применено при последующем использовании инструмента.

так какой все-таки FOV лучше использовать в практике моделирования? Любозна-
тельный пользователь, поэкспериментировав с этим параметром, может убедиться, что ближе 
всего к привычному «человеческому взгляду» FOV в диапазоне 35-45 градусов. Меньшие зна-
чения в градусах (или большие в мм, имитирующие т.н. «длиннофокусный» объектив) умень-
шают перспективные искажения, а минимально возможный 1 градус фактически идентичен 
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переключению в Parallel Projections (Параллельную проекцию). Большие значения в граду-
сах (кстати, максимально возможный – 120 град. FOV), или меньшие в мм, имитирующие т.н. 
«короткофокусный» объектив, увеличивают ширину поля взгляда, но одновременно и пер-
спективные искажения до явно неестественного вида. тем не менее однозначного ответа на 
вопрос «какой FOV лучший, правильный» не существует – все зависит от конкретной задачи.

Пожалуй, все-таки управление FOV объектива (наряду с другими возможностями ра-
боты с камерой) больше относится к нашим будущим темам о презентационных возможно-
стях SketchUp, и здесь можно заметить, что существует несколько дополнительных «опера-
торских» плагинов (подключаемых модулей) к SketchUp, в которых возможности точного 
управления камерой значительно расширены по сравнению со штатными. 

Кстати, это хорошая иллюстрация универсальности SketchUp – его с успехом исполь-
зуют и в кинопроизводстве, и в производстве компьютерных игр для концептуального моде-
лирования организации съемочной площадки и мизансцен кадров будущих фильмов и игр. 

Но обо всем этом подробней в будущих темах...

УправЛЕНИЕ ИНСтрУМЕНтаМИ МоДИФИКаЦИЙ

 Push / Pull (вдавить / вытянуть)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра построения Distance (Дистанция). После начала движения курсора 
с выбранной поверхностью:

 

вводим нужное числовое значение дистанции – положительное (вытягиваем) или от-
рицательное (вдавливаем), что соответствует «повышению наружу» нового уровня относи-
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тельно стартовой поверхности или «понижению внутрь». 

Follow me (Следуй за мной)
Для этой опции Measurements не работает – это и понятно, поскольку действие ин-

струмента полностью определяется конкретной геометрией выдавливаемого профиля и пути 
(траектории) выдавливания.

Offset (Контур)
 После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра построения Distance (Дистанция). После начала движения курсора 
с выбранной поверхностью:

Здесь ввод отрицательного числа означает обратное направление относительно на-
правления начатого движения курсора – создания нового контура внутри / снаружи. 

 move (перемещение)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра опции Length (Длина, дистанция). После начала движения курсора 
с выбранным объектом:

вводим нужное числовое значение дистанции перемещения – положительное (в том 
же направлении, что и начальное) или отрицательное (перемещение в противоположном 
начальному направлении). 

Как уже знаем, инструмент Move обладает еще одной, очень нужной функцией созда-
ния копии активного объекта при перемещении (после нажатия клавиши Ctrl) – при этом сам 
объект остается на месте, а перемещается его копия. Здесь появляется еще одна замечатель-
ная возможность – управление количеством копий, для чего в Measurements (после создания 
первой копии) вводим нужное число в любом из двух показанных форматов:
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Логика этой опции требует некоторого пояснения: на показанном примере ввод чи-
сла «3x» (или «*3») означает, что кроме первой копии, будут созданы две дополнительные, 
то есть всего три. а общее число повторений объекта будет = 4 (оригинал + три копии), 
причем все они расположены на одинаковом расстоянии друг от друга = дистанции перво-
го перемещения.

Кроме того, опция работает и во втором «варианте исполнения» – можно вставить до-
полнительные (промежуточные) копии между оригиналом и первой копией, которые также 
разместятся на равных дистанциях между собой. Для этого делаем первую копию, а далее в 
Measurements вводим нужное число в одном из двух показанных форматов: 

 

Здесь работает аналогичная предыдущему случаю логика: на показанном примере 
ввод числа «5/» (или «/5») означает, что кроме первой копии, будут созданы четыре допол-
нительные, равномерно распределенные между оригиналом и первой копией, то есть всего 
пять. Или по другому – это число означает общее число промежутков между повторениями 
объекта. а общее число повторений объекта будет = 6 (оригинал + 5 копий). 

Понятно, что такие возможности просто неоценимы при создании объектов с регу-
лярно повторяющимися элементами – например, стойки ограждений, ряды окон и т.п. 

 Rotate (вращение)
Эта опция по смыслу аналогична предыдущей, но с одним принципиальным отличи-
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ем – перемещение происходит по траектории правильной окружности с определенным ра-
диусом и на определенный угол поворота. После выбора (включения) инструмента видим 
пустое окошко панели Measurements с названием параметра опции Angle (Угол). После на-
чала вращения объекта: 

вводим нужное значение угла поворота – положительное или отрицательное. И здесь 
положительное значение означает вращение в том же направлении, что и начальное, а от-
рицательное – вращение в противоположном начальному направлении. вспомним также, 
что возможен вариант ввода в виде значения уклона (соотношения горизонтального и вер-
тикального измерений) – в некоторых задачах это удобней. 

аналогично Move, Rotate умеет создавать копии активного объекта при вращении (по-
сле нажатия клавиши Ctrl) – в этом случае сам объект остается на месте, а создается и вра-
щается его копия. И здесь – аналогичная Move возможность управления количеством копий, 
для чего в Measurements (после создания первой копии) вводим нужное число в одном из 
двух показанных ниже на рисунке форматов. 

Эта опция также работает и во втором варианте – можно вставить дополнительные 
(промежуточные) копии между оригиналом и первой копией, которые разместятся на равных 
угловых расстояниях друг от друга. Для этого делаем первую копию, а далее в Measurements 
вводим нужное число в одном из двух показанных форматов: 
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Например, ввод числа «6/» (или «/6») означает, что кроме первой копии, будут со-
зданы пять дополнительных, равномерно распределенных по окружности между оригина-
лом и первой копией, то есть всего шесть. Или по другому – это число означает общее чи-
сло промежутков между повторениями объекта. а общее число повторений объекта будет 
= 7 (оригинал + 6 копий). 

Как и для линейного размножения копий, для этого механизма можно найти множе-
ство применений в практике моделирования. 

Конечно, логика назначения количества копий в Move и Rotate несколько сложновата 
для запоминания... Но с другой стороны, благодаря очень простому и быстрому механизму 
ввода параметров, ошибку легко скорректировать, тут же вводя другие, правильные значения. 

 scale (Масштабирование)
После выбора (включения) инструмента видим пустое окошко панели Measurements 

с названием параметра опции – коэффициента масштабирования Scale (Масштаб). После 
начала движения курсором одного из выбранных «захватов» (и, соответственно, осей мас-
штабирования):
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Числовые значения (коэффициенты) масштабирования и направление (ось или оси), 
динамически отображаются в Measurements, и можно в любой момент по ходу опции (или сра-
зу после ее завершения) заменить их на свои вводом нужных значений. в показанном выше 
примере ввод значения = 2, означает, что по зеленой оси (только по ней!) будет выполнено 
двухкратное увеличение размера модели. И понятно, что коэффициент = 1 означает, что ни-
какого масштабирования не будет, т.е. модель останется в исходном состоянии. 

Как мы знаем, в зависимости от места размещения выбранных «зажимов» (на ребре, 
на поверхности, на углу) в сочетании с клавишами Ctrl, Shift, Ctrl + Shif возможны различные 
варианты масштабирования – по направлению от одной до трех осей одновременно. а как 
это отображается в Measurements? Панель однозначно показывают, по каким осям (помним 
о стандартном порядке следования) и с какими масштабными коэффициентами (разделен-
ными знаком «точкой с запятой») мы получим результат: 

Надо заметить, что в сложных случаях масштабирования по нескольким осям однов-
ременно (подобных показанному примеру), Measurements просто незаменим – такое практи-
чески невозможно выполнить «вручную», если требуется получить результат с заданными ко-
эффициентами по каждой из осей.

Отдельного рассмотрения заслуживает случай ввода отрицательных значений – в об-
щем случае это означает, что масштабирование произойдет по той же оси, но в обратном 
начальному движению курсора направлению. а что произойдет, если начать масштабиро-
вание, а затем ввести отрицательное значение = -1?
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Как видим, объект как бы «отразился» по оси масштабирования, не изменив своей 
геометрии. На этом механизме основан прием создания «зеркального отражения» объекта, 
необходимость в котором достаточно часто встречается на практике, что подтверждается 
популярностью типичного вопроса об этом начинающих пользователей. Однако надо заме-
тить, что на самом деле «правильным зеркалом» такой результат назвать нельзя, посколь-
ку «зеркальное отражение» предполагает одновременное наличие плоскости самого зер-
кала, а также объекта-оригинала и объекта-отражения, расположенных на равных рассто-
яниях от зеркала по разные стороны от него. Заметим, кстати, что в наборе инструментов 
SketchUp просто-напросто отсутствует инструмент, который во многих 3D-редакторах так и 
называется – Mirror (Зеркало). 

Отвлечемся от масштабирования и посмотрим в контекстное меню любого выбран-
ного объекта – видим в том числе пункт Flip Along. Фактически это аналог опции, которую 
мы только что применили в масштабировании, с выбором – вдоль какой оси ее выполнить. 

Название опции точнее отражает суть механизма – происходит не «классическое» от-
зеркаливание, а Flip... Перевести на русский буквально довольно сложно – «щелчок, перещел-
кивание». т.е. фактически объект «отражается на месте» относительно его геометрического 
центра вдоль направления указанной оси. таким образом, если нас устраивает результат, по-
казанный выше на примере, используем масштабирование с коэффицентом «-1» или опцию 
Flip. а если все-таки необходимо, например, в сцене интерьера показать зеркало с отражени-
ем в нем? И это возможно – решение такой задачи будет показано позже в отдельном уроке.

КоНСтрУКЦИоННЫЕ ИНСтрУМЕНтЫ
Начнем знакомство с этой новой группой инструментов – открываем меню View > 

Toolbars, включаем показ (ставим галочку) на пункте Constrution (Конструкционные) – блок 
их кнопок добавляется в основную панель инструментов. 

Пока остановимся только на инструментах из левой колонки, с остальными позна-
комимся позже, поскольку они напрямую не связаны с нашей текущей темой. Итак, рассмо-
трим два очень важных инструмента, необходимых, прежде всего, для создания предвари-
тельной разметки – «опорных» элементов, что обеспечивает (в сочетании с ранее рассмо-
тренными механизмами «привязок») полный контроль за точностью построений и к тому же 
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значительно ускоряет работу в целом. 

  tape measure (рулетка)
По смыслу название инструмента можно перевести как «замерщик», однако будем 

все-таки использовать более понятное и привычное «рулетка». Назначение и принцип дей-
ствия инструмента понятны из названия – с его помощью измеряются линейные расстояния 
между любыми двумя точками в пространстве сцены, т.е. это очень близкий по пониманию 
сути работы аналог реального инструмента. 

Пожалуй, это самый востребованный инструмент из конструкционных, поскольку с по-
мощью Рулетки постоянно выполняются самые необходимые измерительные и разметочные 
операции. Рулетка работает (вытягивается) в любых направлениях, но чаще всего, что понят-
но, применяется либо в плоскостях планов осей, либо «ведет отсчет» от линий осей и ребер 
объектов. Если начинаем «вытягивание ленты» рулетки от конечной точки линии, ребра (или 
точки начала осей – origin), то по завершении опции создается Guide Point (Опорная точка, 
точка разметки); если начинаем от любой другой (промежуточной) точки на линии, ребре 
(или на любой оси) – Guide Line (Опорная линия, линия разметки) бесконечной (!) длины. 

Для построения Guide Line включаем инструмент (курсор изменяется на его изобра-
жение со значком «+») > кликаем на стартовой точке > перемещаем курсор в направлении 
измерения – вытягивается линия со стрелками на концах цвета оси, вдоль которой происхо-
дит перемещение, и черная пунктирная бесконечная линия Guide > в конечной точке клика-
ем второй раз. в итоге в сцене остается линия разметки для дальнейшего использования с 
любыми другими инструментами.

видим также динамический контроль за замеряемой дистанцией: рядом с курсором 
после остановки появляется окошко с текущим числовым значением дистанции перемеще-
ния «ленты» рулетки (или конечной точки), а в панели Measurements – то же значение с воз-
можностью ввода своего после начала или сразу после завершения измерения в виде, на-
пример – Length: 500.

Создание Guide Point – аналогично, только вместо бесконечной линии получаем пун-
ктирную линию от начала до конца измерения с точкой-крестиком на конце. выбор меж-
ду построением линии или точки зависит от конкретной задачи последующего использова-
ния разметки. 
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Ну и далее эти разметочные элементы обеспечивают высокую точность построений 
за счет эффекта «привязки» к ним других элементов построений, а поэтому с их помощью 
удобнее (а иногда это и единственная возможность) точно отрисовать элемент или произве-
сти модификации ребер и поверхностей, вместо того, чтобы пытаться «вылавливать» мыш-
кой нужное расстояние или точку.

 Можно использовать Рулетку в роли полного аналога реального инструмента, т.е. 
только для замера расстояния без создания разметочных линий (точек). Для этого в каче-
стве переключателя используем попеременное нажатие клавиши Ctrl (значок «+ у курсо-
ра снимается). впрочем, на практике такая необходимость встречается достаточно редко...

Заметим важный для комфортной организации работы момент – разметочные линии и 
точки, как правило, имеют разовое применения под текущий шаг построения и поэтому нет 
никакого смысла оставлять (хранить) их в сцене после использования. Более того, накопле-
ние в сцене уже ненужных разметочных элементов просто-напросто превращает их в «стро-
ительный мусор», что неизбежно визуально «засоряет» сцену, и добавляет абсолютно нео-
правданную дополнительную нагрузку на компьютер, т.е. тормозит работу. Как их удалять? 
во-первых, для этого предназначена специальная функция меню Edit > Delete Guides, кото-
рая удаляет одновременно и «за раз» все опорные элементы в сцене. во-вторых, их можно 
выбирать по-отдельности и «стирать» инструментом Eraser, или той же опцией через кон-
текстное меню, или клавишей Del. 

а из возможности выбора и удаления следует, что эти линии и точки для программы – 
такие же «материальные» объекты, как и другие элементы построений, а значит с ними мож-
но производить те же самые опции перемещения и вращения, а также можно использовать 
доступные через контекстное меню опции, в т.ч. в окне Entity info. 

Еще одна очень полезная функция инструмента – способность «глобального» масшта-
бирования, причем это возможно в двух вариантах. Первый вариант – для всей сцены, т.е. 
всех объектов в ней одновременно, независимо от того, на каком из объектов сцены эта оп-
ция выполняется (что не всегда подходит). второй вариант – то же, но только для отдельной 
группы (компонента) в режиме их «внутреннего» редактирования, т.е. такое масштабирова-
ние не будет затрагивать остальные объекты сцены. Понятно, что выбор варианты зависит 
от конкретной ситуации и задачи...

Как это работает? выбираем ребро объекта, которое должно иметь в итоге опреде-
ленную известную длину, и отмеряем Рулеткой расстояние от одной его конечной точки до 
другой. Далее вместо фактического значения длины ребра в панели Measurements вводим 
свое (необходимое), и после нажатия Enter появится окошко с запросом о том, хотим ли дей-
ствительно изменить размер – для всех объектов сцены появляется запрос: «Do you want 
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to resize the model?», а для редактируемых групп (компонентов): «Do you want to resize the 
active group or component?» После подтверждения объекты будут пропорционально отмас-
штабированы, исходя из назначенной величины.

  Protractor (транспортир)
Назначение и принцип действия Транспортира также понятны из названия – с его по-

мощью измеряются угловые величины. Собственно говоря, мы с ним уже знакомы – инстру-
мент является составной часть инструмента Rotate, который изучен достаточно подробно.

в рамках нашей текущей темы остается только добавить, что Protractor можно исполь-
зовать и в «чистом» виде, как отдельный механизм измерения и разметки. При этом он рабо-
тает практически аналогично первому рассмотренному измерительному инструменту – Tape 
Measure, естественно, только в угловых измерениях и единицах. 

Кроме измерения углов, инструмент также создает Guide (Опорные линии) из сторон 
этих углов. Транспортир может также размещаться либо на планах осей (и «вести отсчет» от 
осей), либо на поверхностях объектов, принимая соответствующую плоскость ориентации. 
Можно зафиксировать эту ориентацию, нажав и удерживая клавишу Shift, что дает возмож-
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ность переместить Транспортир в другое место в том же положении. 
Для построения Guide после выбора инструмента:
1. Помещаем курсор в нужное место и первым кликом показываем точку центра вра-

щения – вершину отмеряемого угла. 
2. вращая рулетку, кликаем второй раз для определения положения первой линии 

разметки (одной стороны угла) на оси, поверхности или ребре объекта. 
3. вращая рулетку, кликаем третий раз для определения положения второй линии раз-

метки (второй стороны угла) в нужной финальной точке, которая остается в сцене, как опор-
ная линия. видим также динамический контроль за замеряемым углом в панели Measurements 
с возможностью ввода своего значения в градусах (или коэффициенте уклона) после нача-
ла или сразу после завершения измерения:

в итоге направляющие – стороны угла остаются в сцене. Можно отключить их уста-
новленное по умолчанию появление, кликнув Ctrl (аналогично этой же опции у Рулетки).

 axes (оси)
Назначение инструмента – перемещения или переориентации основных осей сцены. 

Хотя вроде бы такая функция, не имеющая явных числовых значений, не относится к теме 
точных построений, ее умелое использование может значительно облегчить ряд таких за-
дач. Прежде всего потребность в такой опции может возникнуть при работе с элементами, 
рисование или модификации которых должны происходить под углом к направлениям ос-
новных осей, и удобнее всего это сделать, просто изменив ориентацию осей под конкрет-
ную ситуацию. 

рассмотрим применение инструмента на примере. Построим кубик и повернем его, 
например, и в горизонтальной, и в вертикальной плоскостях, а теперь попытаемся отмасшта-
бировать только одну из его поверхностей, в ее же плоскости. активируем инструмент Scale 
и видим, что корректно сделать это невозможно, поскольку, как мы знаем, масштабирование 
работает только по направлениям основных осей сцены. Ничего не дает и переход в одну из 
«неперспективных» проекций, например, в вид top (Сверху) – как видим, такое масштабиро-
вание приводит только к неуправляемому искажению объекта сразу по двум или трем осям:
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Следовательно, выход один – необходимо временно «привязать» систему осей сцены 
к геометрии нашего кубика, для чего и предназначен инструмент Axes:

1. включаем кнопку Axes и помещаем его курсор в виде символа из отрезков трех 
цветов осей в сцену. Как видим, при этом ориентация отрезков символа соответствует ори-
ентации осей сцены по умолчанию. Кликаем курсором, например, в угол кубика, обозначая 
новую точку origin – начала координат. 

2. тянем курсор (разворачиваем «тройник» осей) вдоль одного из ребер – обознача-
ем направление красной оси и кликом фиксируем его. тянем курсор вдоль ребра, перпен-
дикулярного первому (поворачиваем зеленую ось) – обозначаем направление зеленой оси 
и кликом фиксируем его, после чего синяя ось автоматически сориентируется перпендику-
лярно красно-зеленой плоскости. в итоге получаем новую, подходящую для нашей задачи 
ориентацию системы осей сцены – теперь легко доступно «правильное» масштабирование.

И еще раз напоминаю о полезности чтения подсказок в строке статуса – даже если 
вы будете редко пользоваться этой опцией и забыли порядок действий – подсказки поша-
гово помогут выполнить все необходимое! 

После завершения нужных действий можно легко вернуть стандартную, по умолча-
нию ориентацию осей сцены – кликаем ПКМ на любой из осей и в открывшимся контекстном 
меню выбираем пункт Reset (Переустановить).

Следующая возможность управления осями вряд ли так уж нужна, но тем не менее 
о ней полезно знать – в том же контекстном меню на любой из осей выбираем пункт Move 
(Переместить) – появляется диалоговое окно Move Sketching Context, в котором можно 
ввести числовые параметры изменения положения (Move) и ориентации (Rotate) каждой из 



88 тема 8. СтрОИМ тОЧНО

осей. Пожалуй, особых пояснений к этой опции не требуется, и желающие досконально ра-
зобраться и попробовать ее в действии сделают это без труда.

Но и это не все – существует еще один, намного более быстрый и удобный механизм 
переориентации осей – в контекстном меню нужной поверхности объекта выбираем пункт 
Align Axes (Выравнять Оси) – основные оси сцены (планы осей) устанавливаются по теку-
щей выбранной поверхности. Однако надо заметить, что этот механизм более «грубый» – 
например, точка начала осей автоматически устанавливается в левый нижний угол повер-
хности, да и сама привязка осей к ребрам поверхности тоже неуправляема. тем не менее, 
если вы попробуете применить его для нашего примера с кубиком, то сможете убедиться – 
результат практически аналогичный!

И последняя деталь – опции переориентации осей не влияют на «землю» в механиз-
мах построения теней на земле и показа эффектов визуализации «земли и неба». Что это зна-
чит, мы рассмотрим в следующей теме...

СтроИМ МоДЕЛЬ в раЗМЕрах
Для закрепления полученных здесь знаний – очень важных для практического модели-

рования – обратимся снова к нашему первому проекту, выполненному ранее – простому до-
мику. Здесь мы рассмотрим вполне вероятную ситуацию – представим, что имеем готовую мо-
дель (так оно и есть), и ее требуется откорректировать, привести к «правильным» размерам.

1  Первым шагом масштабируем сцену целиком, исходя из того, что есть один 
из размеров, про который точно известно, что он правильный.

Примем за гарантированно «истинную» величину, например, высоту дверного про-
ема = 2000мм. Замеряем Рулеткой (с включением Ctrl) ребро прямоугольника проема, вме-
сто получившейся величины вводим требуемые 2000, и подтверждаем запрос на изменение 
размера (масштаба) модели.
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2  Проверяем и корректируем размеры ступеней.
Почему начинаем со ступеней? Дело в том, что по ним существуют нормированные 

размеры, примем: высота = 150мм, ширина = 300мм. Поскольку крыльцо со ступенями мы 
предусмотрительно ранее заключили в группу, можем в режиме ее внутреннего редактиро-
вания отмасштабировать все его части за один раз, используя тот же прием, что и до этого. 
Замеряем, например, фактическую высоту ступени, вводим свою = 150мм, подтверждаем за-
прос на изменение размера. Проверяем ширину ступеньки – все нормально, 300мм.

3  Корректируем высоту цоколя.
видим, что теперь крыльцо «оторвалось» от цоколя, в т.ч. оказалось меньше по вы-

соте. «Пристыковываем» крыльцо к цоколю в нужное место и принимаем решение умень-
шить его высоту до общей высоты крыльца (уровня площадки перед дверью). Делаем это 
масштабирование группы цоколя снизу по синей оси, указывая величину масштабирования 
перетягиванием курсора на нижнюю плоскость крыльца.
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4  Корректируем высоту стен (фактически – потолка комнат).
Замеряем высоту от пола (уровня верха цоколя) – решаем, что нужно увеличить ее 

до 3000 мм. Для этого будет удобна линия разметки – снова используя рулетку (без нажа-
той Ctrl), вытягиваем ее по плоскости стены от пола вверх на нужную высоту (вводим 3000). 
теперь у нас есть уровень, на который надо поднять верхние поверхности и ребра стены.

Чтобы для дальнейших действий нам не мешала крыша, временно поднимаем ее 
вверх, по синей оси. 

входим в режим редактирования группы стен, и аккуратно выбираем только верхнюю 
поверхность. Делаем это любым удобным способом, разворачивая камеру в подходящий ра-
курс, следим, чтобы ничего лишнего не попало в зону выбора. И теперь остается поднять 
выбранное до «прилипания» к линии разметки – или инструментом Move, или Push/Pull – этот 
вариант и показан на примере.

И в завершении опускаем крышу в новое положение – до нового уровня верха стен.
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Можно продолжать описание действий по корректировке других конструкций и даль-
ше, но думаю, логика действий здесь, и при новых, «с нуля», построениях понятна:

 – активно работаем камерой для получения самых удобных ракурсов доступа к ре-
дактируемому контенту и оптимальной степени увеличения изображения на экране;

– при начальных построениях сразу назначаем конкретные (нужные, известные) дли-
ны, углы, дистанции и др. параметры, используя механизмы панели Measurements;

– максимально используем возможности Guides – элементов разметки, создаваемых 
Рулеткой и Транспортиром, за счет snapping – «привязки» к ним геометрии построений;

– решаем задачи сложных модификаций за счет возможности временной «перестрой-
ки» ориентации осей сцены;

– используем возможности (доступные команды) контекстных меню на выбранном – 
часто это оптимальный (а иногда и единственный) способ решения текущей задачи;

– ... и прочие полученные знания...
а теперь представим – насколько быстрее, точнее и проще мы теперь сможем по-

вторить нашу первую учебную задачу «с нуля» – строительство домика в конкретных разме-
рах... И самое главное – сразу получим законченный результат без необходимости последу-
ющих корректировок!
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Умение эффективно работать в SketchUp зависит не только от уровня владе-

ния инструментами и опциями рисования, модификаций и т.п. механизмами собст-
венно моделирования. Не менее важную роль играет и умелое управление теку-
щим отображением сцены на экране. Именно эта тема и будет рассмотрена здесь, 
а точнее, мы изучим часть механизмов визуализации, используемых в SketchUp в 
процессе собственно рабочего моделирования. 

все инструменты и опции программы, предназначенные для управления визуализа-
цией, можно условно разделить на две группы – «рабочие» и «презентационные». На са-
мом деле в SketchUp такого функционального разграничения по разным инструментам нет, 
но для их понимания и эффективного использования примем именно такую схему изучения. 
«Презентационный» рендеринг предназначен для наглядной, эффектной «подачи» проекта 
(как правило, на финальной стадии работы), и поэтому это большая отдельная тема будет 
рассмотрена отдельно позже, а здесь сосредоточимся именно на «рабочем» рендеринге. 

вспомним первую «теоретическое» тему – такие поверхностные, полигональные 3D-
редакторы как SketchUp, практически мгновенно реагируют на изменения геометрии, одна-
ко отличаются повышенной вычислительной нагрузкой именно на визуализацию, т.е. «пере-
рисовку» изображения на экране при любом действии пользователя. Причем с насыщени-
ем сцены объектами скорость, точность, да и просто комфортность работы все больше и 
больше зависят от того, насколько умело пользователь управляет рабочим рендерингом в 
проекте. Это особенно актуально для SketchUp, имеющего принципиальную особенность 
– в отличие от многих других 3D-редакторов, в нем для всех задач отображения сцены ис-
пользуется только один механизм визуализации – в реальном времени, одновременно с про-
цессом моделирования, под управлением системного графического 3D-«движка» OpenGL. 

в самом начале курса, в теме инсталляции SketchUp уже упоминались определенные 
технические требования к «софту» и «железу», выполнение которых гарантирует беспро-
блемную, комфортную работу программы. Если сталкиваетесь со «странностями» отобра-
жения модели в SketchUp, посмотрите их еще раз на специальной странице официально-
го сайта SketchUp Hardware and software requirements: http://SketchUp.Google.com/support/bin/
answer.py?hl=en&answer=36208.

Для Windows XP: Microsoft Service Pack 2+; Microsoft® Internet explorer 7.0 или млад-
ше; .Net Framework version 2.0. 

Примечание: SketchUp будет работать под 64-bit версией Windows, но будет запущен, 
как 32-bit приложение.

Рекомендуемая конфигурация компьютера: 2+ Ghz процессор; 2+ Gb RAM; 500 Mb 
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свободного пространства жесткого диска; Video Card 3D-класса с 512+ Mb памяти. Драйвер 
видеокарты должен поддерживать OpenGL версии 1.5 или выше. 

Минимальная конфигурация компьютера: 1 Ghz процессор; 512 Mb RAM; (оператив-
ная память), 300 Mb свободного пространства жесткого диска; Video Card 3D-класса со128 
Mb памяти. Драйвер видеокарты должен поддерживать OpenGL версии 1.5 или выше. 

НаСтроЙКИ вИДЕоКартЫ
Итак, если указанные выше параметры компьютера обеспечены, приступим к общим 

настройкам параметров визуализации, но вначале познакомимся с новым для нас диалого-
вым окном, которое откроем из меню Window > Preferences (Основные настройки). Окно 
используется для назначения основных постоянных настроек программы, которые будут за-
действованы в текущем сеансе и во всех проектах (файлах) при последующих открытиях (до 
их изменения на другие). вспомним, кстати, что мы уже знаем о диалоге аналогичного на-
значения Model Info, и заметим его отличие от Preferences – там устанавливаются настройки 
только для конкретного проекта (файла).

в диалоге Preferences пока, в рамках нашей темы, обратимся только к одному пункту 
– OpenGL (остальные будут подробно рассмотрены в отдельной теме 2-й книги), панель ко-
торого используется для назначений опций этого механизма таким образом, чтобы оптими-
зировать отображение 3D-графики. Фактически видим здесь «пульт управления» видеокар-
той, и понятно, что содержание этой панели у вас может отличаться от показанного ниже. 

OpenGL Setting:
– Use Hardware Acceleration (Использование аппаратного ускорения) – включив этот 

пункт, мы получаем аппаратную поддержку, этой программной функции за счет подключения 
вычислительных ресурсов видеокарты. а проще говоря, SketchUp будет работать намного 
быстрее и с максимально качественным рендерингом, поэтому этот пункт должен быть пос-
тоянно включен. Заметим однако, что известны случаи «дефектов» работы программы, свя-
занные с конкретным типом (маркой) видеокарты... Пока запомним только, что самый до-
стоверный способ убедиться в том, что именно видеокарта является источником таких про-
блем – выключить этот пункт и посмотреть, что изменилось в отображении сцены на экране.

– Use maximum texture size (Использование максимального размера текстуры) – 
возможность отображения текстур (растровых имиджей) в материалах, назначенных на объ-
ектах, с размерами без ограничений. При «слабой» видеокарте такие текстуры могут ото-
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бражаться с дефектами, о чем и появляется предупреждение. По умолчанию этот пункт вы-
ключен и действует ограничение на размер используемого имиджа – не более 1024х1024 pix, 
т.е. он будет автоматически уменьшен до этого лимита. Этот параметр действительно акту-
ален может быть только на «презентационном» этапе работы над проектом, поэтому стоит 
оставить его выключенным. 

– Use Fast Feedback (Использовать быструю обратную связь) – параметр, ускоряю-
щий перерисовку на экране. Конечно, стоит держать постоянно включенным.

Capabilities (Совместимость):
Для выбора предпочтительного варианта помечаем нужную строчку и нажимаем OK. 

На самом деле здесь интересна только последняя колонка в таблице – Anti-Alias, показы-
вающая «силу» экранного сглаживания линий – ребер поверхностей. Это общепринятый в 
растровой компьютерной графике механизм (и термин), визуального сглаживания «лесенки» 
граничных пикселей разных цветов (гаммы) в изображении, особенно явно проявляющийся 
на прямых, не горизонтальных и не вертикальных линиях. Самый быстрый, но и самый нека-
чественный «нулевой» вариант (для «слабых» видеокарт другого может и не быть) означает 
полное отсутствие сглаживания... а вообще это в основном вопрос зрительной комфортно-
сти работы с изображением на экране. Заметим кстати, что настроечная опция аналогично-
го назначения, но управляющая этим механизмом специально для улучшенного отображения 
текстур материалов в текущем проекте, есть и в диалоговом окне Model Info > Rendering > 
Anti-Aliased Textures. Думаю, особых пояснений здесь не требуется, хотя и здесь не исклю-
чен некорректный рендеринг, связанный с особенностями вашей видеокарты, о чем и ви-
дим соответствующее предупреждение. 

На самом деле по рассмотренным настройкам невозможно дать универсальные реко-
мендации, поскольку проблемы, связанные со степенью «подтормаживания» или некоррек-
тным отображением графики в рабочем пространстве программы напрямую связаны с кон-
фигурацией «железа» и «софта» конкретного компьютера – можно настоятельно рекомен-
довать открыть подходящую тестовую модель и поэкспериментировать с включением / вы-
ключением отдельных опций, чтобы подобрать их оптимальное сочетание.

hiDE / unhiDE (СКрЫтЬ / отМЕНИтЬ СКрЫтИЕ – поКаЗатЬ)
Суть этого самого «оперативного» (но не единственного) механизма скрытия заклю-

чается в том, что в любой момент любые выбранные элементы могут быть быстро скры-
ты опцией Hide (Скрыть), которая быстрее и удобнее всего активируется из контекстного 
меню выбранного. 

Это же можно сделать из пункта меню Edit > Hide, а также вкл./выкл. переключателя 
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Hidden (Скрытый) в диалоговом окошке выбранного элемента (объекта) Entity Info. 

Чтобы снова отобразить ранее скрытые объекты (сделать видимыми), открываем 
пункт меню Edit > Unhide (Отменить скрытие), и далее – по одному из удобных в данной си-
туации варианту: Selected (Выбранное), Last (Последний), All (Все). 

Есть еще один способ скрытия, который работает только с ребрами – включив ин-
струмент Eraser (Ластик), видим в статусной строке подсказку: Shift = Hide. т.е. работаем 
Ластиком точно так же, как и для «стирания» ребер, но при нажатой клавише Shift его фун-
кция меняется – происходит не удаление ребер, а их скрытие. в некоторых ситуациях этот 
механизм очень удобен для выборочного скрытия отдельных ребер.

 

Однако возможны ситуации, когда в ходе работы нужно «выборочно» отменить скры-
тие для каких-либо отдельных элементов (объектов)... как быть, мы же их не видим? Для это-
го случая предусмотрена специальная опция «условного» показа всех построений, скрытых 
ранее опцией Hide. Используем пункт меню View > Hidden Geometry (Вид > Скрытая геоме-
трия) – скрытые построения будут показаны («проявятся») в сцене в «пунктирно-сеточном» 
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виде. После этого, понятно, нужное легко выбрать, сделать «нормально видимыми» опцией 
Unhide, и снова выключить показ скрытой геометрии. 

Обратим здесь внимание на один важный нюанс, непонимание которого – типичная 
проблема начинающих пользователей. Как мы знаем, объединение нескольких объектов в 
группу фактически создает новый единичный объект, как бы «закрывая» каждую из ее состав-
ляющих от воздействия «снаружи». т.е., например, вращая группу, мы вращаем не каждый 
объект по-отдельности внутри, а целиком их общий «блок». то же происходит и при скры-
тии – если скрыть один из объектов группы (или все!), то применение опции Edit > Unhide, 
которая сработает для всех объектов сцены, не снимет скрытие с таких «внутренних объек-
тов. Отсюда возможны ситуации полной «потери» такого рода в сцене, причем причину этой 
проблемы становится особенно трудно понять и найти через несколько шагов моделирова-
ния после скрытия... Одним словом, единственный вариант их «возврата» – через опцию View 
> Hidden Geometry, а еще лучше – при моделировании стараться избегать таких ситуаций. 

резюмируем суть и назначение этой типичной для 3D-редакторов опции. во-первых 
– возможность оперативного скрытия/показа иногда бывает просто необходима для полу-
чения временного удобного доступа к элементам, заслоненным (закрытым) в данный мо-
мент другими построениями. во-вторых – если объекта нет на экране, значит он и не «гру-
зит» систему своим отображением, т.е. проще говоря, SketchUp работает быстрей. И из этих 
соображений можно рационально использовать Hide/Unhide в сложных, «тяжелых» постро-
ениях для разгрузки компьютера, просто скрывая то, с чем в данный момент не работаем. 

Заметим, что в SketchUp есть и второй, более «продвинутый» механизм аналогичного 
назначения – Layers (Слои). Однако поскольку его функции этим не ограничиваются, а воз-
можности намного шире и сложнее, подробно рассмотрим Слои позже, в отдельной теме. 

СтИЛИ отоБражЕНИЯ повЕрхНоСтЕЙ И рЕБЕр
Это также типичная практически для всех 3D-редакторов функция – возможность вы-

бора различных стилей (режимов) отображения поверхностей и ребер, формирующих объ-
екты. Дело в том, что в ряде ситуаций максимально реалистичный вид модели (конечно, на-
иболее наглядный и «приятный взгляду») может на самом деле создавать проблемы, напри-
мер, для выбора отдельных элементов. Кроме того, некоторые функции доступны только за 
счет специальных, «служебных» стилей отображения. И, конечно, один из главных факторов 
выбора текущего стиля диктуется соображениями рациональной «загрузки» компьютера, а 
значит, скорости и комфортности моделирования. Здесь принцип простой – назначаем мини-
мально достаточный стиль отображения для удобной и быстрой работы в текущей задаче.

И еще – в этой теме мы рассмотрим только «оперативные» рабочие инструменты 
управления, и только часть параметров отображения поверхностей и ребер. На самом же 
деле все возможности SketchUp в их настройках (в т.ч. и рендеринга) сосредоточены в спе-
циальном диалоговом окне, открываемом из меню Window > Styles. Мы будем подробно 
изучать его позже, поскольку это весьма сложная и объемная тема, заслуживающая отдель-
ного рассмотрения.

Стили поверхностей 
Открываем меню View > Toolbars > Styles – блок кнопок Стилей становится на пред-

назначенное для него место в верхней панели инструментов. Заметим, что то же доступно 
и из текстового меню View > Face Style (и далее – через открывающееся подменю), одна-
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ко использование кнопок на панели инструментов, конечно, удобней.

Имеет смысл рассмотреть эти функции не в порядке следования кнопок в панели, а 
по частоте применения:

Shaded with Textures (Затененный с текстурами) 
Это вариант по умолчанию – фактически максимально возможная реалистичность 

рендеринга в SketchUp, которую можно получить под графическим 3D-движком OpenGL. 
Отображаются все материалы поверхностей (цвета и текстуры), а также освещение (тени).

вы, конечно, обратили внимание, что на многих приведенных ранее иллюстраци-
ях («снимков» с экрана программы) показаны разные материалы поверхностей и тени от 
объектов – подробное изучение этих больших отдельных тем еще впереди...

 Shaded (Затененный) 

Нетрудно заметить, что фактически это упрощенный Shaded with Textures – только 
«окраска» без показа текстур. точнее, текстуры отображаются их условным «усреднен-
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ным» цветовым тоном (на рис. – трава и дерево). 

 Hidden Line (Линейный) 
Это фактически вариация на тему предыдущего стиля в манере черно-белой иллю-

страции с отображением теней. Чаще применяется не на стадии рабочего моделирования, 
а при разного рода стилизациях в финальной подаче проекта.

 Monochrome (Бесцветный)
 

Этот вариант (как и последующие) можно считать чисто «служебным». в нем вся мо-
дель отображается только в двух цветах проекта «по умолчанию», показывающих ситуацию 
с Face/Backface в модели. Причем независимо от того, какие материалы – цвета и тексту-
ры (отличные от «по умолчанию») были назначены в ходе работы поверхностям. Или по-
другому – двумя условными цветами отображаются все лицевые и оборотные поверхно-
сти, т.е. фактически это механизм контроля за их правильной (лицевые – наружу, оборот-
ные – внутри) ориентацией. также отображаются затенение и включенные падающие тени. 

На эту тему мы уже говорили ранее, но еще раз подчеркну – грамотное моделиро-
вание предполагает постоянный контроль за ситуацией в этой части, что удобнее всего 
делать как раз с помощью стиля Monochrome. так на показанном примере видим в неко-
торых частях модели – «изнаночный» фиолетовый цвет на «лице», после чего можем ис-
править эти ошибки уже известной нам опцией Reverse Faces (Поменять поверхности). 
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X-Ray (Рентген) 
работает в паре с любым из четырех ранее описанных стилей, добавляя к ним эф-

фект «просвечивания рентгеном» или «полупрозрачности». Бывает удобен в некоторых за-
дачах, когда требуется видеть построения, заслоненные другими, находящимися на пере-
днем плане. Минус – весьма основательно «грузит» компьютер в сложных моделях. также 
отображаются затенение и падающие тени, но сами поверхности могут отбрасывать тени 
только на землю. 

Wireframe (Каркасы) 

Отображаются только ребра поверхностей (естественно, только не скрытые до это-
го опцией Hide), и поскольку самих поверхностей не видим, никакие инструменты, работаю-
щие с ними, неприменимы (тени и материалы в т.ч.). в то же время получаем полный доступ 
ко всем ребрам построений, независимо от ракурса камеры (обзора). Самый «легкий» для 
SketchUp стиль, однако на практике используется эпизодически, чаще – для «нюансных» оп-
ций с ребрами, которые в других стилях не видны (недоступны).

 Back Edges (Ребра сзади) 
Дополнительный режим, появившийся в 8-й версии. Это как бы альтернатива стилю 
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X-Ray – также работает в паре с четырьмя первыми стилями... и так же весьма основательно 
«грузит» компьютер в сложных моделях. Отличие – более очевидно обозначает «невидимые» 
в этом ракурсе камеры ребра с обратных «невидимых» сторон объекта, отображая их пун-
ктирными линиями в отличие от сплошных линий ребер поверхностей «на переднем плане». 

Стили ребер
Кроме рассмотренного механизма показа стилей поверхностям, доступны и отдель-

ные стилевые настройки отображения только ребер поверхностей. Конечно, такое деление 
достаточно условно, поскольку эти два типа базовых элементов построений тесно связаны – 
изменения настроек показа ребер в одном из этой пары элементов интерфейса тут же меня-
ют соответствующие настройки в другом. тем не менее, так это устроено в программе, поэ-
тому открываем пункт меню View > Edge Style (для этой функции отдельной панели инстру-
ментов нет) и разбираемся с действием пунктов подменю.

Для начала отключив (сняв «галочки») со всех пунктов, ви-
дим «нулевой» вариант – ребра не отображаются вообще – только поверхности.

 

Display Edges (Показывать ребра) – все ребра одной стан-
дартной толщины – чаще всего используется в качестве «рабочего» варианта при построе-
ниях, как минимально достаточно наглядный.
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Profiles (Профильные ребра) 
– утолщенные линии только внешних габаритов. Могут показываться только они, или в со-
четании с Display Edges.

Depth Cue (Ребра по глубине) – используются, чтобы под-
черкнуть глубину пространства за счет отображения их более жирными на переднем плане, 
чем на заднем. работает только в сочетании с Display Edges.

Extension (Удлинение ребер) – стиль имитирует при-
нятую в архитектурных чертежах манеру графической подачи – удлиняет каждую линию за 
пределы ее конечных геометрических точек. работает только в сочетании с Display Edges 
и (или) Profiles.

shaDOws (тЕНИ)
Начнем с очевидного факта, что управление освещением, а точнее в SketchUp – 

Shadows(Тенями), особенно большую роль играет на этапе финальной «отделки, подачи» 
проекта, добавляя ему привлекательность и реалистичность. И вроде бы логично на эта-
пе рабочего моделирования обойтись без них, поскольку тени – один из самых «тяжелых» 
факторов при визуализации, который особенно явно проявляется с усложнением модели. 
в то же время тени на «рабочем» этапе построений помогают легче визуально восприни-
мать объемы 3D-объектов, а значит, легче ориентироваться в трехмерном пространстве 
сцены. Одним словом, изучим механизмы управления тенями здесь, тем более, что на са-
мом деле проблемы нагрузки на визуализацию вполне решаемы умелым использованием 
нужных инструментов, настроек и оптимальных вариантов их сочетаний в конкретных об-
стоятельствах.

Подчеркнем, что в SketchUp собственно освещение как бы вторично, и представ-
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лено только как источник образования Shadows (Теней). При этом доступен только один 
источник теней (точнее – света, который их и создает) – имитация естественного солнеч-
ного освещения. Причем этот механизм базируется на реальном географическом положе-
нии модели (геолокации) в сочетании с временными (дата, день, час) параметрами – эта от-
дельная большая тема, которая будет рассмотрена позже. такой основательный подход к 
механизмам освещения/теней понятен, учитывая изначальную архитектурную специализа-
цию SketchUp, и вообще типичен для программ архитектурного проектирования. 

Однако из этого следует одно существенное ограничение SketchUp – внутри закры-
тых объемов (типично – в интерьерах помещения) невозможно достоверно отобразить 
тени... Или по-другому – для таких задач требуются независимые точечные источники све-
та (светильники, люстры и т.п.), но никакого механизма их имитации в SketchUp не предус-
мотрено. впрочем, опытный пользователь достаточно успешно может если не решить, то 
обойти эту проблему – об этом поговорим позже. 

Итак, открываем меню View > Toolbars > Shadows – блок кнопок инструментов Те-
ней становится на свое место в верхней панели инструментов. 

Панель предназначена для быстрого доступа к самым часто используемым настрой-
кам Теней. Начнем со второй слева кнопки – Show/Hide Shadows – это главный переклю-
чатель общего вкл./выкл. показа теней в сцене. 

Здесь же дублируется часть параметров, представленных в основном диалоговом 
окне управления тенями Shadows Setting, которое открывается крайней левой кнопкой 
панели инструментов (или через меню Window > Shadows): 

 

Кнопка в верхнем левом углу – тот же общий выключатель теней Show/Hide Shadows. 
Окошко правее с загадочным текстом связано с геолокацией, т.е. привязкой модели к реаль-
ному географическому местоположению. Слайдерами ниже – Time и Date назначаем время 
года, месяц и дату. Эти географические и временные параметры – отдельные большая тема, 
напрямую не связанная с рабочей визуализацией – рассмотрим ее подробно позже. Заметим 
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только, что этими слайдерами можем просто регулировать положение «солнца на небосво-
де», а значит – характер (направление) теней, как нам требуется. 

Light, Dark (Свет, Темнота) – слайдеры, фактически регулирующие контрастность те-
ней на освещенных и затененных частях сцены за счет изменения соотношения этих параме-
тров. Как это выглядит в сцене? Двигаем, смотрим...

Прежде чем перейти в нижнюю часть диалогового окна – небольшое отступление, по-
ясняющее последующие параметры настройки. тени в SketchUp создаются двух типов: соб-
ственные (затенение поверхностей объектов) и падающие (от объектов на земле и на по-
верхностях соседних объектов). а поскольку вычислительная нагрузка на визуализацию от 
теней, как уже говорили, весьма значительна, предусмотрен очень продуманный и рацио-
нальный механизм их раздельного включения/выключения. 

1. Самый «радикальный» вариант – тени полностью выключены кнопкой Show/Hide 
Shadows. выключим и единственный доступный параметр Use sun for shading (Использо-
вать солнце для затенения) – переключатель, активирующий возможность использования 
и изменения настроек собственных (лицевых) теней поверхностей при выключенном пока-
зе теней в сцене – т.е. без теней падающих. Фактически некое общее затенение на повер-
хностях все равно присутствует – как бы от общего рассеянного освещения сцены. Но при 
этом никакие другие настройки теней не действуют.

 2. включаем только Use sun for shading. Как видим, затенение от теней собственных 
стало более явным, и можем регулировать (действуют) все остальные настройки теней. При 
этом полностью отсутствуют только тени падающие и недоступна их настройка.

Эта опция и есть самый простой способ, пусть ограниченного по возможностям, но 
все-таки достаточно достоверного показа теней внутри закрытых объемов (например, в инте-
рьерах), поскольку из всех возможностей лишаемся только управления падающими тенями от 
прямого солнечного освещения. Понятно, что в «помещении без окон» его и не может быть...
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3. включаем показ теней в сцене кнопкой Show/Hide Shadows. Становятся доступны 
настройки самой нижней части окна – Display, т.е. фактически включаем показ падающих те-
ней, и применяем по очереди их настройки.

 

On face (На поверхностях) – переключатель включения/выключения показа теней, 
падающих на поверхности от других объектов.

On ground (На земле) – переключатель включения/выключения показа теней, пада-
ющих на «землю» (плоскость красно-зеленых осей).

From edges (От ребер) – переключатель включения/выключения показа падающих 
теней от линий – например, ребер без поверхностей. 

Заметим, что включения теней кнопкой Show/Hide Shadows «поглощает» пункт Use 
sun for shading, который уже никак не влияет на остальные настройки. Кроме того, обраща-
ем внимание на то, что пункты On face и On ground можно включать/выключать и раздель-
но – в некоторых обстоятельствах это может пригодиться.

Кроме рассмотренных, доступен «выборочно – пообъектный» механизм управления те-
нями любых элементов построений и объектов через их контекстные меню в опции Entity Info. 
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Здесь видим два интересующих нас параметра: Cast Shadows (Отбрасывать тень), т.е. 
создавать собственную падающую тень и Receive Shadows (Принимать тени), т.е. отобра-
жать тени от других объектов. Или другими словами – если все описанные выше опции дей-
ствуют на все объекты сцены одновременно и одинаково, то этой можно назначить «инди-
видуальные» свойства в части работы с тенями для отдельных объектов. так, в нашем при-
мере можно например, отключить падающую тень только у цилиндра, оставив этот пара-
метр «как есть» у кубика:

Эта, на первый взгляд даже «избыточная» опция, на самом деле иногда помогает ре-
шить некоторые проблемы с отображением теней в SketchUp, варьируя сочетания этих двух 
параметров у разных объектов с другими «теневыми» настройками. 

теперь, прежде чем продолжить текущую тему, отвлечемся и познакомиться с еще од-
ним разделом общих настроек программы – Window > Preferences > Extensions (Расшире-
ния) – здесь «спрятаны» несколько встроенных в SketchUp дополнительных программных мо-
дулей, а также могут добавляться другие при самостоятельной установке новых дополнитель-
ных Plugins (Плагинов). Почему «спрятаны»? Дело в том, что иногда пользователи их просто 
не находят по причине того, что для их «вызова» необходимо дополнительное действие. Для 
того, чтобы Расширения (кнопки их панелей управления) стали доступны в интерфейсе, их 
необходимо включать, «поставив галочку» у соответствующего пункта в разделе Extensions. 

С остальными Расширениями и Плагинами далее познакомимся по ходу изучения, а 
пока найдем и включим пункт Solar North Toolbar. Далее требуется сделать еще один шаг 
– поместить панель управления этого модуля в интерфейс включением пункта меню View > 
Toolbars > Solar North (Север). 

Итак, перед нами еще один дополнительный «солнечный» механизм, чаще востребо-
ванный в случае, когда не требуется абсолютно точная географическая и временная достовер-
ность показа солнечного освещения. Например, нужно только быстро изменить (повернуть) 
направление падающей тени в выгодное для представления сцены положение, поскольку не 
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всегда удается получить требуемый результат только «движками» диалогового окна Shadows. 
Первая кнопка Toggle North Arraw (Направление на Север) – переключатель вкл./

выкл. постоянного показа в сцене (на «земле») этого направления оранжевой линией;

вторая кнопка Set North Tool (Инструмент указания Севера) – переключатель вызо-
ва в сцену и вращения в плоскости «земли» вектора этого направления. вот как раз им и та-
ким вращением можно быстро и удобно поменять характер тени.

  
третья кнопка Enter North Arraw – вызов окошка ввода углового значения того же 

направления относительно Севера в градусах. Нетрудно заметить, что значение = 0 совпа-
дает с направлением зеленой оси.

На этом и завершим пока изучение механизма теней – к ним вернемся позже в те-
мах, посвященных некоторым нюансам и приемам решения конкретных задач в презента-
циях проектов.
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В начальном обзоре инструментов в группе Principal (Основные) уже упоми-

налась Paint Bucket (Палитра) – один из элементов интерфейса механизма «окра-
ски» объектов. Тогда мы отложили рассмотрение этой темы на финальную ста-
дию «отделочных работ», поскольку правильней избегать излишней нагрузки на 
начальной стадии моделирования. Тем не менее, «окраска» , как одно из главных 
средств визуализации, может быть полезна и применяться и в рабочем модели-
ровании, главное – рационально использовать заложенные для этого в SketchUp 
возможности.

 Paint BuckEt (паЛИтра)
Этот инструмент, который еще называют «ведерком с краской» (понятно, по сим-

волу на кнопке), используется для назначения материалов (окраски) поверхностям по-
строений. До этого момента все поверхности имеют как бы «никакие», условные цвета по 
умолчанию, которые несут чисто информационную нагрузку – только цветовое обозна-
чение face/backface (лицевых/оборотных) сторон поверхностей. Их мы и видим при вклю-
ченном стиле отображения Monochrome.

Уточним, что под материалами в SketchUp понимается как «окраска» поверхностей 
в прямом смысле слова – в однотонные цвета, так и помещение на них текстур. тексту-
рами в 3D-моделировании принято называть растровые имиджи (обычно – фотореали-
стичные), процесс нанесения которых можно представить как «обтяжку», «заливку» или 
«оклейку» поверхностей такими имиджами вместо однотонной окраски.

Назначенные материалы в SketchUp можно увидеть только при двух стилях ренде-
ринга: Shaded with Textures (Затененный с текстурами) и Shaded (Затененный). При-
чем во втором случае сама «картинка» текстуры не отображается, но условно все равно 
показывается ее усредненным цветовым тоном. 

типичная схема работы с материалами следующая: после выбора инструмента 
курсор Paint Bucket изменяется на символ «ведерка» и одновременно открывается диа-
логовое окно Materials (Материалы), которое содержит коллекции включенных в про-
грамму материалов и их набор, используемый в текущем проекте. Далее, выбрав нуж-
ный материал, кликаем «ковшиком» на объект – «окрашиваем» его, «заливая» всю вы-
бранную поверхность в ее границах-ребрах. Этот же принцип работает в окраске сгла-
женных криволинейных поверхностей (Surfaces), которые, как знаем, на самом деле не 
более чем набор плоских (Faces) поверхностей – они воспринимаются и «заливаются» 
окраской как единое целое. в то же время, если включить режим показа скрытой геоме-
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трии (View>Hidden Geometry), начинают «работать» ребра каждой из Face, и такая «об-
щая» окраска становится невозможной.

Можно одновременно (в один клик) окрасить несколько поверхностей, предвари-
тельно выбирая их инструментом Select с нажатой клавишей Shift. Обратим особое вни-
мание на один принципиальный момент – при таком множественном выборе этом имеет 
значение, какие стороны поверхностей выбраны для закрашивания – если кликнули сна-
чала на одной из лицевых поверхностей, то во всех поверхностях одновременно окра-
сятся также только лицевые поверхности (то же – с оборотными). Наглядный пример – 
окраска всего цилиндра (в .ч. боковых surfaces), с правильной одинаковой ориентацией 
(слева) и с неправильной (справа), где частично «перепутаны лицо/изнанка»:

Здесь для наглядности (чтобы понять, как это получилось) опцией View>Hidden 
Geometry включен показ скрытой сглаживанием геометрии. Отсюда следует, что «неряш-
ливость» в отношении контроля за правильной ориентацией поверхностей (о чем не раз 
говорилось) чревата и проблемами при назначении материалов. 

При окраске всего объекта «за раз» и целиком есть еще очень интересная осо-
бенность – своеобразное поведение при этом групп и компонентов. во-первых – если 
мы хотим, чтобы одновременно в один и тот же цвет окрасились (или получили текстуру) 
все и лицевые, и оборотные поверхности объекта, просто предварительно создадим из 
него группу (компонент). И во-вторых, при такой окраске групп (компонентов) работает 
принцип: любые входящие в них поверхности, которые еще не окрашены (точнее, пока 
имеют «никакой» цвет по умолчанию), будут принимать одновременно один и тот же на-
значаемый материал, а материалы предварительно (!) окрашенных поверхностей оста-
нутся без изменений. 

Как это работает и какие возможности предоставляет, посмотрим на приме-
ре – построим «автостоянку», на которой поставим в ряд пять одинаковых групп (или 
компонентов)-автомобильчиков. в них заранее одинаково окрашены только «шины» и 
«стекла», а остальное – пока нет (задний ряд). а теперь начнем «красить» автомобиль-
чики, просто кликая на каждом снаружи (!) «ведерком» с краской разного цвета – резуль-
тат налицо (передний ряд)... Понятно, что подобное эффектное решение можно исполь-
зовать во множестве аналогичных ситуаций в сценах...
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Однако в этом быстром и эффектном способе есть определенные «подводные кам-
ни», суть которых заключается в том, что материалы, назначенные «обычным» способом на 
каждую из сторон поверхности, и «групповым» способом, показанным выше, распознают-
ся SketchUp по-разному. 

Посмотрим, как это выглядит, на примере – построим простой объект и его копию, 
которую превратим в группу или компонент. Ситуация с материалами отображается в окош-
ках Entity Info в левом верхнем углу – пока объекты «не окрашены», отображаются услов-
ные цвета по умолчанию. При выборе Entity Info простого объекта, на одной из поверхно-
стей это окошко разделено на две зоны – левая показывает цвет face, правая – backface, 
а на группе показывается единая окраска всех поверхностей, так как вызвали Entity Info на 
группе, как едином объекте. 

Окрасим на простом объекте одну лицевую поверхность «обычным» образом в кра-
сный цвет (рис. слева – в этом ракурсе ее не видно), а группу на его основе окрасим «снару-
жи» (т.е. аналогично примеру с автомобильчиками) в зеленый цвет (рис. справа) – это тут же 
отображается в Entity Info следующим образом:

внимательно рассмотрев и проанализировав результат, можно сделать вывод – при 
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окраске группы (компонента) «снаружи», ситуация с материалами поверхностей распозна-
ется программой некорректно! а именно – такая группа воспринимается как некая условная 
единая поверхность с материалом, полученным при общей окраске (в зеленый цвет), а пред-
варительно окрашенная в красный цвет поверхность внутри группы игнорируется. в каких-
то обстоятельствах и задачах этим можно и пренебречь, а в других это чревато ошибками и 
неудобствами – чуть далее мы остановимся на таких опциях, связанных с выбором и расче-
том площадей поверхностей с одинаковыми материалами.

а пока задержимся еще на одной возможности окна Entity Info, о которой ранее не 
говорили: клик на лицевой или оборотной зоне цветового окошка Face открывает еще одно 
окно Shoose Paint (Выбрать окраску). в нем видим все материалы, уже использованные в 
проекте – выбрав любой из них, можем тут же «перекрасить» в него выбранную сторону по-
верхности или отредактировать «исходник» активного материала (об этом далее) . 

 
вернемся к Paint Bucket и посмотрим теперь, как работает инструмент с функциональ-

ными клавишами – без предварительного выбора поверхности окраски!:
+ Ctrl («ведерко» курсора дополнится тремя горизонтальными квадратиками) – при 

клике на окрашиваемой поверхности в этот же цвет окрасятся и все последовательно смеж-
ные поверхности объекта. 

+ Shift («ведерко» курсора дополнится тремя квадратиками уголком) – при клике на 
окрашиваемой поверхности в этот же цвет окрасятся абсолютно все объекты сцены. 

+ Shift + Ctrl («ведерко» курсора дополнится тремя вертикальными квадратиками) – 
при клике на окрашиваемой поверхности в этот же цвет окрасятся только все «физически» 
связанные элементы построений (связанной геометрии).

Причем заметим – эти три опции воздействует описанным образом только при при-
менении или на «неокрашенные» (с цветом по умолчанию) поверхности, или на поверхно-
сти, уже «окрашенные», но в одинаковый цвет.

+ Alt («ведерко» курсора временно превращается в «пипетку») – взятие образца ма-
териала с любой окрашенной (или текстурированной) поверхности – удерживая Alt, клика-
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ем в нужном месте (берем образец), отпускаем Alt – «ведерко заполняется» этим материа-
лом. После чего применяем Paint Bucket любым из описанных выше способов. Это одноз-
начно самая полезная и востребованная опция использования Paint Bucket с функциональ-
ной клавишей, особенно для «копирования» свойств текстур (об этом подробнее – далее).

И, коротко – о ребрах поверхностей. во-первых, инструментом Paint Bucket их окра-
ска не предусматривается – по умолчанию они все одного, черного цвета. И во-вторых, из-
менить настройку цвета ребер можно через другие опции, рассмотрение которых еще впе-
реди – Стили и Слои, поэтому пока остановимся на этом. 

ДИаЛоГовоЕ оКНо matERials (МатЕрИаЛЫ)
теперь перейдем к «главному центру управления» материалами SketchUp – диалого-

вому окну, которое открывается через меню Window > Materials (Материалы). Кроме 
того, как уже было сказано, оно автоматически открывается при выборе инструмента 
Paint Bucket на палитре инструментов. И наоборот, открытие окна Materials и выбор из 
него материала автоматически активирует Paint Bucket.

рассмотрим подробнее устройство и опции этого окна. Прежде всего, видим два 
основных раздела окна – закладки Select (Выбор) и Edit (Редактирование). 

select (выбор)
в этой закладке, открывающейся по умолчанию, в левом верхнем углу окна ви-

дим миниатюру-образчик текущего активного материала – из него «заполняем ведер-
ко» для последующей окраски поверхностей в области моделирования. Двухцветный 
образчик с цветами по умолчанию говорит о том, что пока никакие материалы для ра-
боты не выбраны. Правее находится окошко с именем этого материала – при отсутст-
вии окраски неактивно, с обозначением текущего Default (по умолчанию) состояния. 
Понятно, что здесь можно ввести любое имя выбранного – например, переименовать 
материал из коллекции (об этом чуть дальше).

Кнопки в правой верхней части: 

– открывает/закрывает аналогичное «вторичное» окно выбора материалов. 
Это дает возможность одновременно видеть, например, папки с коллекциями и мате-
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риалы внутри них, что удобно для перемещения материалов между коллекциями про-
стым «перетаскиванием» мышкой.

 Create Material (Создать материал) – открывает окно создания нового ма-
териала на основе текущего активного – фактически при этом открывается окно (за-
кладка Edit) редактирования материала, которое подробно рассмотрим далее.

«заполняет ведерко» цветами по умолчанию, или по-другому – использу-
ется для отмены уже произведенной окраски, т.е. возврату к исходному состянию по 
умолчанию.

в средней части окна видим кнопки перехода между разделами-закладками Select 
(Выбор) и Edit (Редактирование). 

 – In Model (В модели) – кнопка открывает окно с миниатюрами (списком) мате-
риалов, уже использованных в текущем проекте. 

Правее находится раскрывающийся список Materials – тематическая коллекция ма-
териалов, из которых их можно выбирать, применять к элементам построений, редак-
тировать. Кроме того, можно создавать свои материалы (и их коллекции). Для перехо-
да между коллекциями в порядке их расположения можно также использовать кнопки-
стрелки «назад-вперед».

Заметим сразу, что все сказанное далее про коллекции, относится прежде всего к 
текстурам (т.е. материалам на основе растровых имиджей), поскольку создавать новые кол-
лекции однотонных цветов-заливок не имеет никакого смысла. во-первых, их более чем до-
статочно в комплекте по умолчанию, а во-вторых, они легко и быстро корректируются «по 
ходу» средствами редактирования.

– «пипетка» взятия образца материала объектов в окне моделирования (ду-
блирует опцию Alt + Paint Bucket, о которой уже говорили). Удобна для быстрого выбо-
ра материала на объектах сцены с целью последующего редактирования.

 – открывает меню Details, в котором доступны дополнительные опции (их набор 
различается в разделах In Model и Materials). 

– Open or create a Collection... (Открыть или создать коллекцию) – открывает окно 
Проводника для доступа к существующим папкам коллекций или созданию новых;

– Save Collection As... (Сохранить коллекцию как) – открывает окно Проводника для 
создания новой папки и сохранению в ней новых материалов;

– Add Collection to Favorites... (Добавить коллекцию в закладки-список) – откры-
вает окно доступа к папкам самых часто используемых материалов и добавляет их к списку; 

Эта опция удобна тем, что с ее помощью можно организовать быстрый доступ к 
«внешним» ресурсам, хранящимся вне программных папок SketchUp – например, «сво-
им» коллекциям.

– Remove Collection From Favorites... (Удалить коллекцию из закладок-списка) – от-
крывает окно доступа к папкам, через которое можно удалить их из списка;

– Purge Unused (Очистить от неиспользуемого) – «принудительно» удаляет ранее на-
значенные, но на данный момент неиспользуемые (удаленные) материалы в проекте (In Model). 
Эта опция важна из соображений уменьшения размера файла, поскольку в нем, кро-
ме геометрии построений, сохраняются и данные по материалам. Дело в том, что даже 
после удаления ранее окрашенных объектов из проекта, из самого файла (т.е. из спи-
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ска In Model) материал не удаляется! При этом, если информация об однотонных «кра-
сках» практически не влияет на размер файла, то сохраняемые в нем растровые тек-
стуры могут значительно увеличить его «вес». Заметим, что аналогичная опция «чист-
ки» материалов доступна и из окна Window > Model Info > Statistics.

– Small, Medium, Large, Extra Large Thumbnails (маленькие, средние, большие, очень 
большие миниатюры) – выбор размера миниатюр в окне; 

– List View (В виде списка) – переключение на показ стилей в виде текстового списка;
– Refresh (Обновить) – «ручное» обновление показа перечня стилей;
– Get More... (Получить еще) – открывает через Интернет доступ к дополнитель-

ной коллекции материалов из ресурсов Google. 

Опции контекстного меню в разделе Materials на миниатюрах (списках) материа-
лов в их коллекциях:

– Delete (Удалить) – удаляет материал из коллекции;
– Add to model (Добавить в модель) – выбирает материал в качестве текущего 

в Paint Bucket. Фактически избыточная опция, поскольку просто дублирует ранее показан-
ные (и более удобные) опции выбора материала для окраски.

Задержимся здесь, чтобы обратить внимание на один важный момент – все ма-
териалы коллекций, (т.е. те, которые видим в списках и на миниатюрах) на самом деле 
хранятся и работают в специальном «скетчаповском» файловом формате *.skm. а 
сами исходные коллекции в этом формате размещаются по умолчанию при инсталля-
ции SketchUp в программную папку C:\Program Files\Google\Google SketchUp 8\Materials. 
Отсюда – распространенное заблуждение, что SketchUp работает с материалами толь-
ко в таком виде (формате), а потому все свои новые, дополнительные материалы для 
их сохранения надо сначала «перегонять» в формат .skm. На самом же деле в этом нет 
никакой принципиальной необходимости – любые «внешние» растровые имиджи (как 
увидим дальше) легко и удобно помещаются в текущий проект в качестве новых мате-
риалов, так что можно с таким же успехами пользоваться своими подборками имиджей 
в поддерживаемых SketchUp растровых форматах. разобравшись, легко можно понять, 
что фактически разница в использовании или нет формата *.skm заключается только в 
том, что «превью» материала мы сможем увидеть либо в виде миниатюр коллекций вну-
три диалогового окна Materials, либо (с таким же успехом) в окне Проводника. впрочем, 
это опять же вопрос личных предпочтений и привычек пользователя...

 
теперь рассмотрим опции контекстного меню в разделе In Model на миниатюрах 

(списках) материалов, использованных в проекте:
– Delete (Удалить) – удаляет материал из проекта с запросом подтверждения, 

т.к. материал используется в проекте и будет заменен на «по умолчанию». т.е. факти-
чески речь идет об отмене окраски этим материалом всех поверхностей и удалении его 
из списка In Model.

– Export Texture Image (Экспорт имиджа) – открывает окно экспорта – сохране-
ния растрового имиджа текстурного материала в виде отдельного файла в указанном 
месте файловой системы и выбранном формате (доступны .jpg, .png, .tif, .bmp). таким 
образом, например, можно извлечь для каких-то других задач текстуру, использован-
ную в «коллекционном» материале. 
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– Edit Texture Image... (Редактирование текстурного имиджа) – опция загрузки 
имиджа во внешний растровый редактор, редактирование в нем, и «возврата» в про-
ект в измененном виде. 

На этой очень практичной опции редактирования текстур стоит задержаться осо-
бо, поскольку потребуется предварительная настройка в диалоговом окне Window > 
Preferences (Основные настройки). Мы его уже упоминали при настройках визуализа-
ции, напомню только, что окно используется для назначения основных постоянных на-
строек программы. в открывшемся окне System Preferences выбираем пункт Applications 
(Приложения) и опцией Default Image Editor (Редактор имиджей по умолчанию) через 
кнопку Choose... показываем путь к пусковому файлу установленного на вашем компью-
тере растрового редактора (Adobe Photoshop, Corel PhotoPaint и т.п.).

Фактически эта опция дает возможность быстро и удобно получить доступ к пол-
ноценному редактированию в сторонней программе – специализированном редакторе, 
который после завершения редактирования возвращает растр в SketchUp уже в обнов-
ленном виде. Как видим, без знаний «смежных» программ – редакторов компьютерной 
графики никак не обойтись, тем более, что «встроенные» в SketchUp возможности та-
кого рода весьма ограничены, что мы и увидим дальше...

– Area (Площадь) – рассчитывает и показывает площадь всех поверхностей с 
одним и тем же материалом в проекте. Это очень удобная и практичная функция, на-
пример, когда требуется получить данные по площадям окраски или облицовки стен 
определенным типом материала. Однако как раз здесь стоит вспомнить про особенно-
сти окраски групп (компонентов) «снаружи», о которых говорили чуть ранее (пример с 
автомобильчиками). Суть проблемы в том, что при этом один и тот же материал всегда 
одновременно назначается и для лицевых, и для оборотных сторон поверхностей, а по-
тому для них будет вычислена ошибочная удвоенная величина площади, покрытой этим 
материалом. Избежать такую ошибку можно только одним способом – очень вниматель-
но контролировать ситуацию, не допуская окраски оборотных сторон тем же материа-
лом, что и лицевых. а вообще надо помнить, что в идеале backface вообще не должны 
иметь материала, точнее – оставаться «условно окрашенными» цветом по умолчанию. 
Конечно, за исключением ситуаций, когда «изнанка» не скрыта внутри конструкции, и 
этого не избежать (например, штора на окне).

– Select (Выбор) – выбирает все поверхности в проекте, окрашенные данным ма-
териалом. К сожалению, не работает с материалами поверхностей, назначенными «об-
ычным образом» и находящимися внутри групп (компонентов), и в то же время выби-
рает материалы окраски групп (компонентов) «целиком и за раз» (т.е. опять налицо не-
корректные последствия этого способа окраски). 

Кстати, если видим, что эти две опции неактивны, значит материал, хотя и при-
сутствует в списке In Model, фактически в проекте не используется (им ничего не окра-
шено), т.е. может быть спокойно удален контекстной опцией Delete или Purge Unused.
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Edit (редактирование)
Эта вторая закладка диалогового окна предназначена для редактирования те-

кущего активного материала из списка In Model, т.е. работает только для материалов, 
уже примененных в проекте. 

рассмотрим опции редактирования на примере нашего тестового домика, кото-
рый строили ранее. Используя коллекции Materials, «раскрасим» его по своему жела-
нию. вспомним заодно особенности назначения материалов элементам, находящихся 
внутри групп и компонентов.

Итак, выбираем в списке In Model один из использованных материалов, например 
темно-серый (цоколь, крыльцо) и открываем закладку Edit. Напомню, что выбирать ма-
териал для редактирования в это окно можно и из сцены, с ранее окрашенных им же 
объектов, используя «пипетку» (Alt+Paint Bucket). Ну и понятно, что если ни один из за-
действованных в проекте материалов не выбран, опции Edit будут неактивны.

видим, во первых, что верхняя часть закладки Edit аналогична In Model, а ниже 
находятся три раздела:

color (Цвет)
раскрывающийся список Picker (Выбор) содержит несколько вариантов цвето-

вых моделей представления цвета, применяемых в компьютерной графике. Первым в 
списке находится Color Wheel (Цветовое колесо, круг), на котором представлен весь 
спектр доступных цветов. Нужный цветовой тон выбирается перемещением квадрати-
ка – «прицела», а его «чистота» регулируется вертикальным слайдером за счет измене-
ния доли черного цвета. 

 Далее в списке – несколько других цветовых моделей, имеющих точные число-
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вые параметры определения цвета:
– HLS (Hue, Light, Saturation) – назначает цвет по трем параметрам: H – цвето-

вой тон (собственно «чистый» цвет в спектре), S – насыщенность цвета (доля черного 
в цвете), L – светлота (доля белого в цвете). 

– HSB (Hue, Saturation, Brightness) – практически аналогична предыдущей, отли-
чается только использованием понятия яркости (B) вместо светлоты (L).

– RGB (Red, Green, Blue) – модель «мониторных» цветов, где R – доля красного, 
G – доля зеленого, B – доля синего цвета.

Цвет в этих трех моделях определяется положением движков слайдеров, или вво-
дом числовых значений. Какую из этих моделей использовать? в разных ситуациях мо-
гут быть удобнее разные – практика работы покажет...

Заметим, что изменения настроек цвета тут же интерактивно отражается на всех 
окрашенных в этот цвет поверхностях в области моделирования, так что сразу можем 
видеть результат редактирования цвета непосредственно на объектах сцены. И очень 
практичное следствие такого механизма – если в проекте несколько объектов уже окра-
шены в некий цвет, который мы решили изменить, перекрашивать каждый объект от-
дельно и по очереди нет никакой необходимости, достаточно просто отредактировать 
сам цвет! а отсюда следует, что таким же образом можем вообще поменять один мате-
риал на совершенно другой очень быстро и удобно...

Правее списка Picker находится окошко с исходным цветом материала Undo 
Color Changes (Отмена изменений цвета) – кликнув на нем, отменяем все опции его 
редактирования.

Это две кнопки очень удобной опции – быстрого «взятия» образца 
цвета «пипеткой» с заменой на него текущего активного цвета: 

 Match Color of object in model (Взятие цвета с объекта модели) – работает 
только с материалами поверхностей, использованными в объектах сцены. Если выбра-
ли «краску», то действие опции заменяет текущий цвет на другой из использованных в 
сцене, если выбрали текстурный материал – то же, но в качестве образца цвета снима-
ется «усредненный» цветовой тон текстуры.

 Match Color on screen (Взятие цвета с экрана)– работает аналогично, но не толь-
ко с материалами объектов, но и «захватывает» цвет с любой области рабочего окна 
программы (даже с элементов интерфейса!).

texture (текстура)
Это панель управления опциями замены (аналогично замене цветов) текущей 

«окраски» на текстурный материал, или замены текущей текстуры на другую, после чего 
она появляется в списке In Model закладки Select. Кроме того, здесь доступно несколько 
простых опций редактирования параметров текстуры. включение переключателя Use 
texture image (Использовать текстурный имидж) или сразу клик на кнопке Browse от-
крывает окно доступа через Проводник к файлам на жестком диске любых имиджей 
растровых форматов, поддерживаемых программой (шесть форматов – см. рис. ниже).
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 Если затем «снять галочку» с переключателя Use texture, имидж сразу удаляется из про-
екта, поэтому повторное включение галочки его не восстанавливает – если снова потребует-
ся текстура, ее придется выбирать заново. При этом после загрузки имиджа исходный цвет 
материала меняется на «усредненный» цвет имиджа, который остается и в случае отключения 
самого имиджа. впрочем, эти нюансы не так уж и важны, поскольку и для опций с цветом на 
любом шаге редактирования работает общая функция отмены предыдущих действий – Undo. 

 Кнопка Edit texture image in external editor (Редактировать текстурный имидж 
во внешнем редакторе) дублирует уже рассмотренную чуть раньше опцию контекстного 
меню в разделе In Model на миниатюрах (списках) материалов, использованных в проек-
те. Кстати, эта же опция доступна и из контекстного меню поверхностей непосредст-
венно на объектах сцены – применение ее в связке с другими опциями управления тек-
стурами рассмотрим позже.

Итак, загрузили новый растровый имидж или просто выбрали для редактиро-
вание текстурный материал из библиотеки – есть возможность здесь же изменить (на-
строить) несколько его ключевых параметров. Понятно, что это также будет немедлен-
но отражаться и в сцене на объектах, где применен этот материал. 

 

Первое, что здесь может быть изменено – цветовое тонирование текстуры, по-
скольку и с текстурами работают те же инструменты управления цветами (Picker), что 
и для «красок». 

Действие переключателя Colorize (Тонирование) сложно описать словами – вы-
берите текстуру и посмотрите, что происходит при включении и выключении опции. 
Смысл ее заключается в том, что включение опции ограничивает изменение цветов в 
диапазоне одного (общего, усредненного) цветового тона, т.е. как бы превращает пол-
ноцветный имидж в однотонный. 
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Окошко Reset Color (Сброс цвета) отображается исходный цветовой тон тексту-
ры, и, кликнув на нем, можно отменить все последующие опции тонирования.

Следующая группа опций управляет размерами и пропорциями активной тексту-
ры. Здесь требуется обратить внимание на принципиальный момент пояснение – тек-
стурный материал в SketchUp всегда представляет собой растровый имидж, уложен-
ный по поверхности объекта бесконечное число раз – как непрерывная «плиточная 
облицовка». Запомним этот, один из базовых принципов механизма текстурирования в 
SketchUp – к нему еще вернемся не раз... Понятно, что на объекте видим только часть 
этой «облицовки» в границах поверхности, к которой применен материал. Здесь же 
можно сразу для «согласования» геометрии поверхности и размера рисунка текстуры 
произвести корректировки через специальные окошки:

видим два окошка габаритов имиджа – его ширины и длины (с символами двой-
ных стрелок слева). Заметим, что эта опция не изменяет сам оригинал имиджа, а только 
его представление в модели, что сразу и видим на объектах сцены при изменении чи-
словых параметров. Здесь по умолчанию «замкнута цепочка» кнопки сохранения про-
порций, т.е. при изменении одного из измерений имиджа соответственно будет меняться 
и второе. Если хотим отключить эту функцию, коротко (!) кликаем на кнопке для «раз-
рыва цепочки» – при этом каждое из измерений становится возможным изменять неза-
висимо друг от друга. 

Для сброса деформаций имиджа до исходного состояния кликаем на кнопке сле-
ва от числовых окошек с символами «двойных стрелках».

Opacity (Непрозрачность)

Опция используется для назначения степени непрозрачности материала (числовое зна-
чение – в процентах). Передвижением слайдера влево/вправо или введением числа в окош-
ко значений от 0 (полная прозрачность) до 100 (полная непрозрачность) устанавливаем эту 
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величину. Причем при значении непрозрачности менее 70% поверхности, окрашенные этим 
материалом, перестают создавать падающие тени! Кроме очевидного применения для ими-
тации физических свойств реальных материалов типа стекла, опция может быть использо-
вана для своеобразного стилевого решениях подачи проекта, также интересных эффектов 
«игры» с тенями... но это отдельная тема. 

И в завершении вернемся еще раз в верхнюю часть окна – кнопка  Create 
Material (Создать материал) открывает доступ к опциям создания нового материала 
на основе текущего активного. 

Как видим, оно практически идентично окну Edit, поскольку выполняет те же функции 
редактирования материала. Принципиальное отличие заключается в том, что редактирует-
ся не сам текущий активный материал, а как бы его независимая копия, которая после на-
жатия кнопки ОК появляется в списке In Model в качестве нового дополнительного матери-
ала. Понятно, что эта опция очень удобна для быстрого создания «вариаций» на тему одно-
го и того же материала.

в завершении темы уточним, что рассмотренными инструментами и опциями диало-
гового окна Materials мы управляем параметрами материалов текущего проекта, независи-
мо от того, где и как они применены на объектах. Или, другими словами, любое редактиро-
вание средствами Materials действует одновременно и одинаково на все поверхности всех 
объектов сцены, где этот материал был применен. а инструменты и опции управления тек-
стурами непосредственно на поверхностях конкретных отдельных объектов с учетом их ге-
ометрии будут рассмотрены в следующей теме. 

Надо заметить также, что тема материалов SketchUp имеет непосредственное продол-
жение в «партнерских» программах фотореалистичного рендеринга и презентаций, и всех 
тех весьма сложных, но увлекательных вопросах, которые связаны с этими самостоятельны-
ми жанрами 3D-графики. Но об этом – позже, во второй книге...
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В этой теме рассмотрим, как реализован в SketchUp один из самых интере-

сных (но и один из самых сложных) механизмов 3D-графики – управление тек-
стурными материалами на поверхностях объектов. Фактически от «достоверно-
сти» этих возможностей зависит и степень «реальности» визуализации виртуаль-
ной модели, сцены, проекта, объекта – что, по большому счету, и есть конечная 
цель 3D-моделирования. 

Эта задача особенно актуальна для так называемых «фотореалистичных» текстур-ими-
джей, имитирующих реальные материалы и конечно – для соответствующих конечных целей 
конкретного проекта. так, например, простейшая геометрическая 3D-модель кубика после 
«обтяжки» его фототекстурой деревянных досок, однозначно начинает восприниматься «ре-
альным» деревянным ящиком... в этом, собственно, и состоит назначение и цель текстуриро-
вания. Однако здесь возникает проблема – представьте, что у вас в руках этот самый кубик 
и прямоугольный лист бумаги с напечатанной на нем текстурой... Очевидно, что «обернуть» 
им все грани кубика без предварительного создания «выкройки» под его форму и размеры, 
не получится. Причем на объектах сложной, «нерегулярной» формы (например, «органики»), 
для полноценного решения такого рода задач просто не обойтись без специализированных 
программ (и их немало)... и профессиональных навыков работы в них. 

Скажем сразу – в SketchUp возможности и средства управления текстурными матери-
алами предельно упрощены, а потому весьма ограничены по возможностям, хотя под специ-
ализацию SketchUp они свои задачи вполне успешно решают. Но с учетом того, что SketchUp 
– прекрасный «партнер» других 3D-редакторов, в т.ч. фотореалистичных рендеров, презен-
тационных программ и т.п., стоит знать основы управления трехмерным текстурированием 
и общепринятую терминологию. ведь если серьезно займетесь 3D-моделированием, неиз-
бежно, рано или поздно, столкнетесь с этими вопросами...

Итак, если в качестве материала используется текстурный имидж, поверхности (поли-
гоны) объекта будут «обтянуты» им по назначенным (и хранящимся в файле) т.н. UV-коорди-
натам. Что это означает? Для того чтобы наложить двухмерную «картинку» текстуры на по-
верхности трехмерного объекта, необходимо назначить текстурные 2D-координаты для вер-
шин, определяющих геометрию поверхностей 3D-объекта, т.е. фактически речь идет о раз-
вертывании трехмерной поверхности в плоскую, двухмерную. Эта процедура называется со-
зданием текстурной карты или по специальной терминологии – UV-mapping (UVs), а коорди-
наты в 2D текстурном пространстве принято обозначать символами U (по вертикали) и V (по 
горизонтали). На основании этих UV-данных для поверхности специальными программными 
алгоритмами рассчитываются трансформации между плоскостью текстуры и поверхностями 
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3D-объекта и строится «развертка» текстуры оптимальной формы (с минимальным «потеря-
ми» на искажения и неизбежные разрезы-швы). Эта процедура в терминологии UV-редакто-
ров называется Unwrap. На этом завершим «теоретическую» часть, заметив кстати, что в ин-
струментах и опциях SketchUp терминология UV-маппинга вообще не упоминается, а исполь-
зуется примерно аналогичное понятие «проецирования» текстуры на поверхности объектов.

Прежде чем приступить к изучению этих механизмов в SketchUp, познакомимся с оп-
циями помещения «сторонних» имиджей в сцену. По сути, это всегда импорт 2D-растровых 
файлов – во второй книге подробно изучим все возможности и варианты импорта/экспор-
та двух– и трехмерной графики, а пока остановимся только на одном, нужном в нашей теме. 

Для импорта в SketchUp используются команды меню File > Import... При этом откры-
вается окно Проводника, в котором выбираем файл нужного формата и вариант его при-
менения в модели – их трех доступных выбираем Use As Image (Использовать как имидж). 
Далее, после нажатия кнопки Open (Открыть) имидж помещается в сцену в месте двойного 
клика курсором. в итоге получаем в сцене своеобразный объект – изолированная имидж-
группу со специфическими особенностями – например, для нее недоступна возможность 
«внутреннего» редактирования», как у других групп, хотя ее можно, как любой другой объ-
ект, перемещать, вращать, масштабировать. Заметим, что аналогичный результат получаем 
и простым перетаскиванием имиджа из Проводника в сцену. И что же дальше? выводим наш 
объект из его «промежуточного состояния» имидж-группы опцией Explode – получаем обыч-
ную прямоугольную поверхность как бы с уже назначенным текстурным материалом, кото-
рый при этом тут же появляется в списке материалов проекта. 

Итак, возвращаемся к нашей теме. воспользуемся типичным приемом UV-редакторов 
– импортируем специальную «клеточную» тестовую текстуру, которая очень ясно и наглядно 
показывает, что происходит в этих опциях: 

Начнем изучение на тестовом примере – в нем представлены два типа объектов: один 
простой формы «блок» только с Faces – плоскими поверхностями (что как раз и характерно 
для задач SketchUp) и второй – «мышка» со сложными Surfaces поверхностями (т.е. фактиче-
ски сформированными теми же плоскими, но со сглаженными граничными ребрами). Мышку 
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сгруппируем в единый объект (обратим на это внимание!). Начнем с того, что импортируем 
тестовую имидж-текстуру – «выложим» его на «землю» под наши объекты (!) и попробуем 
назначить текстуру самым быстрым способом – захватим ее «пипеткой» (Alt + Paint Bucket) и 
«зальем» на все поверхности «блока» и на группу «мышка». Как видим, хаотичный результат 
на «мышке» совершенно неприемлем! На «блоке» верхние (горизонтальные и под неболь-
шим углом к горизонту) поверхности текстурированы нормально, но на боковых (вертикаль-
ных) текстура совершенно исказилась, превратившись просто в линии.

 

Что же произошло? Кликнем ПКМ, например, на верхней поверхности «блока», вы-
берем пункт контекстного меню Texture, через который и становятся доступны все даль-
нейшие опции над текстурами на поверхностях, и в открывшемся подменю обратим внима-
ние на включенный пункт с «галочкой» – Projected (Проецировать). Фактически здесь мы 
использовали один их двух доступных в SketchUp вариантов – т.н. Planar mapping в обще-
принятой 3D-терминологии – наложение текстур методом параллельных проекций. Суть его 
заключается в том, что имидж становится как бы картинкой, вставленной в проектор, ось 
объектива которого направлена нормально плоскости имиджа (в нашем примере – вер-
тикально). И далее изображение имиджа проецируется в этом фиксированном направле-
нии на все поверхности объектов, которые попадают под его «луч». Отсюда следует, что 
в идеале плоскости проецируемого имиджа и выбранной для текстурирования поверхно-
сти должны быть параллельны, или хотя бы угол между ними должен быть не более 30-45 
град. Что и видим на «блоке» – чем меньше этот угол, тем меньше искажения проекции тек-
стуры на поверхность, а на боковых поверхностях по этой причине он полностью дефор-
мировался, «размазавшись» по ней. Ну и конечно, будет спроецирована именно та часть 
имиджа, которая находится «напротив» поверхности, т.е. имеет значение и взаимное рас-
положение «текстура/поверхность». 

Заметим, что «проекционная» плоскость-текстура вовсе не обязательно должна ле-
жать строго горизонтально – можем, как любой другой объект, ориентировать ее как угод-
но в пространстве. а отсюда следует, что можно решить проблему искажений на боковых 
поверхностях блока, просто развернув вертикально имидж... и проделать те же действия 
отдельно для вертикальных плоскостей объектов. Ну и аналогично, ту же методику мож-
но использовать и для остальных, наклонных поверхностей, разворачивая на тот же угол 
и имидж и выставляя в нужное положение «напротив» поверхности перед проецировани-
ем с него текстуры. 
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а что же произошло с «мышкой» при «проекционном» методе? во-первых, войдя в 
режим внутреннего редактирования этой группы, видим, что в контекстном меню криволи-
нейной (сглаженной) поверхности пункт Texture просто-напросто отсутствует, т.е. никакие 
опции над текстурами в этом состоянии недоступны. а во-вторых, не вдаваясь в подробно-
сти, почему получили такое явно непригодное текстурирование, просто запомним – при по-
мещение текстур на поверхности сложной кривизны «окраской» группы целиком гаранти-
рован некорректный результат. Итак, «разрываем» группу «мышки» – Explode и «заливаем» 
ту же Projected текстуру (рис. ниже слева). Как видим, результат уже лучше, однако налицо 
те же самые, что и в «блоке», искажения от несовпадения плоскостей имиджа – «проекто-
ра» и поверхностей объекта. 

Можем улучшить ситуацию за счет разделения единого объема (например, в этом слу-
чае, «разрезанием» на части по характерным линиям «перелома» характера кривизны) и раз-
дельным последующим текстурированием по частям (рис. выше справа). 

Это уже вполне приемлемый результат, на нем и остановимся... тем более, что лучше-
го средствами SketchUp добиться не получится... Однако в объектах более сложной геоме-
трии (например, в уже упомянутой «органике») и этим приемом получить удовлетворитель-
ный результат вряд ли удастся. 

теперь разберемся с работой второго, «непроекционного» механизма SketchUp – на 
текстуре любой поверхности «блока» в контекстном меню Texture снимем «галочку» у пун-
кта Projected. тем самым (хотя внешне ничего не изменилось), принципиально меняем свой-
ства исходной текстуры – теперь ее ориентация в пространстве никак не учитывается, не 
принимается во внимание. а раз так, можем спокойно удалить имидж из сцены... тем более, 
что он уже присутствует в списке материалов проекта In Model. 

Главное отличие «непроекционной» текстуры от «проекционной» – она сразу автома-
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тически стремится полностью «обернуть» объект. а точнее – видим фактически то же «пла-
нарное» проецирование, но одновременно на все поверхности, с автоматической ориента-
цией текстуры в плоскость каждой поверхности! Нетрудно заметить, что собственно имен-
но этот механизм по умолчанию и работает, когда пользуемся текстурными «библиотечны-
ми» материалами непосредственно из окна Materials. Однако, если просто выбрать объект 
целиком (все его поверхности), и «залить» текстуру, увидим, что механизм сработал совер-
шенно «стихийно» – для каждой поверхности как бы отдельно, так что достоверного «обо-
рачивания» цельным имиджем получить не удалось (на рис. – «блок» слева). 

решить это затруднение, задать корректный порядок «перетекания» текстуры через 
граничные ребра с одной поверхности на другую, соседнюю – вполне возможно. Для этого 
«снимаем пипеткой» текстуру с одной из поверхностей и затем последовательно «заливаем» 
на каждую из соседних (на рис. выше – «блок» справа). т.е. как бы подсказываем программе 
порядок следования и направление «заливки». Этот же прием применим для Surfaces «мыш-
ки», однако поскольку опции контекстного меню Texture доступны только для плоских по-
верхностей, предварительно потребуется их «выявить». Для этого можно либо снять смяг-
чение/сглаживание ребер (см. тему 5 «Инструменты модификаций» – Soften /Smooth Edges), 
либо, что через опцию View > Hidden Geometry получить доступ к каждой из плоских повер-
хностей, формирующих эти Surfaces. Ну и далее проделываем те же манипуляции с указани-
ем «перетекания» текстуры, что и для блока. впрочем, этот вариант приведен больше для 
того, чтобы показать действие механизма текстурирования на криволинейных поверхно-
стях, чем для практического применения – очевидно, что трудоемкость такого ручного «об-
щелкивания» сотен, а то и тысяч поверхностей, скорее всего окажется нереально высока...
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Есть и еще один способ «заливки» текстуры в аналогичной ситуации для Surfaces. Как 
и в приведенном выше варианте, «снимаем пипеткой» текстуру с одной из ее плоских повер-
хностей, затем выключаем (!) опцию View > Hidden Geometry (видим опять общую сглажен-
ную Surface), после чего кликаем в любом ее месте курсором Paint Bucket с нажатой клави-
шей Ctrl, т.е. «за раз» помещаем материал на все последовательно смежные поверхности 
объекта. впрочем, при очевидном преимуществе в быстроте выполнения, приходится заме-
тить, что этот способ не всегда срабатывает предсказуемо и корректно (зависит от конкрет-
ной геометрии объекта).

И замечаем еще одну проблему – корректное последовательное «оборачивание» тек-
стуры по поверхностям возможно только в одном (!) направлении следования поверхностей 
(вспомним пример с оборачиванием кубика листом бумаги, который был приведен в нача-
ле этой темы), а потому на каких-то ребрах будут образовываться «разрезы» (или швы, как 
еще их называют) текстуры. На самом деле, даже в профессиональных UV-редакторах это 
одна из главных проблем, которую решают размещением «швов» на самых незаметных ме-
стах (например «спинах») объектов.

Еще одна проблема, которую приходится решать при текстурировании, возникает 
из принятого в SketchUp механизма автоматического «бесконечного» повторения «плиток» 
имиджа в двух взаимно перпендикулярных направлениях до заполнения поверхности в гра-
ницах ее ребер. При этом, для получения достоверного результата, почти всегда приходит-
ся «подстраивать» размеры, пропорции и положение плиток текстуры под конкретный объ-
ект, т.е. регулировать характер «укладки» текстурного имиджа по поверхностям. Для этого 
в SketchUp предусмотрен набор специальных функций Position, которые подробно рассмо-
трим далее, но перед этим остановимся на одной типичной проблеме, которую иллюстри-
рует рисунок ниже:

 

Как видим, на левом объекте текстура травы выглядит вполне достоверно, а на пра-
вом, при определенном соотношении размеров поверхности и плиток текстуры, начинают 
явно проявляться границы каждой плитки, «швы» между ними... что, конечно, неприемлемо 
для качественного текстурирования. Как этого избежать? только одним способом – для по-
лучения нужного результата применять только т.н. «бесшовные» текстуры. Это специально 
подготовленные имиджи (типично – природных материалов), у которых «границы» при при-
мыкании одной плитки к другой выглядят таким образом, что их сплошная укладка создает 
полную иллюзию совершенно однородной поверхности. Кстати, почти все «библиотечные» 
текстуры в материалах SketchUp «теоретически» таковыми и являются, однако (что и показыва-
ет приведенный пример) многие из них в этом плане изготовлены недостаточно качественно. 
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Где взять такие качественные бесшовые текстуры? Прежде всего, без труда найде-
те в Интернете множество тематических библиотек, например, по поисковым словам «бес-
шовные текстуры» или на английском – «Seamless textures». Ну а если потребуется сделать 
свою уникальную «обычную» текстуру бесшовной – существуют специализированные под 
эту задачу программы и плагины, а также уроки для растровых редакторов... их также мож-
но найти в Интернете.

И последнее про бесшовные текстуры. Очевидно их главное преимущество – по при-
чине полной однородности по всем направлениям, для них не существует описанных выше 
проблем UV-маппинга – просто «заливаем» ими объект любым из доступных и удобных спо-
собов... И остается только уточнить размер «плитки» текстуры под объект.

POsitiOn (поЗИЦИЯ тЕКСтУрЫ)
Приступаем к изучению остального набора функций контекстного меню Texture. Сна-

чала коротко об очевидных: Reset Position (Сброс позиции) – отменяет до исходного состо-
яния все опции редактирования текстуры на этой поверхности; Edit Texture Image – уже зна-
комая (по предыдущей теме «Материалы») опция перехода к редактированию имиджа тек-
стуры в стороннем графическом редакторе. 

 Итак, пункт Position – опции управления характером текстурной «облицовки» за счет 
изменения ее размеров, положения и искажения на любой (каждой) из поверхностей. Еще 
раз подчеркнем, что опция Position доступна только на плоских поверхностях, т.е. нельзя 
«напрямую» редактировать текстуры, назначенные криволинейным поверхностям как еди-
ному целому – при их выборе опция будет просто неактивна. тем не менее, можно редак-
тировать текстуры на отдельных составляющих их плоских поверхностях, используя опцию 
View > Hidden Geometry (Показать скрытые построения). 

После выбора Position над поверхностью появляется полупрозрачная «матрица» из 
плиток текстуры и четыре Pins – «штырьки» по углам одной «плитки» с символами их опций 
четырех цветов (подробно – далее), и курсор – «рука». 

Сразу заметим, что хотя манипулировать инструментами позиционирования можно и 
в показанном на рис. выше перспективном виде, все-таки удобнее делать это в стандартных 
видах и параллельных проекциях. а еще проще (тем более, если поверхность ориентирова-
на не по планам осей), использовать опцию Align View (Выровнять вид) контекстного меню 
нужной поверхности, которая направит камеру на нее «сверху».

Первая и самая простая возможность редактирования – смещение текстуры курсо-
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ром «рука» (с нажатой клавишей мыши) «скольжением» по поверхности.
Если на этой стадии сделать еще один контекстный клик, откроется дополнительное 

меню, через которое можно: 
Done (Готово) – завершить опцию (или, что аналогично, можно просто кликнуть сна-

ружи от текстуры);
Reset (Сброс) – вернуться к исходному (до редактирования) состоянию;
Flip (Отразить зеркально) – «отзеркаливает» на месте текстуру Left/Right, Up/Down 

(слева-направо, сверху-вниз);
Rotate (Вращать) – повернуть на фиксированный угол: 90, 180, 270 град.;
Undo (Отмена) – отмена последней позиции текстуры;
Redo (Повторить) – отмена предшествующей команды Undo. 
Следующая, более сложная группа возможностей редактирования – манипуляции со 

штырьками (Pins). Штырьки могут иметь два состояния: Fixed Pins – фиксированное (по умол-
чанию – галочка на пункте меню) и свободное (галочка снята). Можно также снять фиксацию 
при помещении курсора на любой из штырьков с нажатой клавишей Shift, а при нажатой 
клавише CTRL отключается механизм «прилипания» – snapping. При помещении курсора 
на штырек рядом появляется (у каждого своя) текстовая подсказка его действия. 

С фиксированными (одним или более) штырьками можно масштабировать, сдвигать, 
перекашивать или искажать текстуру. Короткий одиночный клик на штырьке захватывает его 
и позволяет переместить на другую позицию – новый отправной пункт для любого из дей-
ствий (текстовая подсказка: «Click to lift pin»). видим, что каждый из четырех штырьков обо-
значен разными цветами и имеет символ его специфической опции. Для выполнения опции 
кликаем на штырьке или символе рядом и удерживая клавишу мыши, перемещаем: 

 Позиция (текстовая подсказка: «Drag pin to move texture») – смещение тек-
стуры вдоль поверхности по вертикали/горизонтали – дублирует действие с помощью кур-
сора «Рука».

 Масштабирование / вращение (текстовая подсказка: «Drag pin to scale/rotate 
texture») – при перемещении штырька строго по горизонтали наружу (из поверхности) про-
исходит пропорциональное масштабирование текстуры с увеличением; при перемещении по 
горизонтали внутрь – с уменьшением. Одновременно появляется изображением транспорти-
ра и дуги вращения – перемещаем штырек по дуге для вращения без масштабирования. За-
метим, что точки вдоль направляющих линий и дуги подсказывают текущий и исходный раз-
меры текстуры – можем вернуться к исходным размерам перемещением курсора на исход-
ные линии и дугу. Или выбрать опцию Reset (Сброс) из контекстного меню. 

 Масштабирование / сдвиг (текстовая подсказка: «Drag pin to scale/shear 
texture») – при перемещениях штырька по горизонтали происходит перекос текстуры, по 
вертикали – непропорциональное масштабирование. также одновременно появляется изо-
бражением транспортира для контроля за углом перекоса. Заметим, что два нижних штырь-
ка неподвижны во время этой опции. 

 Перспективное искажение (текстовая подсказка: «Drag pin to distort texture») 
– при перемещениях штырька происходит перспективное искажение исходного вида. Заме-
тим, что все остальные штырьки неподвижны (фиксируют остальные углы) во время этой оп-
ции. Естественно, если нужно исказить текстуру с другой позиции, просто переносим этот 
штырек в нужное место и задействуем оттуда.



128 тема 11. тЕКСтУрИрОваНИЕ

Кроме показанных действий с фиксированными по умолчанию штырьками, можно по-
лучить множество вариантов искажений текстуры со «свободными», перемещая и устанав-
ливая их на новые позиции. 

Как видим, манипуляции с текстурами на поверхностях «внутри» SketсhUp (фактиче-
ски – редактирование исходных растровых имиджей) сложно назвать простыми или удоб-
ными... Поэтому на практике, надо признать, пользователь все-таки чаще приходит к выво-
ду, что лучше предварительно довести до нужной максимальной готовности имиджи по раз-
мерам, пропорциям и т.п. в специализированном растровом редакторе, а уже затем перехо-
дить к другим опциям «обтяжки» ими соответствующих поверхностей объектов непосред-
ственно в SketсhUp. 

а теперь вернемся к нашим тестовым объектам – «блоку» и «мышке», считая, что все 
необходимые настройки для корректного маппинга (назначения текстурных UV-координат) 
на основе тестовой «клеточной» текстуры сделаны. И что же дальше? ведь нам нужно на 
самом деле другое – назначить объекту наш определенный текстурный материал... Это уже 
достаточно просто сделать через редактирование тестового материала (Materials > Select > 
In Model > Edit texture image), точнее – замены его на другой, нужный. Одно обязательное 
условие – сохранить те же пропорции «картинки», иначе появятся неизбежные искажения. 
Причем заметим, что теперь можем сколько угодно раз повторить такие «замены» – любая 
другая текстура так же точно так же корректно «ляжет» на поверхности объекта, посколь-
ку ему уже назначены текстурные координаты... собственно в этом и состоит смысл рабо-
ты с UV-маппингом.

в завершении темы познакомимся еще с несколькими функциями, доступными из кон-
тексного меню поверхностей (только плоских!) с текстурными материалами. вряд ли можно 
их отнести к постоянно востребованным в практической работе, однако не исключено, что 
в каких-то отдельных задачах такие возможности могут пригодиться. 

make unique texture (Создать уникальную текстуру)
Создадим поверхность любой формы, «зальем» на нее нашу тестовую текстуру, и при-

меним Make Unique Texture – видим, что в списке материалов проекта In Model появился до-
полнительный материал. Его отличие от исходного очевидно – фактически это «снимок» по-
верхности, на которой он создан, или как по-другому говорят – опция «запекает» имидж в 
форму, очертания поверхности (рис. ниже слева):
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Заметим, что во-первых, опция работает только на одной, единичной поверхности, и 

во-вторых, созданная текстура все равно, всегда – прямоугольник (по-другому в растровой 
графике быть и не может), в котором зоны снаружи очертаний исходной поверхности просто 
заливаются белым цветом, и в-третьих – создание нового материала возможно не только из 
растра, но и из материала – «краски». в таком случае применения исходного материала из 
группы Colors (Цвета), появляется еще окошко промежуточной опции – назначения разме-
ров текстуры (рис. выше справа).

 

cOmBinE tExtuREs (КоМБИНИроватЬ тЕКСтУрЫ)
разделим поверхность на части новыми ребрами-границами или, что аналогично, 

«состыкуем» несколько coplanar (смежных, лежащих в одной плоскости) поверхностей. За-
тем назначим каждой из частей разные материалы, выберем их вместе и применим опцию: 

Как видим, опция очень похожа по смыслу на предыдущую – здесь также создается 
новый материал – единая текстура, скомбинированная из исходных частей, и также «запе-
кает» имидж в форму очертаний выбранных вместе поверхностей. Обратим еще внимание 
на возможность выбора в появляющемся окошке – удалять внутренние, разделяющие ре-
бра, или нет.

 

aDD PhOtO tExtuRE (НаЗНаЧИтЬ ФототЕКСтУрУ)
Хотя эта опция по названию явно относится к текстурным материалам, она на самом 

деле является частью другой группы функций – инструментов, сервисов Google, которые будут 
подробно рассмотрены в отдельной теме второй книги. Заметим только, что этот пункт контек-
стного меню доступен для всех плоских поверхностей и в любых сочетаниях – и одиночных, 
и при их множественном выборе, и для уже «окрашенных», и с материалами по умолчанию... 
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Основное назначение и прямой результат действия Слоев – распределение 

по ним объектов с возможностью их показа/скрытия за счет включения/выклю-
чения видимости самих слоев. Умелое использование такого механизма помога-
ет как в рациональной организации рабочего моделирования, так и в создании 
эффектных презентаций готового проекта. 

Прежде всего разберемся со спецификой понятия «Слои» в SketchUp, поскольку непони-
мание сути их механизма – источник типичных затруднений пользователей. Надо сразу сказать, 
что сам термин «Слои» вводит в заблуждение, потому что повторяет название знакомого мно-
гим механизма 2D графических редакторов (например, в Adobe PhotoShop) с другим принципом 
действия. там это – аналог листов кальки, уложенных стопкой, на каждом из которых разме-
щены независимые от других слоев, изображения, и которые можно перемещать выше-ниже 
(над/под) относительно друг друга, а также показывать или скрывать в рабочем пространстве. 

в едином рабочем пространстве трехмерного моделирования такое устройство просто 
невозможно – объекты, «размещенные» в разных слоях SketchUp, не изолируются друг, а сами 
слои работают только (!) в части скрытия/показа «принадлежащих» им объектов. Здесь не зря 
понятия «размещенные» и «принадлежащих» помещены в кавычки – на самом деле речь идет 
только о назначении объекту атрибута связи с именем определенного слоя. Или по-другому 
– построение, модификации геометрии и удаление объектов фактически никак не связаны со 
структурой слоев в проекте, все происходит как бы одновременно во всех слоях. И соответст-
венно, удаление, добавление и показ/скрытие слоев никак не влияют на геометрию построений.

Откроем проект нашего тестового домика, выберем, например, группу крыши и вызо-
вем на ней контекстное диалоговое окно Entity Info. Обратим внимание на пункт layer (Слой) – 
видим в окошке имя слоя, которому принадлежит эта группа – Layer 0. 
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К использованию диалога Entity Info для работы со Слоями вернемся позже, а пока 
рассмотрим главный «менеджер» Слоев.

ДИаЛоГовоЕ оКНо layERs (СЛоИ)
Управление слоями осуществляется из диалогового окна, которое открывается че-

рез меню Window > layers и показывает все слои, имеющиеся (созданные) на данном эта-
пе в проекте. в окне Layers увидим в нашем примере в списке слоев пока один – Layer 0, ко-
торый всегда и постоянно по умолчанию присутствует в каждом проекте, а в Entity Info ото-
бражается, какому слою принадлежит выбранный объект. таким же образом распределение 
объектов по слоям и назначение им специфических параметров будет постоянно отобра-
жаться в этих двух окнах – вот, собственно, и вся суть управления ситуацией «объект/слой».

разберемся подробно с устройством диалогового окна Layers.

Name (Имя) – первая колонка в списке слоев. Новые слои ( в дополнение к Layer0) 
создаются круглой кнопкой со знаком «+», при этом новому слою автоматически присваи-
ваться имя Layer# со следующим порядковым номером. Естественно, имеет смысл тут же пе-
реименовать слой, дав ему значащее имя. впрочем, это можно сделать в любой момент и 
позже, входя в режим его редактирования двойным кликом на имени слоя. так, например, 
можно заранее, планируя организацию проекта, создать нужные слои с именами конструк-
ций (как показано в примере выше), или по функциональному признаку (например, «Сантех-
ника», «Мебель»). Причем, заметим, в этом случае можно спокойно пользоваться названия-
ми на русском, поскольку передача Слоев в другие программы проблем не создает – они их, 
как правило, просто не воспринимают. 

Еще одна принципиально важная функция, также находящаяся в колонке Name – на-
значение current (текущего) слоя, хотя по смыслу правильней называть его «активным», что 
мы далее и будем делать. Что значит «активный»? Это значит, что при моделировании лю-
бому новому построению автоматически присваивается принадлежность к этому слою, не-
зависимо от того, строка какого слоя в этот момент выбрана в списке (затенена серым цве-
том). Подчеркну, что просто выбор кликом на строке слоя в списке ничего не значит – для 
назначения слою свойств активного кликаем на переключателе – круглой кнопке левее 
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имени слоя. Или по-другому – черная точка в кнопке левее имени слоя указывает на то, что 
именно он в данный момент активный. Естественно, таковым в каждый момент времени мо-
жет быть только один из слоев, и при выборе в качестве активного другого слоя предыду-
щий станет «обычным». 

Любой из созданных слоев (кроме Layer 0) можно удалить кликом на круглой кнопке 
со знаком «-». При этом появляется запрос о выборе «переназначения» элементов, принад-
лежащих этому слою, на другой слой:

Move contents to Default Layer – переместить содержимое на слой по умолчанию 
(т.е. на Layer 0);

Move contents to Current Layer – переместить содержимое на активный слой. Это, 
фактически, возможность объединения содержимого двух слоев.

Delete contents – удалить содержимое слоя безвозвратно.
При удалении активного слоя (любого, кроме Layer 0) второй вариант, понятно, бу-

дет недоступен.
Можно в этой же колонке отсортировать слои (кроме Layer 0) по их именам в прямом 

и обратном алфавитном порядке, кликая на заголовках колонок (неважно – какой).
При необходимости удаления нескольких слоев одновременно можно использовать 

стандартные опции множественного выбора с клавишами Ctrl и Shif.

Итак, с созданием и управлением списком слоев мы разобрались, а как же назначить 
объектам принадлежность определенному слою? в любой момент можно переназначить 
любой элемент построения с одного слоя на другой через его диалоговое окно Entity Info. 
в нашем примере: выбрали объект – стены (группу «steni»), открыли кнопкой окошка Layer 
список всех уже созданных слоев в проекте, и выбрали в нем слой «Стены». таким образом, 
из слоя по умолчанию Layer0 мы переместили стены (все элементы построений, объединен-
ные группой «steni») в слой «Стены».

а теперь откроем окно Layer, и в строке «Стены» кликнем на квадратике в третьей 
колонке – «снимем галочку». видим, что стены «исчезли», точнее, стали невидимы, посколь-
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ку этим действием мы отключили видимость слоя «Стены», принадлежность стен к которо-
му до этого назначили. 

теперь, думаю, стало ясно, для чего предусмотрена возможность выбора любого слоя 
(его строки в списке) независимо от того, какой слой в этот момент активен.

разберемся подробней с этой основной опцией «видимости/невидимости» Слоев.
 
Visible (видимость) – вторая колонка в списке слоев – переключатель включе-

ния/выключения видимости слоя, а фактически – всех принадлежащих ему объектов (види-
мый – с «галочкой»). 

Мы уже знакомы с опциями Hide/Unhide аналогичного назначения... в чем разница? 
Hide/Unhide – опция «штучная», работающая на отдельных (любых!) элементах и объектах 
построений. Безусловно, ее преимущество – в простоте и наглядности, однако в то же вре-
мя, если мы скрыли таким образом несколько десятков элементов, так же выборочно (или 
для всех сразу) придется отменять и скрытие. а кроме того, функция Hide/Unhide этим и ог-
раничивается, в то время как Layers имеют несоизмеримо более широкие возможности и ва-
рианты применения, что и увидим дальше. 

И, пожалуй, самое главное – возможность быстрого, удобного скрытия/показа боль-
ших «массивов» содержимого сцены – самая эффективная методика снятия нерациональной 
загрузки компьютера и организации удобного доступа к объектам текущего моделирования. 

Кроме включения «галочкой», скрытый слой автоматически становится видимым, ког-
да делаем его активным. При попытке назначить невидимость активному слою, появляется 
окошко с сообщением, что сделать это невозможно – «You cannot hide the current layer».

color (Цвет) – третья колонка в списке, содержит условные цветовые обозначе-
ния слоев. При добавлении слоев по умолчанию цвета назначаются автоматически (и «слу-
чайно»). Стрелка в правом верхнем углу окна открывает меню с дополнительными функци-
ями: 

– Select All (Выбрать все) – выбирает все слои в списке одновременно;
– Purge (Очистить) – удаляет все неиспользованные («пустые») слои. Заметим, что эта 

же опция доступна и из знакомого уже меню «тотальной очистки» проекта от неиспользуе-
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мого: Window > Model Info > Statistics > Purge Unused.
– Color by Layer (Цвет по Слою) – показывает все построения, размещенные в данном 

слое, окрашенными в условные цвета, показанные в колонке Color. При этом опция никак не 
влияет на ранее назначенные поверхностям построений «реальные» материалы – это не бо-
лее чем условный вариант отображения объектов сцены. Отсюда – первое очевидное и про-
стое применение опции – контроль за правильностью распределения элементов по слоям. 

Проверим на нашем примере – трубу на крыше «ошибочно» назначим на слой «Сте-
ны», что приведет к тому, что при скрытии слоя «Стены» станет невидимой и труба на кры-
ше. видим, что в этом варианте отображения ошибка сразу становится явной:

Однако на самом деле в этой функции есть и дополнительные возможности – сдела-
ем двойной клик на цветном квадратике – открывается полноценное окно редактирования 
материалов Materials. то, что здесь можно изменить условный цвет по умолчанию на любой 
другой – очевидно. Но заметим, что при этом есть полноценный доступ ко всем другим воз-
можностям редактирования, в т.ч. к текстурам. а отсюда следует, что на самом деле опция 
Color by Layer – альтернативный вариант полноценного управления материалами с интере-
сными возможностями, которые недоступны при «штатном» управлении ими. Но это отдель-
ная тема, также как и тема использования Слоев в презентациях (анимациях) и взаимодейст-
вии с др. механизмами SketchUp – к ним вернемся позже.

Безусловно, Слои – один из самых сложных механизмов SketchUp для понимания прин-
ципа действия и работы, требующий повышенного внимания и аккуратности. тем более, что 
искать причины ошибок и исправлять их впоследствии (особенно в сложных проектах) – за-
нятие трудоемкое и неблагодарное...

Поэтому в завершении темы остановимся на типичном вопросе – как избежать оши-
бок при «распределении» объектов по слоям? Чтобы полностью разобраться с этим вопро-
сом, протестируем опцию на простейшем примере:

1. Откроем новый «чистый» файл и построим кубик. Поскольку по умолчанию пока 
есть только один слой Layer0, он же и активный, автоматически получаем принадлежность 
всех элементов этому слою. Создадим здесь же группу кубика – она также, как единый эле-
мент построения, принадлежит этому же слою Layer0:
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2. Создадим новый слой – Layer1 и «переназначим» на него в Entity Info группу куби-
ка (рис. сверху). Однако, если войдем «внутрь», в режим редактирования группы, и выберем 
любой элемент (или все), видим, что при этом они «остались» в Layer0 (рис. снизу).

вспомним принцип – все текущие опции выполняются в том слое, который в этот мо-
мент активен, а мы сначала построили и сгруппировали кубик в активном слое (Layer0), а 
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затем группе назначили принадлежность к другому (Layer1). Если теперь «выключить» слой 
Layer0, принадлежащие ему элементы построения кубика (а значит, и вся группа в целом) все 
равно останутся видимыми. И наоборот, при скрытии слоя Layer1 «исчезнет» и группа кубика, 
и все его «внутренние» элементы, хотя они принадлежат слою Layer0! таким образом, осо-
бенно в случае множества слоев в сложном проекте, результаты скрытия отдельных слоев 
могут быть просто непредсказуемы! тем более запутанная ситуация может возникнуть, если 
имеем в проекте «вложенную» структуру групп и компонентов.

Правило №1 – группируем (или превращаем в компоненты) набор элементов толь-
ко после того, как убедимся, что все они принадлежат (предварительно назначены) од-
ному определенному (нужному) слою – т.е. тому, который должен быть и у группы. Или 
по-другому – начинаем строить новые объекты и создаем из них группы в одном и том 
же активном слое.

Конечно, можно исправить ошибку такого рода в любой момент, откорректировав 
принадлежность групп (компонентов) как единых объектов и их «внутреннего» содержимо-
го по указанным принципам. Правильный результат будет получен тот же... если не считать 
затраченного впустую времени и нервов. 

3. вернемся к исходному состоянию кубика (до группировки) и для наглядности окра-
сим одну грань в красный цвет, а остальные – в зеленый. Назначим красную грань в Layer1, 
а остальные оставим в Layer0. теперь выберем все и видим, что окошко Entity Info > Layer – 
пустое, поскольку программа не может определить, к какому же все-таки слою все выбран-
ное принадлежит (рис. слева)? Посмотрим к чему это приведет – создадим группу (например, 
в текущем слое Layer0), и скроем (выключим) слой Layer1 (рис. справа). Как видим, и в этом 
случае произошло «исчезновение» – красной грани. Причем еще более странная ситуация 
возникает, когда есть общее «пограничное» ребро, разделяющее грани из разных слоев – 
видим поверхности без ребер, чего в принципе быть не может. 

Правило № 2 – никогда не размещаем части одного объекта, т.е. связанной гео-



137 тема 12. СЛОИ

метрии, в разных слоях. видим, что если даже создать из этих элементов группу, принадле-
жащую какому-либо определенному слою, ее отдельные элементы все равно «останутся» в 
своих исходных слоях, а потому скрытие отдельных слоев могут приводить к «потере» ото-
бражения отдельных частей объекта. 

Отсюда вытекает и Правило № 3 – начинаем построение новых объектов «в чи-
стом поле», но не на поверхностях или ребрах уже существующих объектов, которые мо-
гут оказаться принадлежащими другим слоям. Конечно, если это только не делается ос-
мысленно, с учетом «конструкции», или если уже существующие объекты не «закрыты» вну-
три своих групп или компонентов.

Ну и еще раз, пожалуй, главное правило – если в проекте создано несколько слоев 
и мы активно с ними работаем, при начале новых построений и редактировании суще-
ствующих внимательно следим за тем, какой слой в этот момент активен! Понятно, что 
при этом для контроля за ситуацией всегда должны быть открыты диалоговые окна Layers 
и Entity Info...

Итак, как уже убедились, управление Слоями весьма непросто, требует максималь-
но внимательного и скрупулезного подхода к организации проекта в текущих построениях. 
т.е. этот механизм просто «чреват» ошибками, которые сложно впоследствии исправлять, 
но он того стоит...  

Замечу в завершении, что существует ряд плагинов, значительно облегчающих эту 
работу – самые полезные из них будут рассмотрены во второй части (книге) нашего курса.
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Так же, как и другие основные опции и инструменты визуализации проекта, 

этот механизм эффективно работает и на стадии рабочего моделирования и на фи-
нальном, «презентационном» этапе. Суть механизма Сцен заключается в возмож-
ности создания, выбора, изменения и сохранения ряда последовательных «сним-
ков» проекта с различной «режиссурой» кадра – ракурсами (точками взгляда) и 
другими параметрами оформления. 

ДИаЛоГовоЕ оКНо scEnEs (СЦЕНЫ)
Управление Сценами осуществляется через специальное диалоговое окно, которые 

вызывается через меню Window > Scenes.

 
Для лучшего понимания сути происходящего при работе со сценами сначала рассмо-

трим нижнюю часть окна – перечень параметров «снимка» окна моделирования, которые 
будут учтены (или нет) в каждой сцене включением/выключением соответствующего пере-
ключателя:

Properties to save (Сохраняемые настройки)
– Camera Location (Позиция камеры) – все текущие параметры камеры;



139 тема 13. СЦЕНы

– Hidden Geometry (Скрытие геометрии) – применение к объектам текущих опций 
Hide/Unhide;

– Visible Layers (Скрытые слои) – применение текущих опций скрытия/показа Слоев;
– Active Section Planes (Активные сечения) – применение текущих опций разрезов и 

сечений (об этом механизме – подробно во второй части курса);
– Drawing Style (Стили моделирования) – все текущие параметры стилей отображе-

ния ребер и поверхностей объектов;
– Shadows Settings (настройки теней) – все текущие параметры теней в сцене; 
– Axes Location (Положение осей) – показ осей сцены.
Практика использования этого механизма наглядно покажет, что получаем практиче-

ски безграничные возможности разнообразить содержание и оформление каждой сцен за 
счет подбора различных сочетаний этих параметров... 

Список сцен
После открытия диалогового окна видим панель списка сцен в проекте – изначально 

она по умолчанию пустая, т.е. пока никаких сцен в проекте не создано. Над панелью разме-
щены кнопки управления опциями панели:

Update Scene (Обновить сцену) – обновляет (т.е. сохраняет в проекте) произ-
веденные в выбранных сценах изменения параметров, указанных в панели Properties to Save 
(Сохраняемые настройки), которые и были рассмотрены выше. Это очень важный пункт (не 
зря поставленный «первым номером») – если после произведенных изменений не сохранить 
их, то при переходе к другой сцене они будут потеряны – опция отмены здесь не работает!

Если после создания сцены мы произвели в ней какие-либо стилевые изменения, то 
после нажатия кнопки Update Scene по умолчанию открывается окно, напоминающее о том, 
что требуется выбор вариантов их сохранения (или нет). 

Здесь требуется отвлечься на необходимое пояснение – что значит «стилевые из-
менения»? Мы уже изучили специальную панель инструментов Styles (Стили поверхностей) 
и опции меню View > Edge Styles (Стили ребер). Эти элементы интерфейса можно назвать 
«оперативными» инструментами, а полное, развернутое управление всеми возможно-
стями рендеринга SketchUp сосредоточено в специальном диалоговом окне Styles (Сти-
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ли). Это наша следующая тема, а пока заметим только, что хотя рассматриваемая опция 
сохранения стилевых изменений фактически работает именно с окном Styles (Стили), о 
сути происходящего при этом все-таки следует знать уже сейчас.

Итак, окно выбора вариантов действий учета произведенных стилевых измене-
ний в сцене:

– Save as a new style – сохранить как новый стиль в списке In Model (т.е. в файле 
проекта) диалогового окна Styles;

– Update a selected style – обновить выбранный стиль, т.е. наоборот, текущие сти-
левые настройки сцены применить к стилю (изменить его с этими новыми параметрами);

– Do nothing to save chages – ничего не делать. в этом варианте выбора становится 
активным переключатель ниже, в котором можно включить опцию Please don’t show this 
again. I will manage style change on my own, смысл которой можно перевести как: «Не 
показывать больше это окно, решения по управлению стилями буду принимать самосто-
ятельно». вряд ли имеет смысл включать этот пункт и тем самым отказываться от полез-
ных подсказок, которые помогают принятию нужных в конкретной ситуации решений...

Прежде чем пойти дальше, обратим внимание на одну важную деталь – кроме сохра-
нения набора настроек сцен проекта, назначаемых общей для проекта опцией Properties 
to save, при каждом обновлении каждой из сцен опцией Update Scene также есть воз-
можность выбора – какие параметры сохранять, какие нет через всплывающее окошко: 

При этом действует принцип – параметры опции Properties to save имеют приори-
тет над опцией Update Scene: т.е., например, если какие-то настройки запрещены к из-
менению до этого в Properties to save, то они не будут доступны и в Update Scene. Ну а 
проще говоря, самый универсальный вариант – оставляем настройки Properties to save 
как есть (по умолчанию), что дает возможность принимать любые решения по конкрет-
ной ситуации в Update Scene.

Add Scene (Добавить сцену) – создает в проекте первую сцену (которой ав-
томатически присваивается имя Scene1) и добавляет последующие с порядковыми номе-
рами в список сцен. Для перехода между сценами делаем двойной клик на нужной стро-
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ке их списка. 
Одновременно с добавлением новых сцен над верхним левым углом окна моде-

лирования появляются панельки-заголовки с их именами сцен, выстраиваясь в ряд – кли-
ком по ним быстрее всего переходить от сцены к сцене. 

 Delete Scene (Удалить сцену) – выбрав одну из сцен (или несколько с клави-
шами Shift или Ctrl), можно удалить ненужные.

 – Move scene down, up (Сцену вниз, вверх) – изменяет порядок следования 
сцен – вверх-вниз по списку и влево-вправо (панельки-заголовки) в окне моделирования.

View Option – варианты опции показа сцен: в виде маленьких, больших миниатюр, 
детального списка с миниатюрами, простого текстового списка.

 

Hide / Show Details (Скрыть / показать детали) – разворачивает полностью/
сворачивает диалоговое окно, показывая только список сцен или с панелью дополни-
тельных параметров.

Menu (Меню) – открывает текстовое меню возможных опций со сценами. 
Меню того же содержания открывается из контекстного меню, вызываемого на строке 
списка сцен (рис. внизу слева).

также часть опций управления сценами доступны и из контекстных меню панелей-
заголовков сцен в окне моделирования (рис. внизу справа).

Пожалуй, по этим меню особых пояснений не требуется, заметим только, что здесь 
также налицо дублирование управления, а пункты Use Scene with Matched Photo и Play 
Amination – «пусковые» кнопки опций – отдельных больших тем второй части курса. 
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в нижней панели окна осталось рассмотреть еще несколько пунктов:
Include in Animation (Включить в анимацию) – переключатель назначения 

(или исключения) выбранных в списке сцен в качестве «кадров» создаваемой анимации 
(будущая отдельная большая тема второй части курса). 

Name (Имя) – в окошке появляется имя добавленной сцены по умолчанию – Scene 
#. Если требуется, переименовываем выбранную сцену вводом другого, значимого имени.

Description (Описание) – здесь можно ввести краткое справочное примечание 
или описание выбранной сцены.

в заключении зададимся вопросом – а что же главное для нас на стадии рабочего 
моделирования в достаточно сложных опциях Сцен, и можно ли без них обойтись? Конеч-
но, можно – ведь это только механизм отображения, никак не влияющий на собственно ге-
ометрию построений. Но с другой стороны, представьте, что не используем и другие из уже 
изученных возможностей управления визуализацией – показ/скрытие, Слои и т.д... Причем, 
что очень важно, сочетание всех их именно с опциями Сцен особенно эффективно для гра-
мотной организации работы. 

Например, в нашем тестовом проекте домика можем создать несколько сцен, в ка-
ждой из которых, кроме общего вида, покажем (сохраним представление) отдельных эле-
ментов его конструкции – фундамент, стены, крышу и проч. Причем, кроме скрытия ненуж-
ного (например, с использованием слоев), в каждой из сцен выставим (и сохраним!) нужные 
виды (проекции), назначим стили рендеринга, тени и т.д. Нетрудно понять, насколько бы-
стрее и удобнее пойдет работа по текущему моделированию и редактированию при умелым 
использованием всех этих возможностей SketchUp!

а впереди у нас – не менее интересные и мощные презентационные возможности 
программы, которые и базируются на механизме Сцен.
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Ранее уже было рассмотрено понятие Styles – Стилей отображения повер-

хностей и ребер построений для всей сцены. Мы подробно изучили специальную 
панель инструментов с этим же названием – Styles (Стили поверхностей) и опции 
меню View > Edge Styles (Стили ребер). Эти элементы интерфейса можно назвать 
«оперативными» инструментами, а в этой теме изучим специальное диалоговое 
окно, в котором сосредоточено полное, развернутое управление всеми возможно-
стями управления стилями, а фактически – визуализации, рендеринга в SketchUp. 

ДИаЛоГовоЕ оКНо stylEs (СтИЛИ)
Диалоговое окно открывается через меню Window > Styles. Нетрудно заметить, что 

логика построения и работы с этим окном во многом аналогична ранее рассмотренным ди-
алоговым окнам, например, окну Materials. видим три основных раздела – закладки Select 
(Выбор), Edit (Редактирование) и Mix (Смеситель). 

select (выбор)
По умолчанию в новом «пустом» файле будет открываться стиль из коллекции, при-

мененный в его шаблоне, который мы выбрали при первом открытии SketchUp (см. Тему 2), 
а при открытии ранее созданного и сохраненного файла – тот, который в нем был назначен. 

в этой первой закладке Select, открывающейся по умолчанию, в левом верхнем углу 
окна видим миниатюру-образчик текущего активного стиля – условное изображение, пока-
зывающее характер его графики. Правее находятся два окошка – верхнее Name с именем 
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этого стиля и нижнее Description с коротким текстовым комментарием к нему. Естественно, 
можем поменять (переписать) и то и другое.

В правой верхней части окна видим три кнопки: 

 – открывает/закрывает аналогичное «вторичное» окно выбора стиля. Это дает 
возможность одновременно видеть, например, папки с коллекциями и стили внутри них, что 
удобно для перемещения стилей между коллекциями простым «перетаскиванием» мышкой;

 – используется для создания нового стиля Create New Style – фактически копи-
рования текущего активного в список использованных в проекте (In Model) с возможностью 
его последующего редактирования (подробно будет рассмотрено далее);

 – обновляет текущий активный стиль в список использованных в проекте (In 
Model) с учетом изменений его параметров. аналогичное действие производит клик на его 
образчике в левом верхнем углу окна, когда на нем появляется изображение таких стрелок, 
сигнализируя о наличии изменений в текущем стиле. так, на рис. выше показано появление 
этих стрелок, как только мы переписали название стиля на русском.

в общем случае, если в начале работы мы выбрали некий стиль из коллекции, а за-
тем по ходу моделирования его модифицировали, и хотим сохранить в этом виде в списке In 
Model, необходимо его обновить. таким образом, назначение этой опции – фиксация (сохра-
нение в файле) произведенных изменений в исходном стиле. Если же по ходу текущей рабо-
ты просто для удобства моделирования временно производим некие изменения, например, 
несколько раз меняем стили отображения поверхностей, и каждый раз сохранять их в Сти-
ле не имеет смысла, то обновления не делаем. Этот принцип действует для всех опций, до-
ступных в диалоговом окне Styles.

Кнопки в средней части окна:

 – открывает список стилей, использованных в проекте (In Model), который ге-
нерируется автоматически при добавлении нового стиля. Доступ к нему возможен и из вер-
хней части раскрывающегося списка коллекции.

в каждый момент времени в проекте (точнее – в одной, текущей Сцене – об этом да-
лее) может быть задействован только один стиль, однако ничто не мешает, и более того – 
часто имеет смысл в списке In Model иметь несколько стилей, что дает возможность быстро-
го переключения между ними. Например, это может быть один предельно простой «рабо-
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чий» стиль для собственно моделирования, и второй (или несколько) – с эффектным графи-
ческим оформлением для презентации проекта заказчику.

 – открывает дополнительное меню Details, в котором доступны опции (их набор 
различается в закладках In Model и Select):

– Open or create a Collection... (Открыть или создать коллекцию) – открывает окно 
Проводника для доступа к существующим папкам коллекций или созданию новых;

– Save Collection As... (Сохранить коллекцию как) – открывает окно Проводника для 
создания новой папки и сохранению в ней новых стилей;

– Add Collection to Favorites... (Добавить коллекцию в закладки-список) – открыва-
ет окно доступа к папкам самых часто используемых стилей и добавляет их к списку; 

– Remove Collection From Favorites... (Удалить коллекцию из закладок-списка) – от-
крывает окно доступа к папкам, через которое можно удалить их из списка;

– Purge Unused (Очистить от неиспользуемого) – «принудительно» удаляет ранее на-
значенные, но на данный момент неиспользуемые (удаленные) стили в проекте (In Model). 
аналогичная опция доступна и из окна Window > Model Info > Statistics.

– Small, Medium, Large, Extra Large Thumbnails (маленькие, средние, большие, очень 
большие образчики) – выбор размера образчиков стиля; 

– List View (В виде списка) – переключение на показ стилей в виде текстового списка;
– Refresh (Обновить) – «ручное» обновление показа перечня стилей;
также доступны опции контексного меню, которое вызывается кликом на образчи-

ках стилей в их списках:
– Delete (Удалить) – удаляет стиль (в списке In Model – только из проекта, в списке 

Select – из программной папки Styles);
– Save As (Сохранить как) – открывает окно сохранения стиля в виде файла специ-

ального формата (*.style) для пополнения коллекции, например, в одной из тематических 
папок Styles программы (подроблней см. чуть ниже).

– Make a Copy (Создать копию) – создает копию активного стиля для последующего 
редактирования, фактически – аналогично кнопке Create New Style.

– Add to Model (Добавить в модель) – добавляет стиль в список In Model в качест-
ве нового дополнительного;

Как видим, ситуации с коллекциями Стилей и Материалов очень схожи. так, все 
Стили коллекций, (т.е. те, которые видим в списках и на миниатюрах), на самом деле 
хранятся и работают в специальном «скетчаповском» файловом формате *.style. а сами 
исходные коллекции в виде файлов этого формата размещаются по умолчанию при ин-
сталляции SketchUp в программную папку C:\Program Files\Google\Google SketchUp 8\
Styles. Однако надо отметить, что со Стилями все-таки удобней работать именно из 
коллекций, так что несмотря на довольно сложную процедуру сохранения своих нара-
боток, имеет смысл с ней разобраться, если есть необходимость или желание пользо-
ваться этой системой. в то же время в большинстве случаев вполне достаточен бога-
тый выбор из готовых коллекций, которые к тому же легко и наглядно редактируются 
«на лету». Не меньший выбор готовых стилей можно найти и в Интернете на «скетча-
повских» ресурсах... 

И еще – в самом начале нашего курса упоминалось, что после инсталляции, кро-
ме самого SketchUp, получаем «партнерское» приложение (только в Pro) – специаль-
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ный редактор Style Builder (Создатель стилей). Здесь замечу только, что это совер-
шенно отдельная программа с продвинутыми возможностями создания своих, в основ-
ном – всякого рода «декоративных» стилей. На практике особой необходимости в этом 
приложении нет, ну а творческим натурам, желающим попробовать себя в этом, в об-
щем-то совершенно отдельном жанре, можно только пожелать успехов в его самосто-
ятельном освоении...

Edit (редактирование)
Эта закладка предназначена для редактирования параметров текущего активного 

стиля проекта (In Model), т.е. редактирование доступно только для стилей, уже применен-
ных в проекте. 

верхняя часть окна аналогична предыдущему, а ниже находится пять панелей, кото-
рые открываются кликом на их кнопках с соответствующими символами.

 Edge Setting (Настройка ребер)

Доступны опции (вкл./выкл. переключателей):
– Edges (Ребра) – показ/скрытие всех ребер в сцене. толщина таких ребер всегда по-

стоянна, и возможность ее изменения не предусмотрена.
– Back Edges (Ребра сзади) – показ/скрытие ребер (пунктирная линия) с обратной 

стороны объекта. Дублирует кнопку панели инструментов Styles  аналогичного назва-
ния и назначения;

– Profile Edges (Профильных ребер) – показ/скрытие профильных ребер, которые 
используются, чтобы подчеркнуть внешние очертания объемов в модели. Здесь же, в окош-
ке рядом, можно назначить ширину этих линий в пикселях; 

– Depth Cue (Ребра по глубине) – показ/скрытие «разноширинных» ребер, которые 
используются, чтобы подчеркнуть глубину пространства за счет отображения их более ши-
рокими на переднем плане, чем на заднем. в окошке рядом вводим толщину этих линий в 
пикселях (на переднем плане);
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– Extension (Удлинение ребер) – показ/скрытие стиля, который имитирует принятую 
в архитектурных набросках манеру графической подачи – удлиняет каждую линию за преде-
лы ее конечных геометрических точек. в окошке рядом вводим удлинение линий в пикселях. 

– Endpoints (Утолщения в конечных точках) – показ/скрытие стиля графической по-
дачи с «точками» в каждой е (на концах каждого ребра). в окошке рядом вводим размер 
утолщений в пикселях.

– Jitter (Нервный) – показ/скрытие имитации эскизного стиля рисования с «расще-
пленными» линиями. 

Следующие параметры становятся доступны только для декоративных, «скечевых» 
стилей из списков Select > Styles (кстати, это и есть типичная «продукция» Style Builder):

– Level of Detail: – слайдер настройки детализации (качества) линий;
– Stroke: – окошко с показом характера линии;
 – Halo: – вкл./выкл. эффекта «размытия границ» линий.
в нижней части закладки находится опция Color для назначения цвета ребер во всей 

сцене. Здесь возможны три варианта:
– All Same (Для всех) – вариант по умолчанию... да и самый употребительный. все ре-

бра отображаются одним цветом (черным по умолчанию), который можно изменить на лю-
бой другой, открыв цветовые палитры кликом на цветном квадратике справа;

– By Material (По материалу) – ребра отображаются цветами материалов поверхно-
стей, которым они принадлежат. Практическое применение для этого варианта найти до-
вольно сложно... 

– By Axis (По осям) – ребра отображаются цветами осей, вдоль которых они направле-
ны. Эта опция помогает, например, выявить ребра, которые не параллельны осям рисования.

Face Setting (Настройка поверхностей)
в верхней части панели назначаются цвета поверхностей в проекте по умолчанию, т.е. 

какими они изначально отображаются до момента назначения материалов. вспомним, что толь-
ко они используются в стиле Monochrome, показывая ситуацию с ориентацией «лицо/изнанка»: 

– Front Color – цвет лицевой стороны;
– Back color – цвет оборотной (изнаночной) стороны.
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Средняя часть закладки – кнопки-переключатели показа /скрытия шести стилей ото-
бражения поверхностей, которые дублируют ранее уже подробно рассмотренную (в Теме 9 
«Рабочая визуализация») панель инструментов Styles (за исключением стиля Back Edges (Ре-
бра сзади): 

Wireframe (Каркасы), Hidden Line (Линейный), Shaded (Затененный), Shaded with 
Textures (Затененный с текстурами), Monochrome (Бесцветный), X-Ray (Рентген) 

в нижней части закладки находится переключатель Enable Transparency – включе-
ние / выключение показа степени прозрачности назначенных материалов. Правее, в списке 
Transparency Quality можно выбрать один из трех вариантов зависимости скорости/качества 
выполнения рендеринга прозрачности: Faster, Medium, Nicer (Быстрый, Средний, Лучший). 
впрочем, явного эффекта от изменения этого параметра, особенно на достаточно мощном 
компьютере, не наблюдается...

Background Setting (Настройка фонов)
в этой панели назначаются фоновые цвета области моделирования в проекте – кли-

каем на цветном квадратике для доступа к палитре цветов: 
– Background (Фон) – однотонный сплошной цвет общего фона рабочего окна;
– Sky (Небо): переключатель скрытия / показа и назначения условной градиентной 

(т.е. светлее к горизонту) окраски «неба»; 
– Ground (Земля) – переключатель скрытия / показа и назначения условной градиен-

тной окраски «земли» (аналогично – светлее к горизонту); 
– Show Ground from Below (Показывать землю снизу) – переключатель скрытия / по-

каза возможности видеть «землю», если ваша точка взгляда находится ниже ее уровня. Связа-
на со следующей опцией – настройкой показа объектов, находящиеся выше уровня «земли». 
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– Transparency (Прозрачность) – слайдер назначения степени прозрачности «земли» 
(левый край – непрозрачность, правый – полная прозрачность). Действие показано выше 
на рис. справа. Понятно, что такая возможность работы и наглядного показа объектов над 
и под «землей» может быть очень полезна в архитектурных или подобного типа проектах, 
связанных с конструкциями соответствующего типа.

Watermark Setting (Настройка водяных знаков)
Эта панель предоставляет доступ к опциям включения в проект дополнительных слоев 

на основе импортированных растровых имиджей со специфическими свойствами. Сразу заме-
тим, что этот механизм никакого отношения к ранее изученным Layers(Слоям) не имеет. Кроме 
того, он имеет еще одну особенность – этот чисто внутренний механизм, который «не пере-
дается» в другие программы, например, при экспорте в другие 3D-редакторы или рендеры.

– Display Watermarks (Показывать водяные знаки) – переключатель скрытия / пока-
за в области моделирования этих слоев;
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Ниже находится окно списка загруженных имиджей с кнопками управления опцией, 
первая из которых «+» последовательно, нажатием кнопки Next (или возврат – Previous),  от-
крывает диалоги.

 В первом диалоге (рис. выше слева):
– выбирается файл имиджа из внешних растровых файлов доступных форматов;
– назначается имя слоя (Watermark #) – понятно, можем переименовать по-своему;
– назначается положение слоя относительно пространства моделирования, точнее – 

объектов сцены (Background – за, или Overlay – перед ним).
Во втором диалоге (рис. выше справа):
– активация переключателя Create Mask позволяет назначить «маскированные» об-

ласти имиджа. Не вдаваясь в подробности (отсылаю к растровым графическим редакторам) 
– здесь типично работает т.н. альфа-канал имиджей растровых форматов (.png, .psd), кото-
рые поддерживают этот механизм. Проще говоря, части имиджа можно сделать полностью 
или частично прозрачными. 

– слайдером Blend регулируется степень «смешения» в показе содержимого сцены и 
Overlay имиджа (Model < > Image) или Background имиджа (Background < > Image).

В третьем диалоге назначается позиционирование имиджа на экране:

– Stretched to fit the screen – опция растягивает имидж на весь экран. При этом пе-
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реключатель Lock Aspect Ratio включает / выключает опцию сохранения пропорций исход-
ного имиджа;

– Tiled across the screen – опция равномерно заполняет экран «плитками» имиджа. 
При этом появляется слайдер Scale, который позволяет масштабировать «плитки»;

– Positioned in the screen – опция позиционирует имидж относительно девяти зон 
экрана специальным переключателем-матрицей позиций Position. аналогично предыдущей 
опции, слайдер Scale позволяет масштабировать имидж.

После нажатия клавиши Finish в окне-списке появляются как минимум две строки вида: 
Model space (Пространство моделирования) и Watermark1. Конечно, могут быть созданы 
(добавлением слоев-имиджей) и Watermark2, Watermark3 и т.д. После этого становятся до-
ступны опции удаления выделенных этих слоев в списке (кнопка «-») и изменения порядка 
их размещения (кнопка с угловыми стрелками – вверх/вниз). Кроме того, для выделенной 
строки становится доступно (кнопка с символом «шестренки») повторное редактирование 
их свойств через те же диалоги, что и при первоначальном создании имиджа.

 Понятно, что эта функция призвана, прежде всего, применяться как средство защиты 
авторских прав на изображение модели (ее название Watermark говорит само за себя) за счет 
его совмещения с водяными знаками (например, с логотипом). Но кроме того, опция может 
быть и дополнительным, очень эффектным приемом оформления проекта за счет комбина-
ции имиджей и трехмерных объектов. Давать здесь конкретные рекомендации не имеет смы-
сла, поскольку возможно множество вариантов их сочетаний, и, соответственно – визуальных 
результатов... все зависит от вашей творческой фантазии!

Modeling (Моделирование)
Эта панель предназначена для самой подробной настройки отображения различных 

элементов интерфейса и построений в текущем проекте. 
Верхняя часть панели управляет цветовым кодированием. Можно назначить этими оп-

циями любые цвета по своим предпочтениям, однако надо учитывать, что они должны всег-
да хорошо «читаться» – быть достаточно яркими и контрастными по отношению к элементам 
построений в любых ситуациях. Можно заметить, что варианты, предлагаемые программой 
по умолчанию, продуманы и вполне рациональны, поэтому вряд ли имеет смысл их менять.

– Selected (Выбранное) – цвет «подсветки» элементов построений, выбранных ин-
струментом Select;

– Locked (Зафиксированное) – цвет «подсветки» элементов построений, фиксиро-
ванных опцией Lock;

– Guides (Направляющие) – цвет конструкционных направляющих линий и точек;
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– Inactive Section (Неактивные раз-
резы) – цвет габаритов секущей плоско-
сти неактивного разреза, т.е. не «подсве-
ченного»;

– Active Section (Активные раз-
резы) – цвет габаритов секущей плоско-
сти текущего активного разреза, т.е. цве-
та «подсветки»;

– Section Cuts (Отсеченные объе-
мы) – цвет «подсветки» линий пересече-
ния секущей плоскости, созданной до это-
го инструментами Sections (Разрезов) с от-
сеченным объемом;

– Section Cut Width (Ширина ли-
ний пересечения) – окно ввода ширины (в 
пикселях) линий секущей плоскости в ак-
тивном разрезе.

Эти пункты касаются группы инстру-
ментов Sections (Сечений и Разрезов), ко-
торые будут изучены в отдельной теме да-
лее, так что просто запомним, что цвето-
вые настройки их отображения находят-
ся здесь...

Средняя часть панели представлена 
переключателями показа / скрытия отдель-
ных элементов в текущем стиле. 

– Hidden Geometry (Скрытые по-
строения) – вкл./выкл. показа/скрытия всех 
скрытых до этого опцией Hide построе-
ний. Дублирует эту же опцию из тексто-
вого меню View. вспомним – при этом по-
верхности отображаются в виде сетки, ре-
бра – пунктирными линиями, а чтобы они 
снова стали постоянно видимыми, приме-
няем опцию Unhide;

– Color by Layer (Цвета по слоям) – вкл./выкл. опции показа всех поверхности в услов-
ные цветах слоев, которым они принадлежат (см. тему «Слои»);

– Section Planes (Секущие плоскости) – вкл./выкл. показа/скрытия всех секущих пло-
скостей, созданных до этого инструментами Sections (Разрезов);

– Section Cuts (Отсеченные объемы) – вкл./выкл. показа/скрытия отсеченных объе-
мов и линий пересечения их секущей плоскостью;

Эти два последних пункта также касаются инструментов сечений и разрезов, которые 
будут изучены позже – пока просто запомним, что эти настройки находятся здесь...

– Model Axes (Оси модели) – вкл./выкл. показа/скрытия основных осей сцены. Дубли-
рует эту же опцию из текстового меню View. 
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Нижняя часть панели с заголовком Match Photo (Совмещение с фото) управляет ча-
стью настроек этой специфической функции, которую подробно изучим позже в отдельной 
теме, поэтому здесь их конкретное действие рассматривать не имеет смысла. Пока просто 
содержание опций: Foreground Photo – вкл./выкл. показа/скрытия фото переднего плана, 
Background Photo – то же для фото заднего плана, Opacity – слайдеры назначения степени 
непрозрачности соответственно для Foreground и Background Photo.

mix (Миксер)
Эта закладка предназначена для со-

здания новых стилей, как «смеси» или ком-
бинации различных категорий настроек из 
стилей нескольких коллекции. 

в верхней части закладки видим 
пять панелей-разделов, соответствующих 
пяти категориям параметров стилей, рас-
смотренными ранее (ребра, поверхности, 
фоновые имиджи, имиджи с водяными зна-
ками, моделирование). Ниже (во вторич-
ном окне) видим включенные в программу 
папки коллекций стилей. Кликаем на нуж-
ной папке (или выбираем папку из выпада-
ющего списка коллекции), открывается ее 
содержимое – собственно стили. При этом 
курсор изменяется на символ «пипетки» как 
бы заполненной всеми настройками этого 
стиля. теперь, поднявшись в верхнее окно 
(курсор изменяется на символ «ковшика»), 
кликаем на разделе, в который хотим поме-
стить настройки этой категории – т.е. как бы 
«заливаем» взятые из другого стиля соот-
ветствующие настройки. При этом все сти-
левые изменения, что очень удобно и на-
глядно, тут же в интерактивном режиме ме-
няют отображение построений в окне мо-
делирования. 

таким образом, эта функция явля-
ется своеобразной палитрой, возможно-
сти которой по созданию своих новых сти-
лей ограничены только фантазией и вкусами 
пользователя. Здесь еще раз можно заме-
тить некоторую даже «избыточность» вни-
мания разработчиков к стилевым возмож-
ностям программы...

Ну и в заключении темы Стилей 
вернемся к диалоговому окну Scenes 
(Сцены) из первой части курса, чтобы 
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еще раз обратить внимание на очень важный для понимания момент совместного ис-
пользования этих двух механизмов. 

Суть заключается в том, что если мы произвели в текущей сцене какие-либо стилевые 
изменения, то после нажатия кнопки Update Scene программа напоминает об этом и пред-
лагает выбрать вариант действий – принять решение, как с этим поступить? 

Здесь особенно внимательно стоит отнестись к первым двум вариантам: 
– Save as a new style – сохранить как новый стиль, который появится в списке In Model 

(т.е. в файле проекта) диалогового окна Styles;
– Update a selected style – обновить выбранный стиль, т.е. наоборот, текущие стиле-

вые настройки сцены применить к стилю (изменить его с этими новыми параметрами);
Что нам дает такой механизм? Он предоставляет очень удобную возможность, наря-

ду со всеми остальными параметрами, сохраняемыми в каждой из сцен независимо от дру-
гих, сохранять для сцены еще и «индивидуальный» стиль визуализации. т.е., например, мо-
жем иметь в списке In Model несколько стилей, и выбирать из них нужный для каждой сцены 
отдельно. Особенно эффектно применение этой методики «играет» при создании презента-
ций – слайд-шоу и анимационных роликов... об этом подробно в отдельной теме. 

На этом завершаем первую часть курса изучения SketchUp – теперь вы можете 
свободно и продуктивно работать над самыми распространенными задачами моделиро-
вания в программе, создавая основу будущего проекта. С другой стороны, полученные к 
этому моменту знания по программе снимут все возникающие по ходу работы вопросы... 

Впереди, во второй книге, еще целый ряд пока не рассмотренных инструментов, 
опций, способов и приемов решения специфических задач, а значит, и дополнительных 
возможностей... 


